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Chapter 1. Remote Control Installation Guide

By using Remote Control you can remotely support and control thousands of PCs and servers, on an enterprise scale,

from a central location or directly, in peer to peer mode.

Use the Remote Control administration web interface, to view and control a remote desktop, including its keyboard
and mouse, anywhere on your network. You can also chat, transfer files, remotely guide the users, administer

the policies to be applied to different users and target groups, and much more. These features can help provide

more efficient and effective analysis of user problems from the administrators desktop, without the added cost of
dispatching a technician or relying on user descriptions over the phone. Use Remote Control to deliver better support,
more flexibility, and richer security, by using robust features that include enhanced central logging and video capture
of the sessions and full data stream encryption.

Audience

This guide is for administrators and IT managers who want to install and administer Remote Control. It details the
system requirements for each of the components and provides installation instructions that allow you to deploy the

program in your environment. It also includes information about configuring and maintaining Remote Control.

Versions

The guide includes the functions introduced in Remote Control V10, © Copyright HCL Ltd. 2024.

Terms used in this guide

The following terms are all Remote Control terms, but are used throughout the guide without being labeled every time

with Remote Control:

« Controller always means Remote Control Controller application

« Target always means Remote Control Target

« Server always means Remote Control Server

- Broker always means Remote Control Broker

- Managed mode refers to installations where a server has been deployed and the targets are configured to

register and report status to the server.



Chapter 2. Overview of the Remote Control system

The Remote Control system includes the following main components:
Remote Control Target

The target is installed on every computer that you want to control remotely with Remote Control. It
listens for connection requests that come from the controller. You can also start a remote control

session over the internet with a target, by using a broker.

Targets that are outside of your intranet can be configured to register their details with the server.
Sessions with these targets are managed by server policies. The targets must be deployed with the
Managed property set to Yes. The ServerURL and BrokerList properties must also be configured.
Targets can also be configured so that they do not send their details to the server. These targets are
classed as unregistered targets. You can install the target software and set the Managed property to
No. The BrokerList property must also be set. You can also use the on-demand target features to start
a remote control session with a computer that does not have any target software preinstalled. Server
policies are used to manage the on-demand sessions. The target software is deleted at the end of the

session.
Remote Control Controller

The controller can be installed by using the Fixlet, or by using the installer that is provided for use in
peer-to-peer sessions. It can also be launched in context from the remote control server or the Remote
Control console. In all instances, the controller can be used to allow the user to control a remote
computer on which the remote control target is installed. The controller delivers an interface to several
actions, available to the controller user, like remote control, guidance, chat, file transfer, command,

collaboration, and many more.
Remote Control Server

A web application that manages all the deployed targets that are configured for managed mode and to
point to the Remote Control Server 's URL. You can deploy it on an existing WebSphere® server, or install
it by using the installer package along with an embedded version of WebSphere®. The server listens for
HTTP or HTTPS connections by default. When it is installed with the embedded WebSphere® option,
WebSphere® it listens on ports 80 and 443. When it is deployed on top of an existing WebSphere®
server, the Remote Control server listens on ports 9080 and 9443. The server requires a database
server: embedded Derby, only for proof of concept deployments; DB2®, SQL Server, and Oracle are the
supported options. Additionally, it can also be configured to synchronize and authenticate user and
group data from an LDAPv3 server, such as Active Directory or Tivoli Directory Server. This deployment
scenario has the same networking characteristics as peer-to-peer. Therefore, direct TCP connectivity

is required between all the controllers and all the targets. However, the Remote Control server provides
a method of centralized, and finer, policy control, where targets can have different policies that are
determined by the user who is trying to start the remote control session. The Server also provides for

centralized audit and storage of full session automatic recordings. In this scenario, the controller is
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not a stand-alone application, but is started as a Java™ Web Start application from the Remote Control

server's web interface to start the remote control session.

Note: Peer-to-peer and managed are not exclusive modes. You can configure the Remote

Control target in the following ways:

« To be strictly managed.
« To fail back to peer-to-peer mode when the server is not reachable.

 To accept both peer-to-peer and managed remote control sessions.

The following components can be used only in managed mode:
Remote Control CLI tools

CLI tools are always installed as part of the target component but you can also install them separately.
The CLI provides command-line tools for the following tasks:

- Script or integrate the launch of managed remote control sessions.

« Run remote commands on computers with the managed target installed.

Remote Control Gateway

A service that is installed in computers in secure network boundaries, where there is strict control of
traffic flows between the secure networks. For example, the firewall at the boundary allows only traffic
between a pair of specific IP address and ports. In these scenarios, a network of gateways can be
deployed. The gateway routes and tunnels the remote control traffic from the controller, which is located
in a particular network zone, to the target that is in a different network zone. The gateway is a native
service that can be installed on a computer that has a Windows™ or Linux™ operating system installed.
It does not have a default port for listening, although 8881 is a usual choice, and can be configured for
multiple incoming listening ports and outgoing connections.

Remote Control Broker

A service that is installed in computers typically in a DMZ so that computers outside the enterprise
network, in an Internet cafe or at home, can reach it. The Remote Control broker receives inbound
connections from the controller and the target and tunnels the remote control session data between
the two components. The broker is a native service that can be installed on a Windows™ or a Linux™
computer. It does not have a default port for listening, but 443 is a recommended option because
usually this port is open for outbound connections and has fewer issues with content filtering than, for
example, 80 would have.

How to use the guide

The process of getting Remote Control up and running varies, depending on your network environment and the

management granularity you want to achieve. The installation guide focuses on three types of deployments:
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Peer to peer

Is the simplest scenario and therefore ideal for small deployments. All targets are in network sight of
the controllers and there is no requirement to centrally manage the controller policies.

Intranet managed

Are most appropriate in a complex network infrastructure that requires the deployment of gateways to

traverse firewalls, or there is a requirement for strict policy control and centralized auditing.

Managed

With support for internet sessions where at least one broker must be installed in an internet-facing

computer so that it is visible to targets outside the controller's network sight.

For the sake of readability and generality, the installation guide assumes the following restrictions:

- Each Remote Control server must have access to one of the supported database servers. The database can
be located locally on the server computer or remotely on a separate server. The supported database systems
are DB2, Oracle, and MS SQL. It is also possible to install the server by using the embedded Derby database
that is provided by the installer. However, this configuration is not supported for production deployments.

« In managed environments, each controller can make an HTTP or HTTPS connection to the Remote Control
server.

« In managed environments, each Remote Control target computer in the network must be able to make an

HTTP or HTTPS connection to a server, a gateway, or a broker on the specified ports.

If your network configuration does not match any of the scenarios in that chapter, contact a support technician for

more options.

The initial deployment of a minimal managed Remote Control system (server and a few targets) can take

approximately 1 hour to complete.

Several steps in the Remote Control installation depend on the completion of prior steps. For this reason, it is

recommended that you follow the guide in the order presented.

Remote Control operating requirements

Remote Control runs efficiently by using minimal server, network, and client resources. The requirements for the client
programs are not stringent. The hardware that is required by the server and the target depends on the number of
computers that are administered and the frequency that is defined for their status updates.

A Basic installation

The most basic installation requires the Remote Control target and controller components. Use the two components
to start a peer to peer remote control session, for which the policies are defined only at target level.

The port to be used for target to controller communication is configurable at installation time. The default is port 888.
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Such an installation provides basic audit information. This information is accessible from the BigFix® console. It is
also stored in the application event log, in a Windows operating system, or system log, in a Linux operating system.
However, if centralized auditing and management of users and computers is required, install the server component.

The server component provides a single interface where controller users can easily search for targets. They can
also organize the targets that are most frequently accessed and view their session history. For an administrator, a
managed environment provides the following extra capability.

- Centralized management of users and targets: Users can be organized into groups with similar profiles. They
can be organized manually, by using the Remote Control server interface, or by importing users and groups
from LDAP. Similarly, targets can be organized into groups manually or by setting target membership rules to
automatically assign a target to a specific group. For more information about target membership rules, see
the BigFix® Remote Control Administrator's Guide.

- Centralized policy management: When a session is started from the server interface, the permissions that
are set for the session are derived from the target and controller properties. Provides more flexibility to define
different levels of access, against a single target, for different users in your organization.

- Centralized auditing and recording repository: Administrators can use the Remote Control server interface
to browse and examine audit information. They can also view recordings that are associated with a specific
remote control session. Administrators can search the existing session history. For example, by user ID or
computer name.

- Access request management: Administrators can grant temporary access, or increase the level of access, to
a target or group of targets. Temporary access can be granted to Remote Control registered and unregistered
users.

 Reporting capabilities
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Figure 1. Basic installation environment
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Note: It is not necessary to install the controller component in a managed environment. Remote control
sessions are launched in-context from the Remote Control server interface. You can also configure the target
components, in a managed environment, to accept peer to peer remote control requests from a stand-alone
controller component. For more information about installing the target, see Install the target (on page 55).

Installation with support for firewall and NAT traversal

In some environments, it is not possible to open a port in a firewall to enable controller to target, or target to server
communication for all endpoints. It is more appropriate to enable traffic from, or traffic to a single computer that acts

as a gateway to traverse the firewall.

The gateway component can be strategically installed in your network to enable traffic between targets and
controllers, or targets and servers that are in different networks. This component can also be used as a proxy server

to forward the target’s status update to the remote control server.
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Installation with support for remote control sessions over the internet

Sometimes the target that requires support is out of network sight in an internet location. For example, in a hotel or

an airport lounge.

Use the broker component to enable remote control sessions to these computers by bridging the target and controller

communication. The broker must be placed in the DMZ and a gateway is required to provide secure communication

to the server in the intranet.

In this scenario, the controller user can start a broker connection and obtain a connection code from the server. The
user who requires assistance enters the connection code by using the appropriate menu option in the target Ul. When

the session details are validated by the server, the session is connected.
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Figure 2. Sample deployment environment

53
T

e
‘
— —
=
atenway

Server requirements

The hardware that is required by the server component depends on the number of computers that are administered
and the frequency that is defined for their status updates.

The distributed architecture of Remote Control allows a single server to support hundreds of thousands of

computers.

The computer on which you install the Remote Control server must have the minimum following capabilities:
Minimum Hardware requirements

« 1 Quad core or two dual core processors. 2.40 GHz with supported 0S.

« A minimum of 4 GB of memory.

« A minimum of 2 GB of storage or hard disk space to install, and an average of 2 MB per client in the database.

« A minimum screen resolution of 800 by 600 pixels is required when you run an automated server installation.

- Adequate space for storing session video recordings. Recordings are stored on the hard disk and their size
can vary depending on the duration and screen activity of the session. On average a 5-minutes session, 8-bits
mode, can use about 2 MB of space. In true color 24-bit mode, recordings can take more space.

» A network card that supports TCP/IP.

« A supported browser.
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Supported browsers

Verified browsers are:

« Internet Explorer
« Mozilla Firefox

« Chrome

« Safari

» Edge

Operating system support

The following operating systems are supported.

» Windows™ Server 2012

» Windows™ Server 2012 R2

» Windows™ Server 2016

» Windows™ Server 2019

» Windows™ Server 2022

» Red Hat Enterprise Linux™ 7.0 or later

« Red Hat Enterprise Linux™ 8.0 or later

« Red Hat Enterprise Linux™ 9.0 or later

« SUSE Linux™ Enterprise Server 10 or later
» SUSE Linux™ Enterprise Server 11 or later
» SUSE Linux™ Enterprise Server 15

« Cent0S 5.0 or later

» Cent0S 6.0 or later

Supported Architectures

* Intel™ IA®-32 (also known as x86, x86-32)
* Intel™ 64 or AMD64 (also known as x64, x86-64, EM64T)

Note: IA®-64 (also known as Itanium™) processors are not supported.

Supported databases
The following databases are supported.

« IBM DB2 11.5 Virtual Processor Core (VPC).
* Oracle 11g, 12¢, and 19c.

When you use an Oracle database, if you are using the Oracle 11g drivers, set oracle.increment.keys.off=1 in

the trc.properties file. Restart the server service.
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* Microsoft SQL server 2008, 2012, 2014, 2016, 2017, 2019, and 2022.

You must use a JDBC driver whose version is higher than 6.3. Older versions do not support TLS1.2 or JRES.

When you use an MS SQL database, Windows™ authentication is not supported. You cannot log on with a
domain user. You must use mixed mode authentication and create an SQL user to connect to the database.

Note: You must use JDBC drivers which support at least Java 8.

Derby Version 10.13 is included with the Remote Control server and is installed locally when you select the Derby
option during the installation.

Note: Install Derby only for proof of concept configurations. Derby is not supported in production

environments.

When you install the server by using the installer, a WebSphere Application Server Liberty Profile version is also

installed.

Server environment guidelines

In addition to system requirements, you must also determine which type of server installation to use in your

environment. Use the following information as a guide.

Table 1. Remote Control server installation types
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Note: Server installation type 1 must be used only in Proof of Concept or test deployments.

The following sections provide guidance and recommendations based on environment size.

Small environment guidelines

For environments containing up to 5K targets, you can use server installation types 1, proof of concept only, or 2 in

Server environment guidelines (on page 18).

Also, consider the following extra requirements.

« Processors: 1 Quad core or 2 dual core processors, 2.40 GHz, with supported OS.
* Memory: 4 GB RAM.
- Storage. For more information, see Server requirements (on page 16).

- Heartbeat configuration

Table 2. Heartbeat configuration properties: suggested values for a small environment

Propertyintrc. properties Value
heartbeat.timeout 60
Note: If there are performance issues, set the value to 1440,
which is 24 hours. For example, when there is heavy usage of re-

ports, especially with Derby.

Default is 60, which is 1 hour.

heartbeat.retry 10
heartbeat.delay 20
heartbeat.on.wake 0
heartbeat.on.user.change 1
heartbeat.on.change 0
heartbeat.on.stop 0

Note: Installation type 1 is suitable for demonstrations or pilot projects. Installation type 2 can give better

performance, which might be preferred for production systems in these environments.

Medium environment guidelines

For environments containing from 5K to 75K targets, you can use server installation types 2 or 3 in Server
environment guidelines (on page 78). In terms of performance, installation type 2 is suitable. However, with

installation type 3 you can also use the admin functions of the installed WebSphere Application Server.
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Also, consider the following extra requirements.

« Processors: 1 Quad core or 2 dual core processors, 2.40 GHz.
* Memory: 8 GB RAM.
« Storage: RAID 5- 6 HDD. DB2, Oracle, or MS SQL 64 bit or 32 bit.

- Heartbeat configuration -

Table 3. Heartbeat configuration properties: suggested values for a medium environment

Propertyintrc. properties Value

heartbeat.timeout 1440

Note: If there are specific groups of computers where more reg-
ular updates are needed, a smaller heartbeat timeout setting can
be applied as a group attribute for those specific groups of tar-
gets. For details of setting this attribute at group level, see the
chapter that explains how to create a target group in the BigFix®
Remote Control Administrator's Guide.

heartbeat.retry 10

Note: In an environment that contains target numbers nearer to
75 K, set this value to 20 to help with performance.

heartbeat.delay 20

Note: In an environment that contains target numbers nearer to
75 K, set this value to 40 to help with performance.

heartbeat.on.wake 0
heartbeat.on.user.change 1
heartbeat.on.change 0
heartbeat.on.stop 0

Note: In this type of environment, ensure that the target deployment is done in stages. A staged deployment
can avoid overload in the server when the targets try to register with the server. Give the RegistrationDelay
target property a value that distributes the target computer registration evenly through the staged
deployment. Distribute the target registration to avoid too many computers trying to register at the one time.
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Large environment guidelines

For environments containing from 75K to 225K targets, you can use server installation type 3 in Server environment

guidelines (on page 18).
Also, consider the following extra requirements.

To host WebSphere Application Server

 Processors: 2 Quad core processors. 2.40 GHz with supported OS.
* Memory: 16 GB RAM.
« Storage: RAID 5- 6 HDD.
 Heartbeat configuration -
Table 4. Heartbeat configuration properties: suggested values for a large environment

Propertyintrc. properties Value

heartbeat.timeout 1440

Note: If there are specific groups of computers where more reg-
ular updates are needed, a smaller heartbeat timeout setting can
be applied as a group attribute for those specific groups of tar-
gets. For details of setting this attribute at group level, see the
chapter that explains how to create a target group in the BigFix®

Remote Control Administrator's Guide.

heartbeat.retry 60

Note: In an environment that contains target numbers nearer to

75 K, set to a higher value to help with performance.

heartbeat.delay 60

Note: In an environment that contains target numbers nearer to

75 K, set to a higher value to help with performance.

heartbeat.on.wake 0
heartbeat.on.user.change 1

heartbeat.on.change 0
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Propertyintrc. properties Value

heartbeat.on.stop 0

- Optional: 2 network cards, one for target communications and one for database communications that could

aid in performance tuning.
To host the database, DB2®, Oracle, or MS SQL supported.

* Processors: 4 Quad core processors, 2.40 GHz.
- Memory: As recommended by the database supplier.
« Storage: RAID 5-6 HDD 146 GB

Note: The database administrator must tune the database for appropriate performance.

The following guidelines must also be considered when you use large reports, as some performance degradation can

be experienced.

- Ensure that the All targets report is not the default home page report.

- Ensure staged deployment of the targets to avoid overload in the server when they try to register.

Note: Give the RegistrationDelay target property a value that distributes the target computer
registration evenly through the staged deployment. Distribute the target registration to avoid too many

computers trying to register at the one time.

Note: If you configure LDAP and LDAP synchronization is enabled, set a reasonable frequency for the
synchronization. If your LDAP configuration is set up to import many users and groups, set the frequency to
24 hours. For more information about configuring LDAP, see Configure LDAP (on page 112).

Controller requirements

The Controller is a Java™ based application that can run on the following operating systems with the listed

prerequisites.

Operating system support

The following operating systems are supported:

» Windows™ 7

* Windows™ 8 and 8.1
* Windows™ 10

» Windows™ 11

» Windows™ Server 2012
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» Windows™ Server 2012 R2

» Windows™ Server 2016

» Windows™ Server 2019

» Windows™ Server 2022

» Red Hat Enterprise Linux™ 7.0 or later

» Red Hat Enterprise Linux™ 8.0 or later

« Red Hat Enterprise Linux™ 9.0 or later

« SUSE Linux™ Enterprise Server 10 or later

» SUSE Linux™ Enterprise Server 11 or later

» SUSE Linux™ Enterprise Desktop 10 or later
« SUSE Linux™ Enterprise Desktop 11 or later
+ Cent0S 5.0 or later

» Cent0S 6.0 or later

» macOS 11.x BigSur

» macOS 12.x Monterey

» macOS 13.x Ventura

* macOS 14.x Sonoma

Supported architectures

* Intel™ IA®-32 (also known as x86, x86-32)
« Intel™ 64 or AMD64 (also known as x64, x86-64, EM64T)
« Apple Silicon

Note: IA®-64 (also known as Itanium™) processors are not supported.

Pre-requisites

» Oracle Java™ SE Runtime Environment 8 or IBM® Java™ SE Runtime Environment 8.

Note: Oracle Java™ is not supported in FIPS or NIST SP800-131a mode. You must use the IBM®

Java™ in this mode.
Target requirements
Minimum requirements
The computer on which you install the Remote Control target must have at least the following specifications:

« At least a 1 GHz Intel™® or AMD processor.
« A minimum of 1 gigabyte (GB) RAM (32-bit) or 2 GB RAM (64-bit).
« A minimum of 50 MB hard disk space.
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- Adequate space for storing session video recordings. Recordings are stored on the hard disk and their size
can vary depending on the duration and screen activity of the session. On average a 5-minutes session, 8-bits
mode, can use about 2 MB of space. In true color 24-bit mode, recordings can take more space.

» The maximum display resolution per display is 7680 pixels by 4320 pixels.

» The maximum number of displays is 8 by 8.

Network requirements

Before you install the Remote Control, ensure that the below network requirements are met:

« Incoming TCP connections to the Target port 888 (or any other port that is configured for the Remote Control
sessions) must be allowed in the firewall rules.

- Traffic on the locahost loopback address 127.0.0.1 betweent rc_base,trc_gui,trc_dspandtrc_ft on
ports between 49152 - 65535 must be allowed.

Note: Antivirus or Intrusion Detection System software might also block this traffic.

Operating system support

The following operating systems are supported:

» Windows™ 7

» Windows™ 8 and 8.1

» Windows™ 10

« Windows™ 11

» Windows™ Server 2012

» Windows™ Server 2012 R2

» Windows™ Server 2016

» Windows™ Server 2019

» Windows™ Server 2022

« Red Hat Enterprise Linux™ 7.0 or later

* Red Hat Enterprise Linux™ 8.0 or later (XORG Only)
* Red Hat Enterprise Linux™ 9.0 or later (XORG Only)
» SUSE Linux™ Enterprise Server 10 or later

« SUSE Linux™ Enterprise Server 11 or later

« SUSE Linux™ Enterprise Desktop 10 or later
« SUSE Linux™ Enterprise Desktop 11 or later
» Cent0S 5.0 or later

» Cent0S 6.0 or later

» macOS 11.x BigSur

» macOS 12.x Monterey

» macOS 13.x Ventura

« macOS 14.x Sonoma



Remote Control Installation Guide | 2 - Overview of the Remote Control system | 25

Note: On macOS 11.1, ensure the monitor screen resolution is set to one of the following: 1280 x 768, 1280
x 800, 1280 x 1024, 1360 x 768, 1440 x 900, 1600 x 900, 1680 x 1050, 1920 x 1080, or 2880 x 1800. This
is because, the following screen resolutions can result in a black screen on the Controller during a remote
session: 1400 x 1050, 1768 x 992.

Supported architectures

* Intel™ IA®-32 (also known as x86, x86-32)
* Intel™ 64 or AMD64 (also known as x64, x86-64, EM64T)
« Apple Silicon

Note: IA®-64 (also known as Itanium™) processors are not supported.

Gateway requirements

The computer on which you install the Remote Control gateway must have the minimum following items or
specification:

1. At least a 1 GHz Intel® or AMD processor.
2. A minimum of 1 gigabyte (GB) RAM (32-bit) or 2 GB RAM (64-bit)
3. A minimum of 50 MB hard disk space.

Operating system support

The following operating systems are supported:

» Windows™ Server 2012

» Windows™ Server 2012 R2

» Windows™ Server 2016

» Windows™ Server 2019

» Windows™ Server 2022

» Red Hat Enterprise Linux™ 7.0 or later

« Red Hat Enterprise Linux™ 8.0 or later

» Red Hat Enterprise Linux™ 9.0 or later

» SUSE Enterprise Linux™ Server 10 or later

« SUSE Enterprise Linux™ Server 11 or later

« SUSE Linux™ Enterprise Desktop 10 or later
» SUSE Linux™ Enterprise Desktop 11 or later
» SUSE Linux™ Enterprise Server 15

» Cent0S 5.0 or later

« Cent0S 6.0 or later
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Supported Architectures

« Intel™ 1A-32 (also known as x86, x86-32)
* Intel™ 64 or AMD64 (also known as x64, x86-64, EM64T)

Note: IA-64 (also known as Itanium™) processors are not supported.

Broker requirements

The computer on which you install the Remote Control broker must meet specific requirements or specifications
depending on the broker usage:

When the broker is used for On-Demand sessions only:

1. At least a 1 GHz processor with supported OS.

2. A minimum of 4 gigabyte (GB) RAM (32-bit) or 8 GB RAM (64-bit).

3. A minimum of 120 MB hard disk space.

4. Adequate space for storing session video recordings. Recordings are stored temporarily on the hard disk
and their size can vary depending on the duration and screen activity of the session. On average a 5-minutes
session, 8-bits mode, can use about 2 MB of space. In true color 24-bit mode, recordings can take more
space.

When the broker is used for Unattended Targets up to 6000 targets:

1. At least one dual core processor at 2.40 GHz, with supported OS.

2. A minimum of 4 gigabyte (GB) RAM (32-bit) or 8 GB RAM (64-bit).

3. A minimum of 512 MB hard disk space.

4. Adequate space for storing session video recordings. Recordings are stored temporarily on the hard disk
and their size can vary depending on the duration and screen activity of the session. On average a 5-minutes
session, 8-bits mode, can use about 2 MB of space. In true color 24-bit mode, recordings can take more

space.
When the broker is used for Unattended Targets up to 10000 targets:

1. One Quad core or two dual core processors at 2.40 GHz with supported OS.

2. A minimum of 4 gigabyte (GB) RAM (32-bit) or 8 GB RAM (64-bit).

3. A minimum of 764 MB hard disk space.

4. Adequate space for storing session video recordings. Recordings are stored temporarily on the hard disk
and their size can vary depending on the duration and screen activity of the session. On average a 5-minutes
session, 8-bits mode, can use about 2 MB of space. In true color 24-bit mode, recordings can take more

space.
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When the broker is used for Unattended Targets up to 16000 targets:

1. Two Quad core processors at 2.40 GHz with supported OS.

2. A minimum of 4 gigabyte (GB) RAM (32-bit) or 8 GB RAM (64-bit).

3. A minimum of 1 GB hard disk space.

4. Adequate space for storing session video recordings. Recordings are stored temporarily on the hard disk
and their size can vary depending on the duration and screen activity of the session. On average a 5-minutes
session, 8-bits mode, can use about 2 MB of space. In true color 24-bit mode, recordings can take more
space.

Operating system support

The following operating systems are supported:

» Windows™ Server 2012

» Windows™ Server 2012 R2

» Windows Server 2016

» Windows Server 2019

» Windows™ Server 2022

« Red Hat Enterprise Linux™ 7.0 or later

» Red Hat Enterprise Linux™ 8.0 or later

« Red Hat Enterprise Linux™ 9.0 or later

« SUSE Linux™ Enterprise Server 10 or later
« SUSE Linux™ Enterprise Server 11 or later
» SUSE Linux™ Enterprise Server 15

» Cent0S 5.0 or later

« Cent0S 6.0 or later

Supported Architectures

* Intel™ 1A-32 (also known as x86, x86-32)
« Intel™ 64 or AMD64 (also known as x64, x86-64, EM64T)

Note: IA-64 (also known as Itanium™) processors are not supported.



Chapter 3. Get started

Now that you understand the terms and components available in Remote Control, you can identify which components
you need to install:

Table 5. Determining which components to install

Bro-
Requirements Target Controller Server Gateway ker
| want others to remotely connectto  Yes Yes
this computer.
| want to remotely connect to other ~ Yes Yes
computers by using the Remote Con-
trol console or by starting the stand-
alone controller.
To centrally manage users and tar- Yes Optional * Yes
gets, and their policies.
To maintain a central audit and Yes Optional * Yes
recording repository.
Traverse firewalls in your company Yes Optional * Yes Yes
infrastructure
Connect to targets outside your com- Yes Optional * Yes Yes ** Yes

pany network.

* In a managed environment, the controller user starts remote control sessions from the Remote Control server
interface. Starting sessions this way does not require the controller component to be installed separately. The

Remote Control server interface starts a Java Web Start controller console, in context.

** A gateway is not strictly required in a broker deployment but it does increase security.



Chapter 4. Install the Remote Control components

The Remote Control components can be installed in two ways. If you have access to the BigFix® console, use a

deployment fixlet to install the components.

For more information, see the BigFix® Remote Control Console User's Guide. Alternatively use the component

installation files.

You can obtain the installation files in various ways. Choose the appropriate method for obtaining the files. There is

no specific order in which the different components must be installed.

Obtain the installation files

The installation files for installing the Remote Control components can be obtained in various ways.

HCL License & Delivery Portal
To install the Remote Control components, use the following images from Flexnet Operations — HCL License &

Delivery Portal. For more information, refer to the HCL Software knowledge article KB0010149

Note:

IBM Passport Advantage® and Fix Central® have been replaced by FlexNet Operations®.

Table 6. Parts that are required for installing Remote Control
Part number File name
Windows™ operating system Bigfix_Rem Cntrl _V10_Ineage_1.zip
CNJOSML - BIGFIX REM CNTRL V10 IMAGET.
Linux™ operating system Bi gfix_Rem Cntrl _V10 I nage_2.tar
CNJO6ML - BIGFIX REM CNTRL V10 IMAGE2.
Windows™, Linux™, macOS operating systems Bi gfi x_Rem Cntrl _V10_I nage_3.tar

CNJO7ML - BIGFIX REM CNTRL V10 IMAGES.

Depending on the operating system, and the component that you are installing, determines which image file you
require.

Bl GFl X_REM CNTRL_V10_| mage_1. zi p

Extract the installation files for the Windows™ operating system components from this image file. The

Windows™ operating system executable files are in the \ wi ndows directory.
BI GFl X_REM CNTRL_V10_| mage_2.t ar

Extract the installation file for the Linux™ server component from this image

file. Thetrc_server_setup. bi nfileisinthe\ | i nux directory. Use the


https://hclsoftware.flexnetoperations.com/flexnet/operationsportal/logon.do
https://hclsoftware.flexnetoperations.com/flexnet/operationsportal/logon.do
https://hclpnpsupport.service-now.com/csm?id=kb_article&sysparm_article=KB0010149
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Bi gf i x_Rem Cntrl _V10_I mage_3. tar file to access the installation files for the other Linux™

components.

Bl GFI X_REM CNTRL_V10_ | nmage_3.tar

Extract the data from the Bi gFi x_Rem Cntrl V10 | mage_3.tar file. Go to the
\ Di sk1\ I nst Dat a\ pl at f or Ml VMdirectory where platform is relevant to your operating system. The

additional setup utiliy can be run only on Windows™ and Linux™ systems. To extract the installation

files for macOS components, run the utility on a Windows™ or Linux™ system then copy the . pkg files

to the macOS system. For more information about running the additional setup utility, see Extract the

installation files by using the additional setup utility (on page 98).

Downloading the files from the server Ul
If you install the Remote Control server, you can download the installation files for the target, controller, and cli

components. The controller installation file is for the standard controller. For the FIPS-compliant controller installation

file, use the additional setup utility.

1. Click Tools > Downloads.
2. Select Agent Downloads.
3. Select the relevant component file.

Install the server

Remote Control server supports the following installation types:

Table 7. Server installation types

Automated installation - For more
information, see Installing by using

the server installer (on page 36)

Available on Windows® operating system

and Linux operating system.

Derby is installed as embedded or uses ex-

isting supported database. Local or remote.

All embedded components are installed lo-

cally on the same computer.

Manual Installation - For more information, see In-
stalling on WebSphere Application Server ver-

sion 8.5.5: deploying the war file (on page 45)

Available on AlX operating system and Solaris operating system and
for any operating system that WebSphere Application Server 8.5 sup-
ports.

Database must be created or an existing supported database can be

used.

The database can be installed on a separate computer.

Note: The embedded Derby database is not supported in production.

Set up the database

Before you set up the database, install the database software and create the instance where the database for Remote

Control is held.
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Setting up DB2®

To perform the database setup for DB2® complete the following steps. If you are using a Windows® operating
system, begin from step 2 (on page 317). If you are using Linux® operating system or AIX® operating systems,
begin from step 1 (on page 31):

1. To verify that DB2® and the instance are ready for remote connectivity using TCP/IP complete the following

steps:

a. Rundb2 get database manager configuration and verify that the value of svcename is a valid port.

for exanpl e 50000

or a reference napped to a valid port

for exanpl e, db2c_db2i nst 1.

b. Ensure that the configured port is not used by other processes in the system, or blocked by a firewall
that sits between the Application Server host and the DB2® server.

c. Use the db2st op command to stop the DB2® instance.

Set DB2COMM to tcpip with the command

db2set DB2COMVEt cpi p

Run db2start to start the DB2® instance again.

The DB2® server is now ready for accessing over the network.

2. Create the database that Remote Control will use by running the following command as the instance owner:

Note: Not necessary when the database is local.

db2 create db dat abasenanme using codeset UTF-8 territory requiredtrerritory

where databasename is the name required for the database. This database name must be the name that was
referenced in any configuration settings. For example, TRCDB.

requiredtrerritory is the required territory. For example, GB for Great Britain.

3. Verify the privileges that a specific user, for the database, needs to have.
Do not use the db2inst1 user as the user configured to access the Remote Control database. Create a new
specific user for DB2® that has the database owner privileges.

With the blank database created and ready to use, the next step is to set up the WebSphere® server, see Setting up
the application server (on page 45). It is possible to verify that the database is set up properly by using a DB2®
client to connect to the database from another host. For more details see the DB2® Infocenter.
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Setting up Oracle

To set up Oracle to use with Remote Control, create the database and then set up the database permissions.

Creating the database

Run the Oracle database configuration assistant to create the database.

To create the Oracle database that will be used for Remote Control, complete the following steps:

1.

a A WON

Run the Oracle database configuration assistant.
Windows® systems

For example, Select Start > All Programs > Oracle > Configuration and Migration Tools >

Database Configuration Assistant.
UNIX®-based systems

Enter the command dbca from the $ORACLE_HOVE/ bi n directory.

. Click Next on the welcome screen.

. Step 1: Select Create a Database. Click Next.

. Step 2: Select General Purpose for the template. Click Next.
. Step 3:

a. Specify a name for the database. For example, TRcoB.
b. Specify an SID to be used to reference the database. For example, TrcDB.

Click Next.

. Step 4: Select the database management option that you require. For example, Use Database Control for

Database Management. Click Next.

. Step 5: Specify a password for the database and confirm the password. For example, dbor acl e. Click Next.

8. Step 6: Specify where the database will be stored. For example, Fi I e system Click Next.

10.
11.
12.

13.

14.
15.
16.

. Step 7: Specify locations for the database files. For example, Use Database File Locations from Tenpl ate. Click

Next.

Step 8: Select the recovery options for the database. Click Next.

Step 9: On the Database Content window, click Next.

Step 10: On the Initialization Parameters screen select the Character Sets tab.
a. Select the required Database Character Set
b. Click Next.

When you are using Oracle 11g, the following two steps are also required.
a. Security Settings, accept the enhanced 11g default security settings.
b. Automatic Maintenance Tasks, enable automatic maintenance tasks.

Step 11: On the Database Storage window click Next.

Step 12: Select the required Creation Options. Click Finish.

On the Confirmation screen, click OK to start the database creation.
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Note: This may take some time as it goes through the different stages.

17. Click Exit when the database creation is complete.

The Oracle database that will be used for Remote Control is created.

Setting up database permissions

When you have created the Oracle database that will be used for Remote Control you will need to configure its

permissions.

To configure the database permissions complete the following steps:

1. Run Oracle SQL*Plus.

Windows® systems

For example: Click Start > Programs > Oracle-OraHomeName > Application Development > SQL
Plus.

Alternatively, enter the following command at a command prompt.

sqlplusw

Log on using the database user name and password and click OK. See your database system
administrator if you do not have this.

For example:
Username - system

Password - dboracle
Linux® systems

Open a UNIX® or a Windows® terminal and enter the SQL*Plus command:

sqlplus username / password @connect_identifier

username and password are the database credentials required to connect to the database.
connect_identifier is the connection required for your specific database.

For example, @ TRCDB as SYSDBA

@//servername:port/DatabaseSID as SYSDBA

servername is the server name or IP address of the system where your Oracle installation is
located.
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port is the port of the system where your Oracle installation is located.

DatabaseSID is the SID defined for the database you created.

The SQL*Plus executable is installed in $ORACLE_HOVE/ bi n, which is included in your
operating system PATH environment variable. You may need to change directory to the
$ORACLE_HOVE/ bi n directory to start SQL*Plus.

After SQL*Plus has started and connected to the database you can create the required users and grant
permissions. There are two methods for creating users and granting permissions. Choose the appropriate
method for creating the users.

Create one user ID in Oracle which will also be used to log on to Remote Control.

Create a single user. The user must be called Asset. This user ID is used by Remote Control to

create and log on to the database, and use the database.

Issue the following commands to create the user ASSET.

a. connect SYS/PASSWORD@DATABASE AS SYSDBA;
where PASSWORD is the default Oracle user password.

and DATABASE is the database name that was defined when creating the database. For
example, TRCBD.

b. CREATE USER ASSET IDENTIFIED BY PASSWORD DEFAULT TABLESPACE users
TEMPORARY TABLESPACE temp;

Note: PASSWORD can be changed to whatever you require, for the user ASSET.

. GRANT UNLIMITED TABLESPACE TO ASSET;
. GRANT CONNECT TO ASSET;

. GRANT CREATE INDEXTYPE TO ASSET;

. GRANT CREATE SEQUENCE TO ASSET;

. GRANT CREATE TABLE TO ASSET;

. GRANT CREATE TRIGGER TO ASSET;

. GRANT CREATE INDEXTYPE TO ASSET;

. GRANT CREATE PROCEDURE TO ASSET;

k. GRANT CREATE VIEW TO ASSET;

. GRANT ANALYZE ANY TO ASSET,
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Create a separate user ID to log on to Remote Control

Create 2 users. User 1 must be called Asset. This user has no specific permissions and is used
only as a schema name. User 2 is the main user and can be called anything you require. This
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user is used by Remote Control to create and logon to the database, and use the database. Use

the assistant tool to create user TRCDBU.

Complete the following steps to create the required permissions for user TRCDBU.

. GRANT UNLIMITED TABLESPACE TO ASSET,
. GRANT UNLIMITED TABLESPACE TO TRCDBU,;
. GRANT ALTER ANY INDEX TO TRCDBU ;
. GRANT ALTER ANY INDEXTYPE TO TRCDBU ;
. GRANT ALTER ANY PROCEDURE TO TRCDBU;
. GRANT ALTER ANY SEQUENCE TO TRCDBU ;
. GRANT ALTER ANY TABLE TO TRCDBU ;
. GRANT ALTER ANY TRIGGER TO TRCDBU ;
i. GRANT COMMENT ANY TABLE TO TRCDBU ;
j- GRANT CREATE ANY INDEX TO TRCDBU ;
k. GRANT CREATE ANY INDEXTYPE TO TRCDBU ;
|. GRANT CREATE ANY SEQUENCE TO TRCDBU ;
m. GRANT CREATE ANY TABLE TO TRCDBU ;
n. GRANT CREATE ANY TRIGGER TO TRCDBU ;
0. GRANT CREATE INDEXTYPE TO TRCDBU;
p
q

o Q -~ 0 o O T o

. GRANT CREATE PROCEDURE TO TRCDBU ;

. GRANT CREATE SEQUENCE TO TRCDBU

r. GRANT CREATE TABLE TO TRCDBU;
s. GRANT CREATE TRIGGER TO TRCDBU ;
t. GRANT CREATE VIEW TO TRCDBU ;
. GRANT DELETE ANY TABLE TO TRCDBU ;
. GRANT INSERT ANY TABLE TO TRCDBU,;
. GRANT DROP ANY INDEX TO TRCDBU ;
. GRANT DROP ANY INDEXTYPE TO TRCDBU ;
. GRANT DROP ANY PROCEDURE TO TRCDBU ;
. GRANT DROP ANY SEQUENCE TO TRCDBU ;
aa. GRANT DROP ANY TABLE TO TRCDBU ;
ab. GRANT DROP ANY TRIGGER TO TRCDBU ;
ac. GRANT EXECUTE ANY INDEXTYPE TO TRCDBU ;
ad. GRANT EXECUTE ANY LIBRARY TO TRCDBU ;
ae. GRANT EXECUTE ANY TYPE TO TRCDBU;

af. GRANT SELECT ANY SEQUENCE TO TRCDBU ;
ag. GRANT SELECT ANY TABLE TO TRCDBU;
ah. GRANT UNLIMITED TABLESPACE TO TRCDBU ;
ai. GRANT UPDATE ANY TABLE TO TRCDBU;

aj. GRANT ANALYZE ANY TO TRCDBU,;

N <« X = < c
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Setting up MSSQL

To set up MS SQL to use with Remote Control, create the database and then set up the database permissions.

Creating the database

Use the MS SQL management studio to complete the following steps:

. Click Connect.

. Right-click the server tree and click properties.

. Select security.

. Ensure that SQL server and authentication mode is selected.
. Expand the server tree.

. Right-click databases.

. Select Create New Database.
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. Enter a name for the database. For example, TRCDB. Click OK.

The default owner of the database is user sa, the system administrator. Create a new user, to be the owner of the
database being used with Remote Control.

Database permissions

The default system administrator is the owner of the database and therefore has the required permissions for using
the database. If you have created a new user, they also have the required permissions if they have been assigned as
the owner of the database.

Installing by using the server installer

The Remote Control server installer can be used on Windows™ operating systems, Red Hat Linux™ operating systems,
and SUSE Linux™ operating systems. A fully functional self-contained server with either of the following component
setup is installed.

» Remote Control server with WebSphere® Application Server Liberty Profile version and a Derby database.
« Remote Control server with WebSphere® Application Server Liberty Profile version and one of the following
databases:
> IBM DB2 11.5 Virtual Processor Core (VPC).
> Oracle 11g, 12c, and 19c.
When you use an Oracle database, if you are using the Oracle 11g drivers, set
oracle.increment.keys.off=1 in the trc.properties file. Restart the server service.

> Microsoft SQL server 2008, 2012, 2014, 2016, 2017, 2019, and 2022.
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You must use a JDBC driver whose version is higher than 6.3. Older versions do not support TLS1.2 or
JRES.

When you use an MS SQL database, Windows™ authentication is not supported. You cannot log on
with a domain user. You must use mixed mode authentication and create an SQL user to connect to

the database.

For more information about the supported versions of the installed components, see Server requirements (on page
16)

Note: Click Cancel at any time to end the installation.

Approximate installation time

« Specifying options in the installer: 5 - 10 minutes.
« Installation of the software: 5 minutes.

1. A minimum screen resolution of 1024 by 768 pixels is recommended when you are using the installer.
2. On a Linux™ operating system, you must install libstdc++.s0.5 when you are installing and configuring the
operating system. If this package is not installed, you can install package compat-libstdc++-33, which

contains libstdc++.s0.5.

Note:

« Console mode installation is not supported.
« During the file copy phase of the server installation:
> A backup copy of any existing installation is saved. This feature is useful if a problem occurs
with the installation when you are upgrading.
» The following directory is deleted if it exists:

[ NSTALLDI R}/ trcserver . bak.

> The current server installation in [ | NSTALLDI R] / wl p/ usr/ servers/trcserver isthen
renamed or moved to [ | NSTALLDI R}/ tr cser ver . bak.
You can access the backup directory to restore or recover anything from the previous installation.

To install the Remote Control server application, complete the following steps:

1. Run the server installation file relevant to your operating system.
Windows™ systems
trc_server_setup. exe

Linux™ systems
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trc_server_setup.bin

To obtain the installation file see Obtain the installation files (on page 29).
2. Choose the language and click OK.
3. At the Introduction window click Next.
4. Click to accept both the IBM® and non-IBM® terms, click Next.
5. Accept the default location or click Choose to define a location for the installation files, click Next.

Note: WebSphere® Application Server cannot be installed in a directory with a name that contains
non-English-language characters. This installation installs an embedded version of WebSphere®
Application Server. Therefore, you must choose a destination for the installation files that do not

contain any non-English-language characters.
6. Select the database, click Next.
Note: Derby is embedded in the application and is installed locally when you select Derby. To use
DB2® or Oracle, you must install them and create a database instance before you install Remote

Control.

7. Enter the options for your selected database and click Next.

Derby
a. Specify a name for the database, click Next. For example, TRcoB.
Note: If you are using an existing database, you can choose to drop the
database.
DB2®

Database server

The IP address or host name of your database server.

Note: 127.0.0.1 can be used when DB2® is installed locally. If you install

DB2® on a remote system, type the IP address of the remote system.

Port

Port on which DB2® is installed.

Note:
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a. On Windows™® systems, the default port is 50000. On Linux™
24 systems, the default port is 50001.
b. A remote DB2® installation is limited to type four connections.
A local installation can use type two or four. For type two

connections, set the port value to 0.

Administrator Userid
Specify the Administrator user ID that is used for logging on to the database. The
user ID must have admin access to the database.

If you select create database, the user ID must have administrator access for
DB2®.

Administrator password

Specify the Administrator password for connecting to the database.
Database Name

Specify a name for the database. For example, TRcDB.

Note: If you are using a remote database, type the name of the database
that was created on the remote system.

Directory path to db2jcc.jar file

Specify the path to the DB2® JAR files, db2j cc. j ar,and db2j cc_l i cense. j ar

Note: If you are using a remote database share the drive, on the remote
system, that the DB2® JAR files are in. Enter the shared drive location.

Create database

If DB2® is installed locally (127.0.0.1), you can select to create a blank database
during the installation. You can also select to drop an existing local database and
create a new database.

Note: Do not select create database or drop database if you are using a
remote database.

Path for database install

Specify the path where the database can be installed. If the installation is local and
you select to create the database, the admin user who is specified must have the
appropriate authority. On a Windows™ system, use the db2admin user, and on a

Linux™ system, the user must be a member of the group db2grp1.
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Note:

Linux™ systems

Specify a directory that the admin User ID has read and write

permissions for.
Windows™ systems

Specify a drive letter.

Oracle
Database server

The IP address or host name of your database server. 127.0.0.1 can be used when
Oracle is installed locally. If you install Oracle on a remote system, type in the IP
address of the remote system.

Port
Port on which Oracle is installed.
Administrator Userid

Specify the administrator user ID that is used for logging on to the database. The
user ID must have admin access to the database.

Note: For an Oracle installation, a user that is called asset must exist. This

user ID can be used here or use an existing or new user.

Administrator password
Specify the administrator password for connecting to the database.
Database Name

Specify a name for the database. The name is the SID name on the server, not the

oneintnsnanes. or a. For example, TRcDB.
Directory path to the oracle Java JDBC library

Specify the path to the oracle Java™ JDBC library. The location can be obtained
from the Oracle server installation or downloaded from the Oracle website. For
example, c: \ oracl e\ ora92\j dbc\li b\ oj dbc14. | ar

MSSQL
Database server

The IP address or host name of your database server.
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Note: 127.0.0.1 can be used when MS SQL is installed locally on a

Windows™ system only.

Port
Port on which MS SQL is installed.
Administrator Userid

Specify the administrator user ID that is used for logging on to the database. The
user ID requires admin access to the database.

Administrator password

Specify the administrator password for connecting to the database.
Database Name

Specify a name for the database. For example, TRcDB.
Directory path to the MS JDBC Java files

Specify the path to the MS JDBC Java files. The nssql -j dbc-X. X. X. jre8. j ar file
must be used depending on the version of MS SQL database that you are using.

If installed on the same server, select to create database
If MS SQL is installed locally, you can select to create the database.
Drop the database if installed locally

Select if you already have an existing database with the name that is entered for

Database Name that you do not want to use.
If local, select path where to create the database

Specify the database installation path. If the installation is local and you select to

create the database the Admin user must have appropriate authority to do so.
Linux™ systems.

Specify a directory that the admin User ID has read and write

permissions for.
Windows™ systems.
Specify an existing directory.
8. Specify the web server parameters then click Next.
Force targets to use HTTPS

Select this option for the target software to communicate with the server by using the HTTPS
URL. The enforce.secure.endpoint.callhome and enforce.secure.endpoint.upload properties
inthetrc. properti es file are also set to true. The check box is selected by default on a new

installation.
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Regardless of your selection, the enforce.secure.web.access, enforce.secure.weblogon, and
enforce.secure.alllogon properties that enable HTTPS logon and access to the web portal, are
all set to True by default. For more information about these properties, see the BigFix® Remote
Control Administrator's Guide.

Note: If you are using HTTPS, you must use a fully qualified domain name for the server

name.

Use secure registration tokens to register targets

Select this option to enable the secure target registration feature. This feature prevents
unauthorized targets from registering with the Remote Control server. The check box is selected
by default on a new installation. Ensure that the Force targets to use HTTPS option is also
selected. For more information about secure registration, see Enable secure target registration
(on page 99).

Upload data to server

The fully qualified name for the Remote Control server. For example, trcser ver . exanpl e. com

Note: You must make sure that you enter the fully qualified name. The name is used
for creating the URL inthe t rc. properti es file that is passed to the target after it
contacts the server for the first time. If the fully qualified name is incorrect, the target

might not be able to contact the server successfully when it is next due to contact it.

Web path of URL

Specify the web path for the server URL. For example, /trc.
Server port on Webserver (default 80)

Specify a port for the server.
SSL Port (default 443)

Specify a port for SSL.
Administrator email

Specify an administrator email address. For example, adni n@onpany. com

Note: To use the email function, you must install a mail server. Edit the
trc. properti es file after you install the Remote Control server. For more information

about editing the properties files, see the BigFix® Remote Control Administrator's Guide

Enable FIPS
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Select this option to enable FIPS compliance on the server. For more information about enabling
FIPS compliance, see Federal information processing standard (FIPS 140-2) compliance in

Remote Control (on page 129) .
Enable NIST SP800-131A Compliance (Enables FIPS)

Select this option to enable NIST SP800-131A compliance on the server. For more information
about enabling NIST SP800-131A compliance, see NIST SP800-131A compliance in Remote
Control (on page 138).

9. Select options for your SSL certificate and click Next. The certificate configuration is stored in the ssl . xni
file.

Use an auto generated certificate store

Select this option to use a self-signed certificate that is generated by the installer.

Note: If the following options are not enabled, click Use an auto generated certificate
store to enable them.

Overwrite an existing certificate store.

If a self-signed certificate store is already saved, the new certificate overwrites the

saved certificate store. This option is the default option.
Password for a new or a previously generated certificate store.

Type a new password for the self-signed certificate. If you do not select to
overwrite, type the password for your existing auto generated certificate store.
If left blank, the default password TrCWebAS is saved as the password. The
password must have a minimum of 6 characters.

Select an existing certificate store
Select this option to use an existing certificate store that is already saved.
Select existing certificate store location.

Click Choose to browse to the relevant certificate store. Select the certificate store.
The file extension canbe . j ks or . p12.

When you use an existing certificate store, it is not copied to the installation
directory during installation. The server software instance points to the location

of the certificate store that you provide. Therefore, you must make sure that you
save the certificate store to an adequate location on the server before you start the
server installation. The certificate store must be stored in a location that does not
get deleted. Therefore, do not save the fileinthe [ i nstal | di r]\ w p directory
or any of its subdirectories. Do not delete the certificate store at the end of the
installation.
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If you select a previously saved auto-generated certificate store from the server
installation directory, a warning is displayed. Choose Copy file to copy the file
to a location that is not deleted during the installation. If the file is not copied
successfully, you must manually copy the certificate store file to another location.
Click Choose and select the new location of the file.
Click Restore Default to reset the field value to its original value.

Enter the certificate store password.

Type a password for the certificate store.

10. Select options to configure Single-Sign-On (SSO) and click Next. The SSO configuration is stored in the
sso. xm file.

Enable SSO

Select this option to enable Single-Sign-On (SSO). To continue with the configuration, you must
get the SAML metadata XML file from the Identity Provider (IdP) and which hash algorithm they
are using: SHA-1 or SHA-256.

Metadata XML file
Click Choose and select the SAML metadata XML file that you obtained from the IdP.
Algorithm used to sign SAML messages

Select the signature algorithm (SHA-1 or SHA-256) to use to sign messages in communications
between the Identity Provider (IdP) and this Service Provider (SP) which is the BigFix® Remote
Control Server.

Advanced parameters (optional)

Type in further configuration options, by adding attribute names in a space-separated list, in
the following format: [keyword]="[keyword-value]". Where [keyword] is the attribute name and

[keyword-value] is the attribute value.
Force regeneration of SAML data. (you must re-register with the IdP)

The first time that you enable SSO, a new default SAML certificate keystore is created. For future
upgrades, you can select the regeneration option to create a new default certificate keystore.
The current keystore is deleted and the new one is saved. When you select this option, you must
reestablish the connection between the SP and the IdP after the server restarts.

11. Select a location for the product icons to be displayed.
If you select Other, click Choose to specify a location.

Note: Product icons do not work when you are using Linux™.

12. In the Summary pane, click Install.
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13. If you selected to enable SSO, a pane that is labeled as Important is displayed. Take note of the URL and
information and click Next.
14. Click DONE to complete the installation.

The Remote Control server software is installed including a set of properties files. These files can be edited to

configure your environment.

Note:

1. Itis important to make sure that the URL property inthe t r c. pr oper ti es file contains the correct
URL for the Remote Control server. This property is used when targets contact the server and for
determining the server during a remote target installation. If the URL property value is not correct, the
remote targets are not able to contact the server successfully. Therefore, you might have problems
when you start remote control sessions with the targets.

2. If the IP address of the server changes at any time, make sure that you update the URL property in
trc. properti es. Restart the server service because the targets try to contact to the old IP address

until the change to the property is made.

Installing on WebSphere Application Server version 8.5.5: deploying the war file

As described in the prerequisites section, a database needs to be created for Remote Control. After the database is
created, add it to the WebSphere® data sources.
Setting up the application server

It is necessary to create the WebSphere profile in a folder that does not include any spaces in its path. Otherwise,

unrecoverable issues might occur when you deploy the application war file.
Use the WebSphere Integrated Solution Console to configure the application server.

To access the Integrated Solution Console, complete the following steps:

1. In your browser type

https://[server : port]/ibm consol e
where server is the | Paddress or nane for the application server nmachine
for exanpl e |ocal host or 192.0.2.0

and port is the port that the server is listening on.

The default port for the WebSphere Application Server admin console is 9060.
2. Log on with the ID and password that you defined when you installed WebSphere.

DB2® configuration
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Creating DB2 database authentication data
Creating authentication data for connecting to an Remote Control DB2 database

Credentials to use for the database connection need to be established and added as a new entry to the JAAS-J2C

authentication data.

To create an entry complete the following steps:

1. Click Security > Global Security.

2. On the right of the screen, expand Java™ Authentication and Authorization Services .
3. Click J2C authentication data.

4. Click New to add a new entry.

5. Supply the following information:
Alias
Specify a name for the authentication alias.
Userid

Type the user ID that was defined when DB2® was installed. Can be one of the following users.
> The user who has permissions to access the TRCDB database, if a specific user was
created.
> The DB2® owner instance, db2admin in a Windows® system and db2inst1 in UNIX® /

Linux® system.
Password
Type the password that you defined when you installed DB2®.

6. Click OK.
7. Click Save.

Verifying the Websphere variables

The JDBC Provider uses WebSphere® environment variables to define the paths to the JDBC driver JAR files.
« db2jcc.jar
 db2jcc-javax.jar

- db2jcc-license_cu.jar
« db2jcc4. jar. If available.

Verify that the correct values are defined by completing the following steps:

1. Select Environment / WebSphere® Variables.
2. Click DB2UNIVERSAL_JDBC_DRIVER_PATH and verify that this points to the DB2® libraries.

Local DB2® database

If you have installed the DB2® database locally the files are located in
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Windows® systems
\Program Fil es\i bm sqgl lib\java

Linux® systems

/opt/ibm db2/ VERSI ON/ j ava
where VERSION is the DB2 version nunber
for exanple: /opt/ibnmdb2/V8.1/java
Remote DB2® database

If you are using a remote DB2® database you must copy the jar files from the remote system to

a location on your local system and put the path to the local files here.

3. Click OK.
4. Click Save.

Creating the DB2 data source

When you have verified that the JDBC Provider is configured properly, the data source for Remote Control must be
created using that JDBC Provider.

To create the data source complete the following steps:

1. Select Resources > JDBC > Data Sources.
2. Select the scope from the drop down menu that includes the node and the server.
For example, Node=TEST-2008Node02, Server=server1.
3. Click New.
4. Specify the data source information.
a. Enter basic data source information
Data source name
Specify a name for the data source. This can be any required name.

JNDI Name

This should be set to j dbc/trcdb

Note: If this name is changed, you need to change the common.properties file
also.

b. Select JDBC Provider

The data source will use the Universal JDBC Provider for DB2 that is predefined in WebSphere.

i. If DB2 Universal JDBC Driver Provider is available, select Select an existing JDBC provider
from the list. If it is not available, click Create new JDBC provider.
ii. In the Database type list, select DB2.
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iii. Select DB2 universal JDBC Driver provider.
iv. From the Implementation type list, select Connection pool data source.
v. Click Next.
vi. Accept the default values and click Next.
c. Enter database specific properties for the data source
Driver Type
Select 4 from the list.
Database name
This is the name used when the db2 create db command was issued.

Server name

This is set to the IP or host name of the server where DB2® is installed. If DB2 is
installed locally you can use localhost.

Port number
This is set to the port that was configured in DB2® for remote connections.

Click Next.

d. Setup security aliases
i. From the Component-managed authentication alias list, select your node/DB2 where your
node is the node you previously created for DB2.
ii. Accept the default of none in the remaining lists.
iii. Click Next.

e. Review the summary and click Finish.

5. To save the configuration changes, click Save.

When the data source has been created and the changes to the profile are saved, test that the data source is correctly
configured. Select the data source from the list of data sources and click Test connection. If the connection is
successful, a conformation message is displayed. A failure in the test should be corrected before continuing with the
installation, as Remote Control will not work without a valid data source.

Oracle configuration

Creating Oracle database authentication data

Credentials to use for the database connection need to be established and added as a new entry to the JAAS-J2C
authentication data.

To create an entry complete the following steps:
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1. Click Security > Global Security.

2. On the right of the screen, expand Java™ Authentication and Authorization Services .
3. Click J2C authentication data.

4. To add a new entry, click New .

5. Supply the following information:
Alias
Specify a name for the authentication alias.
Userid

Type the ID that was defined when the Oracle database was created.This is the user that you
created permissions for.

Password
Type the password that was defined when Oracle was installed.

6. Click OK.
7. Click Save.

Creating the Oracle JDBC provider
To establish access to your Oracle database you must create a JDBC provider for Oracle access.

To create the JDBC provider complete the following steps:

1. Select Resources > JDBC > JDBC Provider.

2. Select Scope and choose the one which has Node and Server.
3. Click New.

4. Specify the JDBC provider information

Database type

Setto oracle.
Provider Type

Setto Oracle JDBC Driver.
Implementation type

Set to Connection Pool datasource.

5. Click Next.

6. The Class path is already pre-populated as ${ ORACLE_JDBC DRI VER PATH}/ oj dbc6. j ar . The directory
location for ${ ORACLE_JDBC DRI VER _PATH} to the jar files must be correct. This can be obtained from the
Oracle server installation or downloaded from the Oracle website. For example, C: \ app\ Admi ni strat or
\ product\ 11. 2. 0\ dbhone_1\j dbc\ | i b. Click Next.

7. Click Finish.

8. Click Save.
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Verifying the Websphere variables

The JDBC Provider uses WebSphere® environment variables to define the paths to the JDBC driver JAR files. Verify
that the correct values are defined by completing the following steps:

1. Select Environment / WebSphere® Variables.

2. Click ORACLE_JDBC_DRIVER_PATH
and verify that this points to the directory location chosen in step 6 (on page 49) in the Creating the Oracle
JDBC Provider section.

3. Click OK.

4. Click Save.

Creating the Oracle data source

When you have verified that the JDBC Provider is configured properly, the data source for Remote Control must be
created using that JDBC Provider.

To create the data source complete the following steps:

1. Select Resources > JDBC > Data Sources.
2. Select the scope with Node and Server.
3. Click New.
4. Specify the data source information
a. Specify the data source information.
Data source name
Specify a name for the data source. This can be any required name.

JNDI Name

This should be settoj dbc/trcdb

Note: If this name is changed, further changes to the common.properties file are
also required.

Click Next.
b. Select JDBC provider
Click Select Existing JDBC provider and select Oracle JDBC Driver. Click Next.

c. Enter database specific properties for the data source.
URL

url=jdbc:oracle:thin@dbserver:1521:SID

where dbserver is the IP address of the server.
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SID is the Oracle database SID.
Data store helper class name
Accept the default Data store helper class name, Oracle 11g.data store helper.
Accept remaining default selected values and click Next.
d. Set up security aliases
i. Select Component-managed authentication alias and select the alias you previously created
for Oracle.

ii. Accept the default of none in the remaining lists.
iii. Click Next.

e. On the summary screen, click Finish to create the data source.
5. Click Save.

You can select the newly created datasource and click Test, to test connectivity.

MS SQL configuration

Creating authentication data

Credentials to use for the database connection need to be established and added as a new entry to the JAAS-J2C
authentication data.

To create an entry complete the following steps:

1. Click Security > Global Security.

2. On the right, expand Java™ Authentication and Authorization Services .
3. Click J2C authentication data.

4. To add a new entry, click New.

5. Supply the following information:

Alias
Specify a name for the authentication alias.
Userid

Type the ID that was defined when MS SQL was installed. This is the user that you created

permissions for. Default is sa.
Password
Type the password that was defined when MS SQL was installed.

6. Click OK.
7. Click Save.
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Creating the JDBC provider
To establish access to your MS SQL database you must create a JDBC provider for MS SQL access.

To create the JDBC provider complete the following steps:

1. Select Resources > JDBC > JDBC Provider.

2. Select Scope and choose the one which has Node and Server.
3. Click New.

4. Specify the JDBC provider information.

Database type
Set to sQU Server.
Provider Type
Setto M crosoft JDBC Driver .

. Select Connection pool data source.

. Click Next.

. To accept the path to the jar files, click Next.
. Click Finish.

. Click Save.

O© 00 N o0 »

Verifying the Websphere variables

The JDBC Provider uses WebSphere® environment variables to define the paths to the JDBC driver JAR files. The

correct jdbc driver software must be downloaded from Microsoft. The following version is recommended:

Microsoft JDBC Driver 4.0 for SQL Server - sqljdbc_4.0.2206.100_enu.exe

Download the SQL Server jdbc driver and copy it to the root drive of the server. Run the file to extract the driver. The

sqgl j dbc4. jar fileis extracted to the following directory structure:
C:\extract_path\sqljdbc_4.0\enu\

where extract_path is the directory chosen when you unzipped the file.
Note: The path cannot contain any spaces.

Verify that the correct values are defined by completing the following steps:

1. Select Environment / WebSphere® Variables.

2. Click MICROSOFT_JDBC_DRIVER_PATH and verify that this points to the Microsoft SQL Server JDBC driver,
sqljdcb4 jar file that you extracted.

3. Click OK.

4. Click Save.
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Creating the MS SQL data source

When you have verified that the JDBC Provider is configured properly, the data source for Remote Control should be
created using that JDBC Provider.

To create the data source complete the following steps:

1. Select Resources > JDBC > Data Sources.
2. Select the scope with Node and Server.
3. Click New.
4. Specify the data source information
a. Enter basic data source information
Data source name
Specify a name for the data source. This can be any required name.

JNDI Name

This should be set to jdbc/trcdb

Note: If this name is changed, the datasource.context property in the
conmon. properti es must be changed after the WAR file is deployed. After the
correct value is set, save the file and restart the application from the Websphere
admin console.

b. Select JDBC provider
Select Microsoft SQL Server JDBC Driver or the required JDBC provider. Click Next.
c. Enter database specific properties for the data source
Database name
This is the name used when you created the MS SQL database.
Port number
Port used when installing MS SQL. Default is 1433.
Server name
This is set to the IP or hostname of the server containing the MS SQL installation. If MS

SQL is installed locally you can use localhost.

d. Set up security Alias
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i. Select Component-managed authentication alias and select the alias you previously created
for MS SQL.
ii. Accept the default of none in the remaining lists.
iii. Click Next.

e. On the summary screen, click Finish to create the data source.

5. Click Save.

Deploying the Remote Control application

After you install and set up the application server, deploy the application code for Remote Control on the WebSphere®
server. You require the t r c. war file that can be obtained by using the additional setup utility to extract the server

installation media.

Note:

1. The heap size must be set to at least 512 MB for this type of installation.

To deploy the server application, complete the following steps:

1. Extractthe t r c. war file by using the additional setup utility. For details about the files that are required and
for running this utility, see Utility for extracting the component installation files (on page 97).
2. In the WebSphere administrative console complete the following steps:

a. Select Applications > New Applications.

b. Click New Enterprise Application.

c. Click browse and type the path to the trc.war file in a local or remote file system. Click Next.
d. On the Preparing for the application installation screen, select Fast path. Click Next

e. Step 1: Installation options
The default options can be left. The application name can be changed to something more descriptive
but it must not contain any spaces. Click Next.

f. Step 2: Map modaules to servers
Leave the default association to the server. Click Next.

g. Step 3: Map virtual hosts for Web modules
The default association to the default_host, virtual host can be changed. Click Next.

h. Step 4
Use/ t r c as the context root, otherwise further changes must be made inthetrc. properti es file.
Click Next.
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i. Step 5
A summary of the chosen deployment settings is displayed before the installation of the Remote
Control application proceeds.

Click Finish

A status page for the installation in progress and the outcome when the installation is finished is
displayed.

j. Click Save to save to the master configuration.

The Remote Control application is displayed in the list of Enterprise Applications with the descriptive name
that you entered in the Installation options step of the deployment process. Before you start the application,
you can customize thet rc properti es file and change the default values. The properties files are deployed
with the application and are in the i nst al | edApps directory within WebSphere. For more information about
the properties in the files, see the BigFix® Remote Control Administrator's Guide.

Note: Ensure that the correct server IP address or server name is set in the URL field in the
trc.properties file, so that the targets connect to the correct server. If you are using HTTPS, the host
name or IP address that is set in the URL property must exactly match the value of the CN field of the

SSL certificate that is installed on the server.

Installing from the BigFix console

You can create and run a server installation task to install the server by using the BigFix® console. For more
information, see the BigFix® Remote Control Console User's Guide and the chapter about Managing target and server
configuration.

Install the target

The Remote Control target can be installed on every computer that you want to control remotely. You can also use it

to start a remote control session over the internet, by using a broker to make the connection.

Remote Control provides two ways to install the target component. If you have access to the BigFix® console, use the
deployment fixlets to deploy the target. For more information, see the BigFix® Remote Control Console User's Guide.
Alternatively use the Remote Control target installation files.

Installing the Windows™ target

Thetrc_target setup. exe fileis required to install the Remote Control target component on a Windows™
system.

For details of how to obtain the Windows™ component installation files see, Install the Remote Control components
(on page 29). Choose the appropriate method for obtaining the file.
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.Runthetrc_target setup.exe file.

. Click Next at the welcome screen.

. Accept the license agreement. Click Next.

. Accept the default location for the installation files, or click Change to select a different location.

a A WON =

. Specify the host name of the Remote Control server that the target connects to.

For example, trcser ver. exanpl e. com

Note: Select Use secure connections (https) if you selected to use HTTPS during the server
installation.

6. On the Server Address window, for secure target registration, enter or paste the Registration token.
Ensure that Use secure connections (https) is also selected. For more information about secure target
registration, see Add a token for secure target registration (on page 100)

7. For advanced settings, click Advanced settings

Server port

The port must match the value that is entered for the Server port on Webserver parameter
during the server installation.

Server Context

The server context is used as part of the URL for contacting the server. It must match the value
that is entered after the '/' in the Path to URL field, on the Web server parameters screen during

the server installation.
Use a FIPS certified cryptographic provider

Select this option to enable FIPS compliance on the target. For more information about enabling
FIPS compliance, see Enable FIPS compliance on the target (on page 134).

Enable NIST SP800-131A compliance (Enables FIPS)

Select this option to enable NIST SP800-131A compliance on the target. For more information
about enabling NIST SP800-131A compliance, see NIST SP800-131A compliance in Remote
Control (on page 138).

8. Click Next.
9. On the Proxy settings screen if you are not using a proxy server, click Next.
> To use a Proxy, select Use a proxy server or a Remote Control Gateway.

a. Type in the IP address or host name for the Proxy server.

b. Type in the port that proxy server is listening on.

c. Select whether you are using an HTTP proxy or a Remote Control Gateway.

d. Select Proxy requires authentication if you must authenticate with the proxy server. Enter
the ID and password for authenticating to the proxy server. The user ID and password are
automatically encrypted when the target starts. For more information about the automatic
passphrase encryption, see the BigFix® Remote Control Administrator's Guide.
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Note: When you rerun the target installer and select Modify after the user ID and
password are encrypted, the encrypted user ID and password combination is displayed

in the user ID field. The password field remains empty.

e. Click Next.
10. Accept or change the port value to be used to listen for incoming remote control sessions. Click Next.

Note: Your operating system might have a firewall, an antivirus or an intrusion detection system that is

installed by default. For more details, see Target requirements (on page 23).

11. To enable failover to peer-to-peer mode, select one of the following options:

Regardless of server status

A peer to peer session can be established between a controller and this target directly if the
server is available or not. Click Peer to Peer policies to set the local policies for the target to use
during a peer to peer session. Click Next to move through the peer to peer policies screens.

Only when server is down or unreachable

A peer to peer session can be established only if the server is down or the target cannot connect
to the server. Click Peer to Peer policies to set the local policies for the target to use during a
peer to peer session. Click Next to move through the peer to peer policies screens.

Never

A peer to peer session is not allowed directly between a controller and this target. If you select

this option, continue from step 12 (on page 75).

Peer to Peer policies

Session policies options

Table 8. Session policies options.

Installation Default
option. Target Property. Value. Description
Active AllowActive Selected. Determines whether the target can take part in active peer to

peer sessions. For more information about the different types
of remote control session that can be started, see the BigFix®
Remote Control Controller User's Guide.

Selected.

The target can take part in active peer to peer

sessions and the Active option is available in the

session type list in the controller window. The
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Installation Default

option. Target Property. Value. Description
Open connection window also displays an Active

option.
Not selected.

The target cannot take part in active peer to peer
sessions and the Active option is not available in

the session type list in the controller window.

Guidance AllowGuidance Selected. Determines whether the target can take part in guidance peer
to peer sessions. For more information about the different
types of remote control session that can be started, see the

BigFix® Remote Control Controller User's Guide.
Selected.

The target can take part in guidance peer to peer
sessions and the Guidance option is available in
the session type list in the controller window. The
Open connection window also displays a Guid-

ance option.
Not selected.

The target cannot take part in guidance peer to
peer sessions and the Guidance option is not
available n in the session type list in the con-

troller window.

Monitor AllowMonitor Selected. Determines whether the target can take part in monitor peer to
peer sessions. For more information about the different types
of remote control session that can be started, see the BigFix®

Remote Control Controller User's Guide.
Selected.

The target can take part in monitor peer to peer
sessions and the Monitor option is available in
the session type list in the controller window. The
Open connection window also displays a Monitor
option.

Not selected.
The target cannot take part in monitor peer to
peer sessions and the Monitor option is not avail-

able in the session type list in the controller win-

dow.
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Installation Default
option. Target Property. Value. Description
Enable high EnableTrueColor Not select-
Determines whether the target desktop is displayed in high-
quality colors ed.
quality colors in the controller window at the start of a session.
Used together with Lock color quality.
Selected.
The target desktop is displayed in true color
24-bit mode at the start of the session. Partial
screen updates are also enabled.
Not selected.
The target desktop is displayed in 8-bit color
mode at the start of the session. Partial screen
updates are also enabled. This value is the de-
fault value.
Lock color LockColorDepth Not select-
Determines whether the color quality that a remote control ses-
quality ed.

sion is started with can be changed during the session. Used

together with Enable high quality colors.
Selected.

The initial color quality, for the remote control
session, is locked and cannot be changed during
the session. The Performance settings icon is
disabled in the controller window. The controller
user cannot change settings to improve the ses-

sion performance if their network is slow.
Not selected.

The color quality can be changed during the ses-
sion. The Performance settings icon is enabled

in the controller window.

Remove desk- RemoveBackground Not select-  If the target has a desktop background image set, this property

top back- ed. can be used to remove the background from view during a re-
ground mote control session.
Selected.

The desktop background image on the target is

not visible during a remote control session.

Not selected.
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Installation Default
option. Target Property. Value. Description

The desktop background image on the target is
visible during a remote control session.

Stop screen NoScreenSaver Not select-  Stops the target from sending screen updates when it detects

saver updates ed. that the screen saver is active.

when screen Selected.

saver is active
While the screen saver is active on the target
system, the target stops transmitting screen up-
dates. The controller displays a simulated screen
saver, so that the controller user is aware that a
screen saver is active on the remote display. The
controller user can remove the screen saver by
pressing a key or moving the mouse.

Not selected.
A simulated screen saver is not displayed in the
session window. The target screen is displayed
as normal and the target continues to transmit
screen updates.
Policies options
Table 9. Peer to peer policy descriptions -
Installer screen Default
names. Target property. value. Description
Disable chat DisableChat Not select- Determines whether you can start a chat session with the tar-
ed. get and also chat to the controller user during a peer to peer ses-
sion.
Selected.

If ChatOnly is chosen as the connection type on
the open connection screen, the session is re-
fused. During the session, the chat icon is not

available in the controller window.
Not selected.

A Chat Only session can be started from the open
connection window. During the session, the chat

icon is available in the controller window.
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Installer screen Default

names. Target property. value. Description

Save chat mes- AutoSaveChat Not select- Determines whether the chat messages that are entered during

sagess ed. a chat session are saved.
Selected.

The chat messages are saved in an html file, in the
working directory of the target. The location is de-
fined by the target property WorkingDir. The file
name is prefixed with chat-. For example, on a Win-
dows™ system, a file that is named chat - m.5. ht m

is saved to the following location.

c:\Docunents and Settings\All Users
\ Appl i cati on Dat a\ Bi gFi x\ Renot e Con-

trol
Not selected.
The chat messages are not saved to a file.

Disable file DisableFilePull Not select- Determine whether files can be transferred from the target to the
transfer from ed. controller during the session.

target to con- Selected.

troller
Files can be transferred from the target to the con-

troller.
Not selected.

Files cannot be transferred from the target to the

controller.

Disable file DisableFilePush Not select- Determines whether files can be transferred from the controller
transfer from ed. to the target during the session.
controller to tar- Selected.

get
Files can be transferred from the controller to the

target.
Not selected.

Files cannot be transferred from the controller to

the target.

Disable clip- DisableClipboard Not select- Determines the availability of the clipboard transfer menu. Use
board transfer ed. this menu option to transfer the clipboard content between the

controller and target during a remote control session.

Selected.
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Installer screen

names.

Allow local

recording

tion

Allow session

handover

Target property.

AllowRecording

Allow collabora- AllowCollaboration

AllowHandover

Default

value. Description
The clipboard transfer menu is available during the
session and you can transfer the clipboard content

to and from the target.
Not selected.

The clipboard transfer menu is not available during

the session.

Selected.  Determines whether the controller user can make and save a
local recording of the session in the controlling system. Deter-
mines the availability of the record option on the controller win-
dow. For more information about recording sessions, see the

BigFix® Remote Control Controller User's Guide.
Selected.

The record option is available in the controller win-

dow.
Not selected.

The record option is not available in the controller

window.

Selected. Determines whether more than one controller can join a session.
Determines the availability of the collaboration icon on the con-
troller window. For details of collaboration sessions, see the Big-

Fix® Remote Control Controller User's Guide.
Selected.
The collaboration icon is available in the controller
window.
Not selected.
The collaboration icon is not available in the con-

troller window.

Selected. Determines whether the master controller in a collaboration ses-
sion can hand over control of the session to a new controller.
Determines the availability of the Handover button on the col-
laboration control panel. For more information about collabora-
tion sessions, see the BigFix® Remote Control Controller User's

Guide.

Selected.
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Installer screen

names.

Allow requests  AllowForceDiscon-
to disconnect nect

existing session

Disconnect ForceDisconnect-
grace time Timeout
Audit to Appli-  AuditToSystem

cation Event

Log

Target property.

Default

value.

Description

The handover option is available in the collabora-

tion control window.
Not selected.

The handover option is not available in the collabo-

ration control window.

Not select- Determines whether a controller user is given the option to dis-

ed.

45

Selected.

connect a session with a target so that they can connect to the
target instead. Used with the Managed and CheckUserLogin
properties. For more information about disconnecting sessions,

see the BigFix® Remote Control Controller User's Guide.
Selected.

A Disconnect session option is available in the
message window that is displayed when you at-

tempt to connect to the target.
Not selected.

A Disconnect session option is not available when

you attempt to connect to the target.

The CheckUserLogin property must be set to Yes and Managed

set to No for AllowForceDisconnect to take effect.

Number of seconds in which the current controller user must re-
spond to the prompt to disconnect the current session. If they
do not respond on time, they are automatically disconnected
from the session. The timer takes effect only when AllowForce-
Disconnect and CheckUserLogin are set to Yes. The default val-

ue is 45.

Determines whether the actions that are carried out during re-
mote control sessions are logged to the application event log on

the target. This log can be used for audit purposes.
Selected.

Entries are displayed in the application event log of
the target corresponding to each action carried out

during the session.
Not selected.

No entries are logged to the application event log.
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Security policies

Table 10. Peer to peer policy descriptions - Security policies.

Installer Default
screen names. Target property. Value. Description.
Authenticate by us-  CheckUserLogin Selected. Determines whether a logon window is displayed when the
ing Windows logon controller user clicks a session type button on the Open
Connection window.
Yes
The logon window is displayed and the con-
troller user must log on with a valid Win-
dows™ ID and password. If the credentials
are invalid, the target refuses the session.
No
The user acceptance window does not ap-
pear and the peer to peer session is estab-
lished.
Must be a member  CheckUserGroup See descrip- Default value.
of these Windows tion.

Windows™ systems.
groups
BUI LTI M Adni ni strators

Linux™ systems.

wheel

When Authorized user group has a value set, the user
name that is used for authentication must be a member of
one of the listed groups. Otherwise, the session is refused.
Multiple groups must be separated with a semicolon. For

example, wheel ; trcusers.

Note: By default, on a Windows™ system, only the
administrator user is granted access. On a Linux™
system, by default no users are granted access. To
resolve this issue, complete one of the following
steps.

a. If the users must also be granted admin-
istrator rights, add them as members of
the Administrators group on a Windows™

system or the wheel group on a Linux™

system.




Remote Control Installation Guide | 4 - Install the Remote Control components | 65

Installer

screen names.

Allow privacy

Allow input lock

Target property. Value. Description.

AllowPrivacy

AllowInputLock Selected. This property works with Allow privacy and on its own.

Default

b. If the users must not have administrator
4 rights, complete the following steps.

i. Create a group or use an exist-

ing group. For example, the fol-

lowing command might be run

as root:

groupadd trcusers

ii. Add the users to this group. For
example, the following com-
mand might be run as root to

add bsmith to trcusers.

usernmod -a -G trcusers

<bsmi t h>

Add the group to the list in the

Authorized user group field.

Selected. Determines whether a controller user can lock the local in-
put and display of the target when in a remote control ses-
sion. Determines the visibility of the Enable Privacy option

on the controller window.
Selected.

The Enable Privacy option is available in the
Perform Action in target menu in the con-

troller window.
Not selected.

The Enable Privacy option is not available
in the Perform Action in target menu in the

controller window.

Select Allow input lock to lock the target users mouse

and keyboard during a remote control session.
Selected.

The lock target input menu item is enabled,

in the Perform action in target menu in the

controller window. Select lock target input
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Installer Default
screen names. Target property. Value.
Enable privacy when EnablePrivacy Not select-

session starts ed.
Enable input lock EnablelnputLock Not select-
when session starts ed.

Description.
to lock the target users mouse and keyboard
during a remote control session. The target

screen is still visible to the target user.
Not selected.

The lock target input menu item is not en-
abled in the Perform action in target menu in

the controller window.

/’ Note: If Enable Privacy is selected during a ses-
sion, the remote user input is automatically
locked. It is not possible to enable privacy without

also locking the input.

Determines whether the local input and display are locked
for all sessions. Therefore, the target user cannot interact

with the target screen during a remote control session.
Selected.

The target screen is blanked out by the priva-
cy bitmap when the session starts. The tar-
get user cannot interact with the screen dur-
ing the session. The target desktop is still
visible to the controller user in the controller

window.
Not selected.

The target screen is not blanked out when
the session starts and the target user can in-

teract with the screen.

This property works with Enable privacy. Use Enable input
lock to determine whether the target user can view their
screen or not during a remote control session when priva-

cy mode is enabled.
Selected.

The target screen is visible to the target user
during the session, while in privacy mode but

their mouse and keyboard control is locked.

Not selected.
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Installer Default

screen names. Target property. Value. Description.

The target screen is not visible to the tar-
get user and the privacy bitmap is displayed
on the target during the session. The tar-
get users mouse and keyboard are also dis-

abled.

Note: Enable privacy must be selected to allow

Enable input lock to take effect.

Enable on-screen EnableOSSN Not select-  Determines whether a semi-transparent layer is placed on-

session notification ed. to the target screen. The layer displays text that indicates
that a remote control session is in progress. Can be used
when privacy is a concern so that the user is clearly noti-

fied when somebody remotely views or controls their PC.
Selected.

The semi-transparent layer is displayed
on the target screen. The text indicates
which type of remote control session is in
progress. For exanple : Renote Control -
Active Mbde. The layer does not intercept
keyboard or mouse actions. Therefore, the

user is still able to interact with their screen.
Not selected.

A semi-transparent layer is not displayed on

the target screen.

Note: This policy is only supported on targets

where a Windows™ operating system is installed.

Disable Panic Key DisablePanicKey Not select-  Determines whether the target user can use the Pause

ed. Break key to automatically end the remote control session.
Selected.

The target user cannot use the Pause Break
key to automatically end the remote control

session.

Not selected.
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Installer Default
screen names. Target property. Value. Description.
The target user can use the Pause Break key
to automatically end the remote control ses-
sion.
Inactivity timeout IdleTimeout 360

Number of seconds to wait until the connection ends if
there is no session activity. Set this value to 0 to disable
the timer so that the session does not end automatically.
The minimum timeout value is 60 seconds. For values 1 -

59, the session times out after 60 seconds of inactivity.

/‘ Note: The inactivity timeout value applies to Active
session mode only. The session does not end au-

tomatically when other session modes are used.

The default value is 360.

User acceptance policies

Table 11. Peer to peer policy descriptions - User acceptance policies.

Installer Default

screen names. Target property. Value. Description.

Take over session  ConfirmTakeOver Selected. Determines whether the user acceptance window is dis-

played when a remote control session is requested.

Selected.

The user acceptance window is displayed to
the target user who can accept or refuse the

session.
Not selected.

The user acceptance window is not displayed
and the session is established.

Change session ConfirmModeChange Selected. Determines whether the user acceptance window is dis-
mode

played when the controller user selects a different session

mode from the session mode list on the controller window.
Selected.
The user acceptance window is displayed

each time a session mode change is request-

ed. The target user must accept or refuse the

request.
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Installer Default

screen names. Target property. Value. Description.

Not selected.

The user acceptance window is not displayed
and the session mode is changed automati-

cally.

File transfers ConfirmFileTransfer  Selected. Determines whether the user acceptance window is dis-
played when the controller user transfers files between the

target and the controller.
Selected.

The acceptance window is displayed when
the following options are selected. The target
user must accept or refuse the file transfer.
> The controller user selects pull file
from the file transfer menu on the

controller window.

P 4| Note: After they accept the
request, the target user
must select the filethat is to

be transferred.

> The controller user selects send file
to controller from the Actions menu

in the target window.
Not selected.

The acceptance window is not displayed and
files are transferred automatically from the
target to the controller system when request-

ed.

System informa-  ConfirmSysinfo Selected. Determines whether the user acceptance window is dis-
tion played when the controller user requests to view the target

system information.
Selected.

The user acceptance window is displayed
when the controller user clicks the system in-
formation icon in the controller window. The
target user must accept or refuse the request

to view the target system information.
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Installer Default

screen names. Target property. Value. Description.

Not selected.

The target system information is displayed
automatically when the controller user clicks

the system information icon.

Local recording ConfirmRecording Selected. Determines whether the user acceptance window is dis-
played when the controller user clicks the record icon on

the controller window.
Selected.

A user acceptance window is displayed when
the controller user clicks the record icon on
the controller window. If the target user clicks
Accept, the controller user can select where
to save the recording to. If the target user
clicks Refuse, a refusal message is displayed

to the controller.

Note: After the target user accepts

the request for recording, the accep-
tance window is not displayed again
if the controller user stops and then
restarts local recording in the same
session. Also, the refusal message is
displayed in English and is not trans-

lated.

Not selected.

When the controller user clicks the record

icon on the controller window, the user accep-
tance window is not displayed. The controller
user can then select where to save the record-

ing to.

Collaboration ConfirmCollaboration Selected. Determines whether the user acceptance window is dis-
played when another controller user requests to join a col-

laboration session with a target.
Selected.

The user acceptance window is displayed

when the controller user tries to join the col-
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Installer Default
screen names. Target property. Value.
User acceptance  AcceptanceGrace- 45
grace time Time
Proceed on accep- AcceptanceProceed  Not select-
tance timeout ed.
Do not prompt for  AutoWinLogon Selected.

user acceptance
when user is not

logged on.

Description.
laboration session. The target user must ac-
cept or refuse the request. If the target user
clicks Accept, the additional controller joins
the collaboration session. If they click Refuse,
a message is displayed on the controller and
the additional controller cannot join the col-

laboration session.
Not selected.

The additional controller automatically joins

the collaboration session.

Sets the number of seconds to wait for the target user to
respond before a session starts or times out. Used with
Take over session.
o Acceptable values 0 - 60 - If set to 0 the activity
starts without displaying the message box for

user acceptance on the target.

Note: If Take over session is selected, User accep-
tance grace time must be set to a value >0 to allow

the target user time to respond.

Continue with the session if the user acceptance timeout
lapses. The target user does not click accept or refuse
within the number of seconds defined for Acceptance

grace time.
Selected.
The session starts.
Not selected.
The session does not start.

Determines whether a session can be started when no

users are logged on at the target.
Selected.
Session is started with the target.
Not selected.

Session is not started and the following mes-

sage is displayed. Session rejected because
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Installer Default
screen names. Target property. Value. Description.
there is no user logged to confirmthe
session
Enable Hide win-  HideWindows Not select- _
dows (Deprecated) ed. P 4l Note: The "Allow to show/hide selected windows

during the session" feature has been deprecated

for all versions above Windows 7.

Determines whether the Hide windows check box is dis-
played on the user acceptance window when Confirm in-

coming connections is also selected.
Selected.

The Hide windows check box is displayed on

the user acceptance window.
Not selected.

The Hide windows check box is not displayed

on the user acceptance window.

Session scripts

Table 12. Peer to peer policy descriptions - Session scripts policies.

Installer Default
screen names. Target property. Value. Description.
Run pre-session RunPreScript Not select-  Determines whether a user-defined script must be run be-
script ed. fore the remote control session starts. It is run just after the

session is authorized but before the controller user has ac-
cess to the target. The outcome of running the script and
the continuation of the session is determined by the value

set for Proceed on pre/post-script failure.
Selected.

When a remote control session is requested,
the defined script is run before the controller

user has access to the target.
Not selected.
No script is run before the session.

For details of setting up pre-session scripts and post ses-
sion scripts, see the Session policies chapter in the BigFix®

Remote Control Administrator's Guide.
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Installer Default

screen names. Target property. Value. Description.

Run post-session RunPostScript Not select-  Determines whether a user-defined script is run after the re-

script ed. mote control session finishes.
Selected.

When a remote control session ends, the

user-defined script is run.
Not selected.
No script is run after the session.

For details of setting up pre and post session scripts, see
the Session policies chapter in the BigFix® Remote Control

Administrator's Guide.

Proceed with ses- ProceedOnScript- Not select-  Continue with the session if the pre-script or post script ex-

sion when script Fail ed. ecution fails. A positive value or 0 is considered a success-

fails ful run of the pre-script or post session script. A negative
value, a script not found error, or a script that does not fin-

ish within 3 minutes is considered a failure.
Selected.

If the pre-script or post script run fails, the

session continues.
Not selected.

If the pre-script or post script run fails, the

session does not continue ends immediately.

For the definition and more information about the properties, see Properties that can be set in

the target configuration (on page 169).

Session policies options

Table 13. Session policies options.

Installation
option. Target Property. Default Value.
Active AllowActive Selected.
Guidance AllowGuidance Selected.
Monitor AllowMonitor Selected.
Enable high quality colors EnableTrueColor Not selected.
Lock color quality LockColorDepth Not selected.




Remote Control Installation Guide | 4 - Install the Remote Control components | 74

Installation
option. Target Property. Default Value.
Remove desktop background RemoveBackground Not selected.
Stop screen saver updates when  NoScreenSaver Not selected.
screen saver is active
Policies options
Table 14. Policy descriptions -
Installer screen
names. Target property. Default value.
Disable chat DisableChat Not selected.
Save chat messagess AutoSaveChat Not selected.
Disable file transfer from target to DisableFilePull Not selected.

controller

target

Disable clipboard transfer
Allow local recording
Allow collaboration

Allow session handover

Disable file transfer from controller to

Allow requests to disconnect existing

DisableFilePush

DisableClipboard
AllowRecording
AllowCollaboration
AllowHandover

AllowForceDisconnect

Not selected.

Not selected.

Selected.

Selected.

Selected.

Not selected.

session
Disconnect grace time ForceDisconnectTimeout 45
Audit to Application Event Log AuditToSystem Selected.
Security policies
Table 15. Security policies.
Installer screen names. Target property. Default Value.
Authenticate by using Windows logon CheckUserLogin Selected.

Allow privacy

Allow input lock

Enable privacy when session starts

Enable input lock when session starts

Must be a member of these Windows groups CheckUserGroup

AllowPrivacy
AllowInputLock
EnablePrivacy

EnablelnputLock

See description.
Selected.
Selected.

Not selected.

Not selected.
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Installer screen names. Target property. Default Value.
Enable on-screen session notification EnableOSSN Not selected.
Disable Panic Key DisablePanicKey Not selected.
Inactivity timeout IdleTimeout 360

User acceptance policies

Table 16. User acceptance policies.

Installer screen names. Target property. Default Value.
Take over session ConfirmTakeOver Selected.
Change session mode ConfirmModeChange Selected.
File transfers ConfirmFileTransfer Selected.
System information ConfirmSyslInfo Selected.
Local recording ConfirmRecording Selected.
Collaboration ConfirmCollaboration Selected.
User acceptance grace time AcceptanceGraceTime 45
Proceed on acceptance timeout AcceptanceProceed Not selected.
Do not prompt for user acceptance when AutoWinLogon Selected.
user is not logged on.
Enable Hide windows HideWindows Not selected.

Session scripts

Table 17. Session scripts policies.

Installer screen names. Target property. Default Value.
Run pre-session script RunPreScript Not selected.
Run post-session script RunPostScript Not selected.
Proceed with session when script fails ProceedOnScriptFail Not selected.

Additional Features

Select Install device driver for Virtual Smart Card Reader to install the virtual smart card reader
driver. For more information about the smart card reader driver, see Install a driver to support

smart card authentication in the target (on page 104).

12. Click Install to begin the installation.

13. When the installation is complete, click Finish.
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Installing the Linux™ target

You can install the target component on a Linux™ computer by using the RPM file that is provided in the Remote

Control installation files.

Note: The broker component installation package depends on the 32-bit version of the following libraries:
glibc libgcc, libblkid, and libstdc++.

Usethetrc-target-10. x. x. i 386. r pmfile to install the target component in Linux™, where 10.x.x is the version
that you want to install. For more information about how to obtain the Linux™ component installation files, see Obtain

the installation files (on page 29). Choose the appropriate method for obtaining the file.
Install a default target RPM file and then configure the target after the installation.

To install the RPM file, run the following command and use the file specific to the version that you want to install. For

example, rpm -ivh trc-target-10.x.x.i386.rpm

When the target is installed, configure the target properties by editing the /etc/trc_target. properties file. For more
information about target properties and their definitions, see Properties that can be set in the target configuration (on

page 169).

Install the BigFix® Remote Control Target for macOS

You can install the BigFix® Remote Control Target for macOS in numerous ways. Use thet rc_t ar get . pkg file
to install the application in attended or unattended mode. You can also install the target by using a Fixlet® in the
BigFix® console.

For information about how to obtain the BigFix® Remote Control Target for macOS component installation files, see
Install the BigFix® Remote Control components (on page 29). Choose the appropriate method for obtaining the
file.

Installing the BigFix® Remote Control Target for macOS from the BigFix® console

You can use a Fixlet® in the BigFix® console to install the BigFix® Remote Control Target for macOS component. The
deployment Fixlet® is available in the Remote Control site in the Systems Lifecycle domain.

Note: Selecting the managed mode option prompts for a server URL and a secure registration token.

To install the BigFix® Remote Control Target for macOS target component, complete the following steps.

1. Within the Systems Lifecycle domain, expand Remote Control configuration > Remote Control.

2. Expand the Deployment node.

3. Select macOS.

4. Select Deploy BigFix® Remote Control Target for macOS.

5. In the Task pane, review the description and follow the instructions in the Actions box to start the task.
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6. In the Take Action pane on the Target tab, select the relevant option for determining the computers on which
to deploy the BigFix® Remote Control Target for macOS component.

7. Click OK.
The summary screen shows the progress of the task and the status is set to Complete when it is finished.

Installing the BigFix® Remote Control Target for macOS by using the .pkg file

You canusethetrc_target. pkg file to install the BigFix® Remote Control Target for macOS.

You can obtain the pkg file from Passport Advantage or from the Remote Control server Ul. For more information,
see Obtain the installation files (on page 29). Two installation methods can be used when you have the pkg file:
attended and unattended.

You can also apply custom configuration settings when you install the target. The configuration values are set in the
trc_target. cfg file. Create the file and add your custom values. Copy the file to the computers on which you want
to install the BigFix® Remote Control Target for macOS. Copy thetrc_t ar get . cf g file to the same directory as the
trc_target. pkg file.

Your configuration settings are installed together with the target. The target configuration is installed to / Li brary/

Pref erences/ com bi gfi x. renot econtrol .target. plist.

To configure the target to support broker sessions, you must configure the BrokerList property and provide
trusted certificates. Place a br oker . cer t s file, that contains the trusted certificates in the same directory as the
trc_target. pkg file. The package installs the br oker . cert s file to

/ Li brary/ Application Support/com bi gfix.renptecontrol.target/Trust Store.

For more information about the target properties that can be set in the . cf g file, see Properties that can be set in the
target configuration (on page 769).

If you do not apply any custom configuration, the target uses built in configuration settings when it installs.

Choose an installation method for installing the BigFix® Remote Control Target for macOS.

Attended Mode:

1. Double-click the trc_target. pkgfile.

2. Click Continue.

3. Click Install to install to the startup disk. If your system has multiple disks, you can select the disk on which to
install the target. Click Change Install Location to select an installation disk.

4. If you are a user with admin authority, type in your password when prompted. Otherwise, type a valid admin ID
and password. Click Install Software.

5. When the installation completes, click Close.

Unattended mode:
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1. Open a Terminal window and type the following command.
sudo installer -pkg "/[path]/trc_target.pkg" -target /

Where [path] is the path to the . pkg file.

After you install the .pkg file, open the Renpt e Cont rol Tar get . app to start the target.

Run a target custom installation

Run an Remote Control target custom installation to install the target software by using parameters. You can run the

installation in multiple ways.
Unattended and silent
No interaction is required by the user and no Ul dialogs or progress bars are displayed to the user.
Unattended
No interaction is required by the user and an installation progress bar is displayed to the user.
Attended
The full installation Ul is displayed and requires user interaction.

You can customize installation settings and also assign the target to a specific group during the installation.
Running a target custom installation on a Windows® system

To install the target software on a Windows® operating system, usethetrc_t arget _set up. exe file.

For more information about obtaining this file, see Obtain the installation files (on page 29).

To install the target, complete the following steps:

. Create a folder in your root drive called TRC.
.Copytrc_target_setup. exetoTRC.

. Open a command prompt window and go to TRC.
. Type D Rto verify that the exe file is in this folder.

a A w N =2

To install the target, type the following command in one line.

trc_target _setup.exe /s /v"/gn [ | NSTALLPARANETERI] [ | NSTALLPARANETER?] . . . [ | NSTALLPARAVETERX] "

Use the following installation parameters customize your installation.

Note: Ensure that the correct values are assigned to the parameters as no validation of the values is

carried out.

/s

Denotes a silent installation.
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/vll

The string that is attached to /v contains the parameters for nsi exec. exe, which is a piece of
software that runs the installation.

/qn

Run a silent and unattended installation with no progress window and no Ul.

You can also replace /gn with the following parameters.
/qb
For an unattended installation with a basic Ul and a small progress bar.
/qr
For an unattended installation with a reduced Ul progress bar in a large window.
/qf
For an attended installation with full Ul.
TRC_SERVER_HOSTNAME
The host name or IP address of the server. This property is required. Default value is <blank>.
For example, TRC_SERVER_HOSTNAME=t r c. nyser ver . com
TRC_SERVER_CONTEXT
This parameter value must match the last part of the path in the server URL. Default value is trc.
For example, TRC_SERVER CONTEXT=tr c.
TRC_SERVER_PORT
If the server runs on a non-standard port, specify the port number. Default value is 80.
For example, TRC_SERVER_PORT=8080.
TRC_SERVER_PROTOCOL

Choose between plain HTTP and secure HTTPS protocols. Valid values are http and https.
Default value is http.

For example, TRC_SERVER PROTOCOL=ht t p.

TRC_PROXY_HOSTNAME
Host name or IP address for the proxy server, if you are using one. Default value is <blank>.
For example, TRC_PROXY_HOSTNAME=pr oxy. conmpany. com

TRC_PROXY_PORT

Port number for the proxy server. Default value is <blank>.

For example, TRC_PROXY_PORT=8080.
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TRC_PROXY_USER_ID

The user ID, if the proxy requires authentication. Default value is <blank>. The
user ID and password are automatically encrypted when the target starts, unless
DISABLEAUTOMATICPASSPHRASEENCRYPTION is set to Yes. For more information about

automatic passphrase encryption, see the BigFix® Remote Control Administrator's Guide.
For example, TRC_PROXY_USER | D=pr oxyuser .
TRC_PROXY_PASSWORD

The password, if the proxy requires authentication. Default value is <blank>. The
user ID and password are automatically encrypted when the target starts, unless
DISABLEAUTOMATICPASSPHRASEENCRYPTION is set to Yes. For more information about

automatic passphrase encryption, see the BigFix® Remote Control Administrator's Guide.
TRC_PROXY_PASSWORD=v264xnpt .
TRC_PROXY_AUTH_B64

The user ID and password, format user: passwor d, encoded in base64. Overrides the user ID and
password properties. If you do not want the password to be easily visible, use this parameter.
Base64 is not encryption. Default value is <blank>.

For example, TRC_PROXY_AUTH_B64=cHlveH 1c2VynYyNj R4bXBO

The user ID and password are automatically encrypted when the target starts, unless
DISABLEAUTOMATICPASSPHRASEENCRYPTION is set to Yes. For more information about

automatic passphrase encryption, see the BigFix® Remote Control Administrator's Guide.

TRC_TARGET_PORT

To run the target on a non-standard port, specify the port number to use. Default value is 888.

For example, TRC_TARGET_PORT=888.
TRC_SERVER_HEARTBEAT_RETRY

The amount of time, in minutes, that the target waits before it resends a heartbeat to the server,
when the server is not responding. Default value is 10.

For example, TRC_SERVER HEARTBEAT_RETRY=1.
TRC_ACCESSIBILITY

Enables the accessible Ul. Default value is No. Available on Windows® operating system.

GROUP_LABEL

The name of the group that the target is to be assigned to. To enable this feature, edit the

trc. properti es file and set allow.target.group.override = true. For more information about
editing the properties files, see the BigFix® Remote Control Administrator's Guide. Default value
is DefaultTargetGroup.
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Note:

a. The GROUP_LABEL parameter is discarded if the target is already registered in
the Remote Control server.
b. The target group that is specified must already be defined on the server.

For example, GROUP_LABEL=NewTar get G oup.
INSTALLDIR

Use this parameter to specify the directory for installing the target software to.

For example, | NSTALLDI R= c:\trc\target.
ALLOWP2P

Use this parameter to enable peer to peer connections regardless of the server status. Default

value is No.
ALLOWP2PFAILOVER

Use this parameter to enable failover to peer-to-peer mode when the server is down or
unreachable. Default value is No.

AUDITTOSYSTEM

Use this parameter to log peer to peer session events in the targets application event log for
auditing purposes. Default value is No.

AUTOSAVECHAT

Use this parameter to save the contents of the chat window to a file on the target. Default value
is No.

AUTOWINLOGON

Determines whether a session can be started when no users are logged on at the target. Default

value is Yes.
CHECKUSERGROUP

The controller user must be a member of the listed groups. Default value is BUI LTI N
\ Adnmi ni st rat or s on Windows® systems and wheel on Linux® systems.

CHECKUSERLOGIN

Determines whether the login window is displayed when the controller user selects a session
type in the Open Connection window. Default value is Yes.

CONFIRMFILETRANSFER

Determines whether the user acceptance window is displayed before the controller user transfer

files from the target to the controller in a peer to peer session. Default value is Yes.

CONFIRMMODECHANGE
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Determines whether the user acceptance window is displayed when the controller user selects a

different session mode during the remote control session. Default value is Yes.
CONFIRMSYSINFO

Determines whether the user acceptance window is displayed when the controller user requests
to view the target system information. Default value is Yes.

CONFIRMTAKEOVER

Determines whether the user acceptance window is displayed when a peer to peer session is
requested. Default value is Yes.

DISABLEAUTOMATICPASSPHRASEENCRYPTION

Determines whether the proxy authentication user ID and password are automatically encrypted
when the target starts. Default value is No. For more information about automatic passphrase

encryption, see the BigFix® Remote Control Administrator's Guide.
DISABLECHAT

Determines whether you can start a chat session with the target and also chat to the controller
user during a peer to peer session. Default value is No.

DISABLECLIPBOARD

Determines the availability of the clipboard transfer menu during a peer to peer session. Default
value is No.

DISABLEFILEPULL

Determines whether you can transfer files from the target to the controller during a peer to peer

session.
DISABLEFILEPUSH

Determines whether you can transfer files from the controller to the target during a peer to peer

session. Default value is No.
FIPSCOMPLIANCE

Enable the use of a FIPS certified cryptographic provider for all cryptographic functions. Default

value is No.
SP800131ACOMPLIANCE

Enable the use of NIST SP800-131A compliant algorithms and key strengths for all
cryptographic functions. Default value is No.

HTTPSSTRICTVALIDATION

Determines whether the target uses the system truststore to verify HTTPS connections to the

server. Default value is No.

LOGLEVEL
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Set the logging level. The logging level determines the types of entries and how much
information is added to the target log file. Possible values 0, 1, 2, or 4. However, use
LOGLEVEL=4 only by request from IBM software support. Default value is 2.

For example, LOGLEVEL=2.

LOGROTATION

Controls the period after which an older log file is overwritten. Set to Daily, Weekly, or Monthly.
Default value is Weekly.

For example, LOGROTATI ON=Mont hl y.
You can also disable log rotation by using the value Disabled.

LOGROLLOVER

Controls the period after which a new log file is started. Therefore, this period must be shorter
than the LOGROTATION period, not all combinations are valid. LOGROLLOVER cannot be
disabled. Set to Daily or Hourly. Default value is Daily.

For example, LOGROLLOVER=Dai | y.

VSsC

Use the parameter to install the device driver for the virtual smart card reader. Add VSC=1 to the

parameter list to install the driver.

Note: The appearance of VSC in the parameter list determines whether the driver is
installed, not the value of the parameter. If VSC= n is in the parameter list, the driver is
installed. If VSC is not in the parameter list, the driver is not installed. VSC can have any
value. However, VSC=1 is the suggested value.

For more information about installing the device driver for the virtual smart card reader during
a silent installation, see Installing the virtual smart card reader driver by running a silent
installation (on page 105).

REGISTRATIONTOKEN

Use this parameter to provide the registration token to the target. The token is used to
authenticate the target to the server when it first contacts the server. The value of the property
is set to the registration token. For more information about installing the target with a secure
registration token by running a silent installation, see Running a target silent installation with a

secure registration token (on page 107).

Note: To reconfigure the parameters on an existing target installation, use the parameter, REINSTALL=ALL.
However, the parameter is ignored if it is used when you upgrade the target.
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For example, on the command line you can type the following command:

trc_target_setup.exe /s /v"/qn REINSTALL=ALL'

To modify the target configuration and apply an upgrade, complete the following steps.

1. Perform a silent installation with the new version of target software. Do not use any parameters. If you
do use parameters, the target is upgraded but the parameters are ignored and are not updated.

2. Perform a silent re installation with REI NSTALL=ALL and any new parameters.

You can also specify the parameters that you want to override.

For example, to change the target port to 2222, type the following command.

trc_target_setup.exe /s /v"/qn TRC_TARGET_PORT=2222 REINSTALL=ALL"

Note: To view Help options during the installation, type the following command on the command line.

trc_target_setup.exe -help

Install the controller

The Remote Control controller can be installed locally on your system, to be used for connecting to a target directly if

peer to peer mode is enabled.

Remote Control provides two ways to install the controller component. If you have access to the BigFix® console, use
the deployment Fixlet® to deploy the controller. For more information, see the BigFix® Remote Control Console User's

Guide. Alternatively use the Remote Control controller installation files.

Installing the controller on a Windows™ system
Thetrc_control | er _setup. exe file is required to install the controller component on a Windows™ system.

For more information about how to obtain the component installation files for a Windows™ system, see Install the

Remote Control components (on page 29). Choose the appropriate method for obtaining the file.

1. Runthetrc_control |l er_setup. exe file.

2. On the file download window, select Run or Save
Run

Select Run to start the installation wizard.
a. Click Next at welcome screen.
b. Accept the license agreement, click Next.
c. Accept or change the location for the installation files, click Next.
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d. Click Install.
e. Click Finish.

Note: If the controller software is already installed on the system, modify, repair, or
remove options are available.

Save

Select Save to save thetrc_control | er _set up. exe file to a selected location. Run the file
to install the controller.

The controller is installed to the default location \ Program Fi | es\ Bi gFi x\ Renot e Control\ Controller or

the location that is selected during the installation.

Installing the Linux™ controller

Usethetrc-controller-10.x.x.noarch.rpmandtrc-controller-jre-10.x. x.i 386. rpmfiles to
install the controller component in Linux™. Where 70.x.x is relevant to the version that you want to install. For more
information about how to obtain the Linux™ component installation files, see Install the Remote Control components
(on page 29). Choose the appropriate method for obtaining the file.

You can install the controller in two modes in Linux™, a FIPS-compliant controller or a standard controller.

Type the relevant command for installing the controller. Where 70.x.x is relevant to the version that you want to

install. .

« For the standard controller type

#rpm -ivh ~/BigFix/Tivoli_Remote_Control/RCTarget/trc-controller-10.x.x.noarch.rpm

« For a FIPS-compliant controller, install the standard controller and the FIPS-compliant JRE by running both
commands.

#rpm -ivh ~/BigFix/Tivoli_Remote_Control/RCTarget/trc-controller-10.x.x.noarch.rpm
#rpm -ivh ~/BigFix/Tivoli_Remote_Control/RCTarget/trc-controller-jre-10.x.x.i386.rpm

Note: Standard controller installations work with the t r c- cont rol | er - 10. x. x. noar ch. r pmfile, with
an alternative JRE installed on the system. If the controller is to be FIPS-compliant, thet rc- control | er -

jre-10.x. x. i 386. r pmfile must also be installed. Thetrc-control | er-jre-10. x. x. i 386. r pmfile

can also be installed even if the controller is not going to be run in FIPS mode.

You can start the controller from your applications list when it is installed.
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Install the BigFix® Remote Control Controller for macOS

The BigFix® Remote Control Controller for macOS can be installed in multiple ways. You can use the
trc_control |l er. pkg file to install the application. You can also install the controller by using a Fixlet® in the
BigFix® console.

For information about how to obtain the BigFix® Remote Control Controller for macOS component installation files
see, Obtain the installation files (on page 29). Choose the appropriate method for obtaining the file.

Installing the BigFix® Remote Control Controller for macOS from the BigFix®
console

You can use a Fixlet® in the BigFix® console to install the BigFix® Remote Control Controller for macOS component.
The deployment Fixlet® is available in the Remote Control site in the Systems Lifecycle domain.

. Within the Systems Lifecycle domain, expand Remote Control configuration > Remote Control.

. Expand the Deployment node.

. Select macOS.

. Select Deploy BigFix® Remote Control Controller for macOS.

. In the Task pane, review the description and follow the instructions in the Actions box to start the task.

o oA WN =

. In the Take Action pane on the Target tab, select the relevant option for determining which computers to
deploy the BigFix® Remote Control Controller for macOS component on.
7. Click OK.

The summary screen shows the progress of the task and the status is set to Complete when it is finished.

Installing the BigFix® Remote Control Controller for macOS

You canusethetrc_control |l er. pkg file to install the BigFix® Remote Control Controller for macOS.

You can obtain the pkg file from Passport Advantage or from the Remote Control server Ul. For more information, see

Obtain the installation files (on page 29). To install the controller, complete the following steps.

1. Double-clickthetrc_control | er. pkg file.

2. Click Continue.

3. Click Install to install to the startup disk. If your system has multiple disks, you can select which disk to install
the controller on. Click Change Install Location to select an installation disk.

4. If you are a user with admin authority, type in your password when prompted. Otherwise, type a valid admin ID
and password. Click Install Software.

5. When the installation completes, click Close.

After you install the .pkg file, open the Renpt e Control Control | er. app to start the target.
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Installing the controller in other supported operating systems

If you are using a supported operating system other than Windows™ operating system, Linux™, AIX®, or Solaris
(SPARC), extract the controller files by using the additional setup utility. Then, copy the required files to the system
that you are running the controller on. You must run the additional setup utility on a Windows™, Linux™, AIX®, or
Solaris(SPARC) system. For more information about obtaining the additional setup utility files, see Install the Remote
Control components (on page 29).

Note: Ensure that you install a supported version of Java™ to run the controller on the other supported

operating system. See Controller requirements (on page 22).

To install the controller, complete the following steps:

1. After you extract the installation files, go to the RCCont r ol | er directory.
2. Copy thefiletrc_consol e. zi p to the system that you are running the controller on.
3. Extract the files fromthe t rc¢_consol e. zi p file.

4. Type the following command to run the controller

java -jar TRCConsole.jar

Installing a preconfigured controller component

You can apply custom configuration settings when you install the controller component.

Preconfiguring the controller is useful for unattended installations. You can set your configuration file values in the
configuration file and copy the file to the computers that you want to install the controller on. Your configuration
settings are installed together with the controller. The configuration values are setinthetrc_control | er. cf g file.
You can create the file and add your custom values or you can edit a default configuration file. If you do not apply any
preconfiguration, the default configuration file is installed when you install the controller component.

The property values inthetrc_control | er. cf g are global and are the same for all users who run the controller.
However, a user can create a local configuration. The values in the users' local configuration are used when they
run the controller and override the global values. To enforce the global property value, you can set a property to
mandatory so that a user cannot edit the property in the Configuration Window in the controller Ul. The mandatory

global property overrides the local property.

To set a mandatory property, complete the following steps:

1. Openthetrc_controller.cfgfile.
2. Copy the property name and add .mandatory = true to the end.

For example, to make the Enable Address History property mandatory so that it cannot be edited in the
Configuration Window.
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enable.address.history=false
enable.address.history.mandatory=true

3. Save the file.

After you savethetrc_control | er. cf g file, install the controller.

Preconfigure the controller for a Windows™ operating system installation

1. Copythetrc_control | er.cf g file to the same directory as the
trc_controll er_setup.exeortrc_controller.nsi file.

2. Run the controller installation file.

The controller is installed with your configured settings.

Note: Preconfiguring the controller is not supported for installation on a Linux™ operating system. If

necessary, you can modify and rebuild the controller . r pmfile from the source . r pmfile.

Use the content of the default configuration file to create your custom configuration file and set your own values.

fips.compliance=false
sp800131a.compliance=false
enable.address.history=true
enable.user.history=false
enable.domain.history=true
history.max.items=20

tool01.ToolName = Control Panel
t00l01.ToolCommand = [SystemFolder]\\control.exe
tool01.ToolParameters =

tool01.ToolUser =

tool02.ToolIName = Command Prompt
tool02.ToolCommand = [SystemFolder]\\cmd.exe

tool02.ToolParameters =
tool02.ToolUser =
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t00l03.ToolName = Administrator Command Prompt
t00l03.ToolCommand = [SystemFolder]\\cmd.exe
tool03.ToolParameters =

tool03.ToolUser = admin

tool04.ToolName = Task Manager
tool04.ToolCommand = [SystemFolder]\\taskmgr.exe
tool04.ToolParameters =

tool04.ToolUser =

tool05.ToolIName = Windows™ Explorer
tool05.ToolCommand = [WindowsFolder]\\explorer.exe
tool05.ToolParameters =

tool05.ToolUser =

tool06.ToolName=Terminal
tool06.ToolCommand=/usr/bin/gnome-terminal
tool06.ToolParameters =

tool06.ToolUser =

tool07.ToolName=Control Panel
tool07.ToolCommand=/usr/bin/gnome-control-center
tool07.ToolParameters =

tool07.ToolUser =

tool08.ToolName=
t00l08.ToolCommand=
tool08.ToolParameters =

tool08.ToolUser =

tool09.ToolName=
tool09.ToolCommand=
tool09.ToolParameters =
tool09.ToolUser =

tool10.ToolName=
tool10.ToolCommand=
tool10.ToolParameters =
tool10.ToolUser =

# Custom keys
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# example.KeySequenceName = Inject F1
# example.KeySequenceValue = [F1]
#

# For a list of supported key codes, please refer to the User's Guide

key01.KeySequenceName =
key01.KeySequenceValue =

key02.KeySequenceName =
key02.KeySequenceValue =

key03.KeySequenceName =
key03.KeySequenceValue =

Install the command-line tools

You can use the command-line tools to start a remote control session from the command-line, or run commands on a
target system without target user interaction. The commands can be useful if you want to connect to a target without
using the BigFix® Remote Control Server interface or for using as part of a script to run multiple commands in an
automated fashion. The command-line tools are only available to run on Windows™ operating systems and Linux™

operating systems.

Remote Control provides two ways to install the command-line tools. If you have access to the BigFix® console, use
the deployment fixlets to deploy the tools. For more information about deploying the components, see the BigFix®
Remote Control Controller User's Guide. Alternatively use the Remote Control controller installation files.

Installing the cli tools on a Windows™ system
Thetrc_cli_setup. exe fileis required to install the controller component on a Windows™ system.

For more information about how to obtain the Windows™ component installation files, see Install the Remote Control
components (on page 29). Choose the appropriate method for obtaining the file.

1. Runthetrc_cli _setup. exe file.

2. On the file download window, select Run or Save
Run

Select Run to start the installation.
a. Click Next at the welcome screen.
b. Accept the license agreement, click Next.
c. Accept or change the location for the installation files, click Next.

d. On the server address screen type in the information and click Next:

Server host name
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Enter the IP address or server name of the Remote Control server.
Use secure connections (https)
Select https to use secure connections to contact the server.
Advanced settings
Click Advanced settings for more configuration settings.
Server port
Enter the port number that the server is listening on.
Server context
Enter a value for the server context. For example, trc.
Use a FIPS certified cryptographic provider

Select Use a FIPS certified cryptographic provider for
installing FIPS-compliant tools.

Enable NIST SP800-131A compliance (Enables FIPS)

Select Enable NIST SP800-131A compliance (Enables FIPS)
for installing NIST SP800-131A compliant tools.

e. On the Proxy settings panel, if you are not using a proxy server click Next.
= If you are using a Proxy, select Use a proxy server or a Remote Control Gateway.
Type in the relevant information
i. Type in the IP address or host name for the proxy server.

ii. Type in the port that proxy server is listening on.

iii. Select Use an HTTP proxy or Use a Remote Control Gateway.

iv. Select Proxy requires authentication and enter the user ID and password
for authenticating to the proxy server.The user ID and password are
automatically encrypted when the target starts. For more information
about the automatic passphrase encryption, see the BigFix® Remote
Control Administrator's Guide.

Note: The CLI is unable to automatically encrypt the proxy
credentials when the CLI is installed stand-alone, without the
target and when the CLI is run by a standard user. If you use the
CLl that is included in the target package, the proxy credentials
are automatically encrypted by the target. You must restart the
target after you edit the settings in the registry or configuration
file. When you use the stand-alone CLI tools, you must run the
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P CLI once from an Administrator Command Prompt in a Windows

operating system or when logged in as root in Linux.

v. Click Next.
f. Accept the default port or type in a value, click Next
g. Click Install.
h. Click Finish.

Save

Select Save to save thetrc_cl i _set up. exe file to a specific location.

Note: Run this executable file to install the command-line software.

The following executable files are in the selected directory.
W C. exe
Use this tool to start a remote control session with a target.
wr crrdpcr . exe

Use this tool to run a command on a target and see the output from the command on the computer that

you issue the command from.

For more information about using the command line tools, see theBigFix® Remote Control Controller User's Guide

Installing the CLI tools in Linux™

You can install the CLI tools on a Linux™ computer by using the RPM file that is provided in the Remote Control

installation files.

Note: The broker component installation package depends on the 32-bit version of the following libraries:
glibc libgcc, libblkid, and libstdc++.

Usethetrc-cli-10.x. x. i 386. r pmfile to install the CLI tools in Linux™. Where 70.x.x is relevant to the version
that you want to install. For more information about obtaining the Linux™ component installation files, see Install the

Remote Control components (on page 29). Choose the appropriate method for obtaining the file.

Note: If thet r c- t ar get RPM file is installed, you do not need to install the t r c- cl i RPM file because the
CLI commands are already included in the target. For more information about using the commands, see the

BigFix® Remote Control Controller User's Guide.

1. Type, the following command to install the command line software.

Where 70.x.x is relevant to the version that you want to install.
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$ rpm -ivh ~/BigFix/Tivoli_Remote_Control/RCTarget/trc-cli-10.x.x.i386.rpm

2. When the installation is complete, editthe / et c/ t rc_t ar get . properti es file and set your configuration.
o Set the value of ServerURL to the host name or IP address of your BigFix® Remote Control Server.
> For FIPS-compliance set the value of FIPSCompliance to Yes.
> For NIST SP800-131a compliance, set the value of SP800731ACompliance to yes.

3. Save thefile.

For more information about using these commands, see the BigFix® Remote Control Controller User's Guide.

Install gateway support in Remote Control

For targets, controllers, and server on different networks that cannot directly contact each other you can install and

configure gateway support.

Remote Control provides two ways to install the gateway support. If you have access to the BigFix® console, use the
deployment fixlets to deploy gateway support. For more information, see the BigFix® Remote Control Console User's

Guide. Alternatively you can use the Remote Control gateway support installation files.

Installing Windows gateway support

Thetrc_gat eway_set up. exe file is required to install gateway support in a Windows operating system. For more
information about how to obtain the Windows gateway support files, see Install the Remote Control components (on

page 29). Choose the appropriate method for obtaining the file.

Note: You can also install gateway support with no user interaction by running a silent installation. For more
information about a silent installation, see Installing the gateway support by running a silent installation (on

page 93).

To install gateway support, complete the following steps:

1. Runthetrc_gat eway_ set up. exe file.

2. Click Next at the Welcome screen.

3. Accept or change the installation location and click Next.
4. Click Install.

5. Click Finish when the installation is complete.

When the gateway support is installed, you must configure it for your environment. For more information about

configuring gateway support, see the BigFix® Remote Control Administrator's Guide.

Installing the gateway support by running a silent installation

To install the gateway support on a Windows® system by running a silent installation, complete the following steps:
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1. Create a folder in your root drive called TRC.

2. Copytrc_gateway_setup. exe fileto TRC.

3. Open a command prompt window and go to TRC.
4. Type in the following command all in one line:

trc_gateway_setup.exe /s /v"/qgn"

/s
Denotes a silent installation.

N
The string that is attached to /v contains the parameters for nsi exec. exe, which is a piece of
software that runs the actual installation.

/qn

Perform a silent installation with no progress window.

For more information about configuring gateway support, see the BigFix® Remote Control Administrator's Guide.

Installing Linux™ gateway support

You can install gateway support on a Linux™ computer by using the RPM file that is provided in the Remote Control

installation files.

Note: The broker component installation package depends on the 32-bit version of the following libraries:
glibc libgcc, libblkid, and libstdc++.

Usethetrc-gat eway- 10. x. x. i 386. r pmfile to install gateway support in Linux™. Where 70.x.x is the version that
you want to install. For more information about obtaining the Linux™ gateway support files, see Install the Remote

Control components (on page 29). Choose the appropriate method for obtaining the file.

Type the following command at a command prompt to install the gateway support. Where 70.x.x is the version that

you want to install.
$ rpm-ivh trc-gateway-10. x. x. i 386. rpm

When the gateway support installed, configure it for your environment. For more information about configuring

gateway support, see the BigFix® Remote Control Administrator's Guide.

Install broker support

Broker support must be installed on the computers that connect the controller to the target computer when the target

computer is not directly accessible by the controller and the connection is made across the internet.
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Remote Control provides two ways to install the broker support. If you have access to the BigFix® console, use the
deployment fixlets to deploy the broker support. For more information, see the BigFix® Remote Control Console User's
Guide. Alternatively use the Remote Control broker installation files.

Installing Windows™ broker support
The Remote Control broker installation files are executable files that can be used to install broker support on a

Windows™ computer.

Thetrc_broker_set up. exe file is required to install broker support on a Windows™ system. For more information
about how to obtain the Windows™ broker support files, see Install the Remote Control components (on page 29).
Choose the appropriate method for obtaining the file.

To install broker support on a Windows™ computer, complete the following steps.

1. Runthetrc_broker_setup. exe file.

2. Click Next at the welcome screen.

3. Accept license terms and click Next.

4. Accept the default location or change the installation destination folder. Click Next.

Default location is \ Pr ogr am Fi | es\ Bi gFi x\ Renot e Cont r ol \ Br oker

5. Click Install.
6. Click Finish.

The following files are installed in the [working dir]\ Br oker directory, where [working dir] is determined by the version
of Windows™ operating system that you are installing the broker support on.

For example,\ Docunents and Settings\Al |l Users\Application Data\BigFi x\ Renote Control.

etrc_broker.properties
« TRCI CB- conput er nane- day. | og where computername is the computer name of the system that the

broker is installed on and day is the day of the week that the broker is installed on.

You must check that the Remote Control- Internet Connection Broker service is registered and is started.

Installing Linux™ broker support

You can install broker support on a Linux™ computer by using the RPM file that is provided in the Remote Control
installation files.

Note: The broker component installation package depends on the 32-bit version of the following libraries:
glibe libgcc, libblkid, and libstdc++.
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Usethetrc-broker-10. x. x. i 386. r pmfile to install the broker support in Linux™. Where 70.x.x is the version
that you want to install. For more information about obtaining the Linux™ component installation files, see Install the
Remote Control components (on page 29). Choose the appropriate method for obtaining the file.

At a command prompt type, the following command to install the broker software. Where 70.x.x is the version that

you want to install.
rpm-ivh trc-broker-10.x.x.i386.rpm

The following files are installed in the / opt / bi gf i x/ trc/ broker directory.

« libcrypto.s0.1.0.0
« libssl.s0.1.0.0
« trc_icb

* Alicense directory.

Thetrc_broker. properties fileisinstalled inthe/ et c directory.

When the broker support is installed, configure the broker properties by editing the t r c_br oker . properti es file.



Chapter 5. Utility for extracting the component installation
files

Remote Control provides a utility that you can use to extract the installation files that are required for each

component.

Extract the data from the Bi gFi x_Rem Cntrl V914 | mage_3.t ar file. Gotothe\ Di sk1\| nst Dat a

\ pl at f or Ml VMdirectory where platform is relevant to your operating system. The utility can be run only by using
thetrc_addi tional _setup.exeortrc_addi tional setup. bin file. To extract the installation files for other
supported operating systems, for example, macOS, run one of the t r c_addi t i onal _set up files to extract the

installation files, then copy the . pkg files to the macOS system.

Use the following files to run the additional setup utility:
Windows® systems
trc_addi tional _setup. exe
Linux® systems
trc_additional _setup. bin

For more information about how to obtain the Bi gFi x_Rem Cntrl V914 | mage_ 3.t ar file, see Obtain the
installation files (on page 29).

You can extract the following component installation files.

« Server Installation media: Use the files to run a manual server installation. The t r c. war file and instructions
are extracted.

« Target Installation media:
> Windows Packages (. exe and . nsi )
> Linux Package (. r pnm)
> macOS Package (.pkg)

« Controller installation media:.
> Windows Packages (. exe and . nsi )
> Linux Package (. r pnm)
> macOS Package (.pkg)

- Command Line Interface installation media:
> Windows Packages (. exe and . nsi )
> Linux Package (. r pnm)

» Gateway installation media:
> Windows Packages (. exe and . nsi )
o Linux Package (. r pn)

« Internet Connection Broker installation media:
> Windows Packages (. exe and . nsi )

o Linux Package (. r pn)
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Extract the installation files by using the additional setup utility

To run the additional setup utility, complete the following steps:

1. Runthetrc_addi ti onal _set up file relevant to your operating system.
The file must be run from within the file structure that is extracted from the
Bi gFi x_Rem Cntrl _V914_| nage_3. t ar file. For more information about which file to use, see Utility for
extracting the component installation files (on page 97).
2. Select the language and click OK.
3. Accept the license agreement and click Next.
4. Clear the options that you do not want to extract the files for. Only the options you require must remain
selected.
a. Server Installation media: to extract the files for installing the server.
b. Target Installation media: to extract the files for installing the target.
c. Controller Installation media: to extract the files for installing the controller.
d. Command Line Interface Installation media: to extract the files for running the command line interface.
e. Gateway Installation media: to extract the files for installing gateway support.
f. Internet Connection Broker Installation media: to extract the files for installing broker support.
. Click Next.
. Accept or change the installation folder. Click Next.
. On the summary screen, click Install.

. When complete, click Done.

O 00 N O O»

. Go to the chosen installation folder.
The installation files are in the following directories:

« RCSer ver -server installation file,t r c. war .
« RCTar get - target installation files.

* RCCont rol | er -controller installation files.
« RCCLI - command line tools installation files.
« RCGat eway - gateway installation files.

« RCBr oker - broker installation files.



Chapter 6. Enable secure target registration

To prevent unauthorized targets from registering with the Remote Control server, you can enable the secure

registration feature and use tokens to authenticate the target.

The secure registration feature is enabled by default on a new Remote Control server installation when you use the
installer program. After you install the server, create a registration token on the server and use it when you install the
target. For more information about the secure registration feature and how to create a token, see the Secure target
registration chapter in the BigFix® Remote Control Administrator's Guide

Enable secure target authentication in the server

The BigFix® Remote Control Server provides an installation option to enable secure registration of targets.

When the feature is enabled, the server verifies that a secure registration token that is sent by the target matches an
existing token on the server. If the token is valid, the target is registered in the server and receives an endpoint token

from the server. The target sends the endpoint token to the server each time it contacts the server.

Note: If you have existing targets in the database and you enable the secure registration feature, the existing
targets cannot successfully contact the server because they do not have an endpoint token. Therefore, you
must create or use a valid a secure registration token and reinstall the existing targets with the token so that

they can continue to contact the server.

Enabling secure registration when you run the server installer program

You can enable the secure target registration feature when you install the server by using the installer program. The

feature is enabled by default on a new server installation.

To enable the secure registration feature, complete the following steps:

1. Follow the installation steps in Installing by using the server installer (on page 36).
2. On the Web server parameters window, ensure that Force targets to use https is selected.
3. Select Use secure registration tokens to register targets.

4. Complete the installation.

After you install the server and enable the secure target registration feature, create registration tokens. For more
information about creating registration tokens, see the BigFix® Remote Control Administrator's Guide.

Enabling secure target registration after you install the server

You can enable the secure target registration feature after you install the server by editing properties in the

trc. properti es file.

To enable the secure registration feature after you install the server, complete the following steps.
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1. In the server Ul select Admin > Edit properties file.
2. Selecttrc. properti es from the list.
3. Set rc.enforce.secure.registration to t r ue.

Ensure that the enforce.secure.endpoint.callhome and enforce.secure.endpoint.upload properties are also

settotrue.

4. Click Submit.
5. Click Admin > Reset Application.

You can also manually edit the properties files and set the property to true. Restart the server after you edit the file.

The properties files are in the following directories:

Windows® systems
[installdir]\wlp\usr\servers\trcserver\apps\TRCAPP.ear\trc.war\WEB-INF\classes

Where installdir is the directory that the BigFix® Remote Control Server is installed. For example,

C:\ Program Fi | es\ Bi gFi x\ TRC\ server\w p\usr\servers\trcserver

\ apps\ TRCAPP. ear\trc. war\ VEB- | NF\ cl asses
Linux® systems
[installdir]/wlp/usr/servers/trcserver/apps/TRCAPP.ear/trc.war/WEB-INF/classes

Where installdir is the directory that the BigFix® Remote Control Server is installed. For example,

/ opt / Bi gFi x/ TRC/ server/w p/ usr/servers/trcserver/apps/ TRCAPP. ear

/trc.war/VWEB- | NF/ cl asses

Add a token for secure target registration

The BigFix® Remote Control Target provides an installation option to add a secure registration token. You can also
add the token by running a Fixlet in the BigFix® console.

The token is used to prevent unauthorized targets from registering with the Remote Control server. Create a token on
the server and use it when you install the target. The secure registration feature on the server must also be enabled.

The target sends the secure registration token to the server the first time it contacts the server. The server verifies
that the token matches an existing token on the server. If the token is valid, the target is registered in the server and

receives an endpoint token from the server.

Note:
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P The target includes the token in its callhome to the server only when it uses a secure connection to the server.

The server URL that it uses to connect to the server must start with HTTPS.

Add the secure registration token when you install the target on a Windows™ system

On a Windows™ system, you can add a secure registration token in multiple ways:

» Add the token by using the target installer program.
- Add the token by running the target installation from the command line.
« Modify the target after installation.

Running the target installer with a secure registration token

When you install the target component, use the BigFix® Remote Control Target installer to provide the target with a
secure registration token. The target uses the token to authenticate to the server when it contacts the server for the

first time.

To run the target installer with a token, complete the following steps:

1. Follow the installation steps in Installing the Windows target (on page 55).

2. On the Server Address window, for secure target registration, enter or paste the token in the Secure
registration token field.
Ensure that Use secure connections (https) is also selected. For more information about secure target
registration, see Add a token for secure target registration (on page 100).

3. Complete the installation.
Running a target silent installation with a secure registration token
Install the target along with a secure registration token when you run a new Remote Control target silent installation.
For more information about running a target custom installation, see the BigFix® Remote Control Installation Guide.

To install the target component and the token, run the following command on one line.
trc_target_setup.exe /s /v"/gn REGISTRATIONTOKEN=xxxxxxxxxxx TRC_SERVER_HOSTNAME=yyyyyyyyyyyyyy"

Replace xxxxxxxxxxx with the token and yyyyyyyyyyyyyy with the host name of your Remote Control server.

For more information about running a silent installation when you upgrade the target, see Upgrading the target with a

secure registration token (on page 102).
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Adding the secure registration token after you install the target

If you install the target component and do not install the secure registration token, you can modify the target and add
the token.

Select the method for adding the token.

To add the token by running the installer program, complete the following steps:

1. Go to the Control Panel. For example, Start > Control Panel > Programs > Programs and Features.

2. Right-click Remote Control-Target.

3. Select Change.

4. On the Program Maintenance window, select Modify.

5. Click Next until the Server Address window is displayed.

6. Enter or paste the token in the Secure registration token field. Ensure that Use secure connections (https) is
also selected.

7. Click Install.

8. Click Finish.

To add the token by editing the target registry, complete the following steps:

1. Edit the target registry and go to HKEY_LOCAL_MACHI NE\ SOFTWARE\ Bi gFi x\ Renot e Contr ol \ Tar get

Note: On a 64-bit system, all the 32-bit registry keys are under the Wow6432Node key. For example,
HKEY _LOCAL_MACHI NE\ SOFTWARE\ WOW6432Node\ Bi gFi x\ Renot e Control \ Tar get

2. Right-click RegistrationToken.
3. Click Modify.
4. Enter or paste the token.

5. Restart the target.
Upgrading the target with a secure registration token
Upgrade the Remote Control target with a secure registration token.

The upgrade process requires two steps. You must upgrade the target first, then run an installation with the token.

- To use the installer to upgrade the target with a token, complete the following steps:
1. Runthetrc_target_setup. exe file.
2. Select Yes for an automatic upgrade.

3. Click Next.
If a Files in Use window is displayed, click OK.
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4. Click Finish.

5. To add the token, complete the steps in, Adding the secure registration token after you install the
target (on page 102).

« To run a silent installation to upgrade the target with a token, complete the following steps.
1. At a command prompt type trc_target_setup.exe /s /v"/gn" to upgrade the target.
2. To add the token run trc_target_setup.exe /s /v"/qn REGISTRATIONTOKEN=xxxxxx REINSTALL=ALL"

Where xxxxxx is replaced by the token that you saved when you created a token.

Add the registration token when you install a target on a Linux™ system

On a Linux™ system, you can add a registration token for secure target authentication by editing the / et c/

trc_target. properti es file after you install the target.

To add a secure registration token to a Linux target, complete the following steps after you install the target. For more

information about installing the target on a Linux system, see Installing the Linux target (on page 76).

1. Editthe/etc/trc_target. properties file.

2. Add the registration token property and set it to the value of your registration token. Set RegistrationToken =
XXXXXXXXXXXXXXX, where xxxxxxxxxxxxxxx is replaced with your token data. For example, 6386e21f-4316-460b-
b339-deb3d132f3c7

3. Save the file.

4. Restart the target service. For more information, see Starting, stopping, or restarting the Linux components

(on page 109).



Chapter 7. Install a driver to support smart card
authentication in the target

The BigFix® Remote Control Target provides an installation option to install a virtual smart card reader driver. You can

also install the driver by running a fixlet in the BigFix® console.

The device driver for the virtual smart card reader is required to enable the use of smart cards for remote

authentication, or to perform an action on the target computer.

During a remote control session, the target creates a virtual card reader. The controller user selects a physical card
reader on their system to connect it to the virtual card reader so that the target system can access the smart card.
During the session, when Windows makes a request to the virtual card reader, the target redirects the request to the

physical card reader on the controller system.

For more information about using the smart card feature during a session see, the BigFix® Remote Control Controller

User's Guide.

The device driver for the virtual smart card reader is supported only in Windows 7 or later and Windows Server 2008

R2 or later.

Note: Installation of the driver on Windows 7 or Windows server 2008 R2 might require the following updates

to be installed on the target.
KB2921916

Microsoft hotfix to resolve the "Untrusted publisher" dialog box appears when you install a driver

in Windows 7 or Windows Server 2008 R2 issue.
KB3033929

Security Update for Windows 7 for x64-based Systems.

Installing the virtual smart card reader driver by using the installer

Use the BigFix® Remote Control Target installer to install the device driver for the virtual smart card reader when
you install the target component. You can also use the installer to install the driver on a system that has the target

component already installed.

For more information about adding the driver after you install the target, see Adding or removing the virtual smart

card reader driver by using the installer (on page 705).

To install the target software and the device driver for the virtual smart card reader, complete the following steps:

1. Follow the installation steps in Installing the Windows target (on page 55)
2. On the Additional features window, select Install device driver for Virtual Smart Card Reader.
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After you install the driver, you must install a certificate so that the target can automatically enable the driver when
smart card authentication is requested. For more information about installing the certificate by running a Fixlet, see
the BigFix® Remote Control Console User's Guide. You can also download the certificates and install them manually.
For more information, see the BigFix® Remote Control Console User's Guide.

Adding or removing the virtual smart card reader driver by using the
installer

After you install the target component, you can add or remove the device driver for the virtual smart card reader by

using the installer.

If you install the target component and do not install the device driver, you can modify the target and add the driver.

To add the driver, complete the following steps:

1. Go to the Control Panel. For example, Start > Control Panel > Programs > Programs and Features.
2. Right-click Remote Control-Target.

3. Select Change.

4. On the Program Maintenance window, select Modify.

5. Click Next until the Additional features window is displayed.

6. Select Install device driver for Virtual Smart Card Reader. Click Next.

7. Click Install.

8. Click Finish.

The target can automatically enable the driver when smart card authentication is requested during a remote control
session. Use the same procedure to remove the driver. In step 6 (on page 105), clear Install device driver for Virtual
Smart Card Reader.

After you install the driver, you must install a certificate so that the target can automatically enable the driver when
smart card authentication is requested. For more information about installing the certificate by running a Fixlet, see
the BigFix® Remote Control Console User's Guide. You can also download the certificates and install them manually.
For more information, see the BigFix® Remote Control Console User's Guide.

Installing the virtual smart card reader driver by running a silent
installation

Install the device driver for the virtual smart card reader when you run an Remote Control target silent installation.

You can install the driver when you run a silent installation on a computer that does not have the target component.
You can also add or remove the driver from an installed target. For more information about running a target custom

installation, see Run a target custom installation (on page 78).

« To install the target component and the device driver for the virtual smart card reader, run the following

command.

trc_target_setup.exe /s /v"/gn VSC=1"
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- To add the driver to an installed target, run the following command.

trc_target_setup.exe /s /v"/qn ADDLOCAL=vsc REINSTALL=service"

« To remove the driver from an installed target, run the following command.

trc_target_setup.exe /s /v"/gn REMOVE=vsc REINSTALL=service"

After you install the driver, you must install a certificate so that the target can automatically enable the driver when
smart card authentication is requested. For more information about installing the certificate by running a Fixlet, see
the BigFix® Remote Control Console User's Guide. You can also download the certificates and install them manually.

For more information, see the BigFix® Remote Control Console User's Guide.

Installing the virtual smart card reader driver when you upgrade the
target

Install the device driver for the virtual smart card reader when you upgrade the Remote Control target.

- To install the driver when you upgrade the target by using the installer, complete the following steps:
1. Runthetrc_target setup. exe file.
2. Select Yes for an automatic upgrade.

3. Click Next.
If a Files in Use window is displayed, click OK.

4. Click Finish.

5. To install the driver, complete the steps in, Adding or removing the virtual smart card reader driver by

using the installer (on page 705).

- To install the driver when you upgrade by running a silent installation, complete the following steps.
1. At a command prompt type trc_target_setup.exe /s /v"/qn" to upgrade the target.
2. To add the driver run trc_target_setup.exe /s /v"/qn ADDLOCAL=vsc REINSTALL=service".

After you install the driver, you must install a certificate so that the target can automatically enable the driver when
smart card authentication is requested. For more information about installing the certificate by running a Fixlet, see
the BigFix® Remote Control Console User's Guide. You can also download the certificates and install them manually.
For more information, see the BigFix® Remote Control Console User's Guide.

Installing the virtual smart card reader driver and certificates by
running a Fixlet

Install the device driver for virtual smart card reader together with the certificates by running a Fixlet in the BigFix®

console.
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You can install the driver and certificates by running a Fixlet after you install the target. To install the driver and

certificates, complete the following steps:

1. In the Remote Control site, click the Deployment node.
2. Select the Install Remote Control Virtual Smart Card Reader Driver version 10.0.0.23 and certificates task.
3. Review the information in the Description tab.

4. Follow the instructions in the Actions field to install the driver.

The device driver and certificates that are required for smart card authentication are installed. During a remote control
session, when the controller user selects a physical card reader on their system, the target can now create a virtual

card reader.

Note: If an error is reported when you run the Fixlet, use the VSCDr i ver | nst al | . | og file in the target

installation directory for debugging purposes.

Installing the certificates by running a Fixlet®

Use a Fixlet® to install the certificates that are required by the device driver for the virtual smart card reader.

You can install the certificates together with the driver by running a Fixlet®. However, if the results of the Remote
Control - Virtual Smart Card Reader Driver Status analysis show that the device driver is installed on your computer,
but there are no certificates, you can install the certificates by running a Fixlet®. To install the certificates, complete

the following steps:

1. In the Remote Control site, click the Deployment node.

2. Select the Install Remote Control Certificates for the Virtual Smart Card Reader Driver version 10.0.0.23
task.

3. Review the information in the Description tab.

4. Follow the instructions in the Actions field to install the driver.

The certificates that are required for smart card authentication are installed. For more information about the Remote

Control - Virtual Smart Card Reader Driver Status analysis, see Determining whether smart card support is enabled.

Note: If an error is reported when you run the Fixlet®, use the VSCCer t sl nst al | . | og file in the target
installation directory for debugging purposes.

Downloading the certificates for the virtual smart card reader

You can download the certificates that are required by the device driver for the virtual smart card reader and install

them manually. For example, by using Active Directory Group Policy.

You can download the certificates in multiple ways. Choose the method for downloading the certificates.
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- Download the files from the Remote Control site in the BigFix® console:
1. Click the Deployment node and select the Install Remote Control Virtual Smart Card Reader Driver
version 10.0.0.23 and certificates task.
2. Select the Description tab.
3. Follow the instructions in the Description field to download the certificates.
4. Savethevsc _certs_1020. zi p file.
5. Extract the certificate files from the . zi p file.
« Extract the certificate files from the installation media:
1. Access the image files. For more information about the image file, see Obtain the installation files (on
page 29).
2. Download the Bi gFi x_Rem Cntrl _V10xx_I| mage_1. zi p file, where 70xx is relevant to the version
that is installed.

3. Extract the certificate files from the \ W ndows directory of the . zi p file.

When you install the certificates, you must install the HCL_Aneri ca_| nc- sha256. crt file to the Trusted Publishers
store. Install the Tr ust edRoot . crt and Di gi Cert CA-sha256. crt files to the Trusted Root Certificate Authorities

store.



Chapter 8. Manage the component services

After you install the Remote Control components, if you change their configuration, you can stop, start, or restart the

component services.

Follow the steps in the section that is relevant to your operating system.

Starting, stopping, or restarting the Windows™ components

You can start, stop, or restart the Remote Control Windows™ components from within the Control Panel.

To manage the Remote Control Windows™ components, complete the following steps.

1. In Control Panel select Administrative tools > Services.

2. Highlight the relevant service.
Server service
Remote Control- Server
Target service
Remote Control- Target
Gateway service
Remote Control- Gateway
Broker service
Remote Control- Internet Connection Broker

3. Choose the appropriate method for selecting an action for the service.
You can right-click and select start, stop, or restart or select Start, Stop, or Restart from the list on the left.

Starting, stopping, or restarting the Linux™ components

You can start, stop, or restart the Remote Control Linux™ components from within the Control Panel.

Depending on the version of Linux™ you are using, use one of the following commands to manage the components.

* /sbin/service conponent action

e /etc/init.d/ component action

Where component is the component service that you want to manage and action is start, stop, or restart.
Server

For example, to start the server service.

* /shin/service trcserver start

*/etc/init.d/trcserver start
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Target

For example, to stop the target service.

* /shin/service trctarget stop

e /etc/init.d/trctarget stop

Gateway

For example, to restart the gateway service.

* /sbin/service trcgateway restart

*/etc/init.d/trcgateway restart

Broker

For example, to restart the broker service.

* /shin/service trcbhroker restart

e /etc/init.d/trcbroker restart



Chapter 9. Enabling email

To use the email function, you must install and set up an email server. For example, for a forgotten password, to

export and email a report, or to request access to certain targets.

To enable the email function, complete the following steps:

1. Log on to Remote Control server with a valid admin ID and password.
2. Click Admin > Edit properties files.
3. Select trc.properties.

4. Edit the following variables

email.enabled

Set to true to enable email.
SMTP.server

Set to the address of your mail server.
SMTP.authentication

Set to true of false, Set to true to authenticate with the SMTP ID and password.
SMTP.userid

User ID for the SMTP server.
SMTP.password

Password for the SMTP server.

5. Click Submit.

The email function is enabled.



Chapter 10. Configure LDAP

Remote Control provides Lightweight Directory Access Protocol Version 3 support. You can use LDAP to enable

authentication and integration of users and their associated group membership into the Remote Control database.

All configuration information that is required for LDAP authentication is in the | dap. pr operti es file. Before you

configure, some prerequisite information must be obtained. This information simplifies the configuration process.

« A user name and password to be used by Remote Control to establish a connection with the Active Directory
server. This user name must have the authority necessary to read all the required information from the

directory tree.
« The fully qualified server host name or IP address of the Active Directory server to be used with Remote

Control.
« In an Enterprise scenario, a secondary backup LDAP server would also be configured in Remote Control.

Setting up LDAP synchronization
To enable LDAP authentication, synchronization with the LDAP server must also be enabled. Edit values in the

comon. properti es fileand the | dap. properti es file to enable synchronization.

To perform the basic configuration for LDAP authentication, complete the following steps:

1. Click Admin > Edit properties file.
2. Ensuring that you are editing the conmon. pr operti es file, edit the following properties

authentication.LDAP
To enable or disable LDAP authentication.
True

LDAP user authentication is enabled.

Note: Each time the synchronization with Active Directory takes place the
users and user groups are deleted from the Remote Control database and
then imported from Active Directory. Therefore, if LDAP is enabled, new
users and new user groups must be created in Active Directory and not in

Remote Control.

False

LDAP user authentication is not enabled. Users are authenticated against the

Remote Control database.

aut henti cati on. LDAP=t r ue

authentication.LDAP.config

Defines the file that contains the LDAP configuration properties.
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aut henti cati on. LDAP. confi g=I dap. properties

sync.ldap

Synchronize the users and groups from Active Directory with the Remote Control database.

Takes the values true, to synchronize or false, for no synchronization.
True

The LDAP server is synchronized with the Remote Control database to reflect any

changes that are made in LDAP.
False

No synchronization takes place. If synchronization is disabled, you must manually
import the users into the Remote Control database. Otherwise, they cannot log on
to the Remote Control server. The users must exist in the Remote Control database
so that they can be associated with the relevant permissions that are required to

establish remote control sessions.

Note: The synchronization is performed by running a scheduled task. The task pulls the
LDAP information from the LDAP server and updates the database with any changes
that are made to the user or group information. Withinthe t r c. properti es file, two

attributes define the time interval that the scheduler uses to check for scheduled tasks.
scheduled.interval

The frequency hat the server must check for scheduled tasks. The number

of units of time between each checking period. Default is 60.

Note: If you change this value, restart the server service for the

new value to take effect.

sync.LDAP.task_run_time

Use to indicate the time of the day the a fixed time synchronization has to
occur. This is an alternate setting to scheduled.interval. Possible values: 24
hours notation of the time in HH:MM:SS. For Example 02:00:00 to perform
the synchronization at 2 AM.

Note:

> When using usingsync.LDAP.task_run_time the actual task
execution time is affected by the scheduled.interval setting,
as the LDAP synchronization occurs within the context of
the task scheduler. The actual execution time can span
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from sync.LDAP.task_run_time to sync.LDAP.task_run_time
+ scheduled.interval.
> The server must be restarted to use fixed time

synchronization.

scheduled.interval.period

The unit of time to be used along with the scheduled interval to specify

how often the server must check for scheduled tasks. Default is minutes.

The scheduled.interval attribute is set to 60 as default and the
scheduled.interval.period set to minutes, that is, the server checks for and runs any
scheduled tasks every 60 minutes. To accurately reflect any changes to the users or
groups, set the scheduled.interval attribute to a lower value so that the synchronization

can occur more frequently.

3. Click Submit.

Verifying connection information

Use parameters to define how Remote Control connects to the LDAP server. The connection is used to query the
LDAP server for the user and group information that is imported into Remote Control.

Any changes to the | dap. properti es file do not take effect until you select Admin,Reset Application. To avoid
multiple restarts or an extended outage use an LDAP browser and the LDAP Configuration Utility as an aid to the

entire configuration process.

To verify the connection information by using an LDAP browser, define an LDAP server profile by entering the fully
qualified host name and credential information. When you open an LDAP browser for the first time, provide details for
a new profile.
The profile can include the following information.
Host
Host name or FQDN of the preferred LDAP Server.
Port

Port that is used to communicate with the directory. Typically, port 389 but if your environment contains
child domains, port 3268 must be used instead. Port 3268 points to the Global catalog that includes the
child domains.

Base DN

The root point to bind to the server. For example, DC=nmydonai n, DC=nyconpany, DC=com

After the information is entered, the LDAP Browser displays attribute names and values available at the root of the
Active Directory tree.
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When a connection is established, use the same information that is used in the LDAP browser to set the parameters

inthe | dap. properti es file.

« Click Admin > Edit properties files
« Select Idap.properties from the list

« When modifications are complete, click Submit

The application must be reset for the changes to take effect. Click Admin > Reset Application or restart the server
service.

The properties file can also be edited manually by locating it on the BigFix® Remote Control Server. The file is in the
[installdir]w p\usr\servers\trcserver\apps\ TRCAPP. ear\trc. war\VEB- | NF\ cl asses directory,
where installdir is the directory that the BigFix® Remote Control Server is installed in. For example, C:\ Program
Files (x86)\Bi gFi xX\ TRC\ server\w p\usr\servers\trcserver \apps\ TRCAPP. ear\trc.war\WEB-
I NF\ cl asses

Note: Remote Control is provided with a default | dap. properti es file and many of the extended
configuration options are commented out. To enable the options, the file must be edited manually.

Note: The BigFix® Remote Control Server is capable of managing one Global catalog only. This means that

domain controllers of different domains cannot be managed by the same BigFix® Remote Control Server.

Users belonging to a domain which is not included in the forest specified in the server configuration cannot be

added to the users of the same BigFix® Remote Control Server.

Configuring connection credentials

Use the following properties to set valid credentials for connecting to the LDAP server.

Note: Check that a successful connection to the LDAP browser can be established by using these credentials
to verify that they are valid.

1. Edit the | dap. properti es file.

2. Configure the following properties.
Idap.connectionName

The user name that is used to authenticate to a read-only LDAP connection.
If left not set, an anonymous connection is attempted. For example,

adm ni strat or @ydonai n. myconpany. com

Idap.connectionPassword
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The password that is used to establish a read-only LDAP connection. The password can be
entered here in plain text or it can be encrypted. Use the LDAP wizard to encrypt your password.
For more information, see Configure LDAP properties by using the LDAP wizard.

Idap.connectionPasswordEncrypted
True
The LDAP password is encrypted.
False
The LDAP password is not encrypted and entered as plain text.
Idap.connectionURL

The directory URL used to establish an LDAP connection. Type in the URL of your LDAP server.

| dap: // nyl dapser ver . mydomai n. nyconpany. com

Setting connection security

The following properties define the level of security to be used on the connection to the LDAP server. Set the following

parameter to si npl e so that the Remote Control server can communicate with most Active Directory servers.
Idap.security_authentication

Specifies the security level to use. Value can be set to one of the following strings: none, simple, strong.
If this property is unspecified, the behavior is determined by the service provider.

| dap. security_athentication=sinple

While most LDAP servers support simple plain text login, some Active Directory administrators require a secure
connection. Remote Control supports two types of secure connections to an Active Directory server, SASL (Digest-
MD5) or SSL. If you cannot connect to the Active Directory server and see the following errorinthetrc. | og:

LDAP Aut henti cati on. exception[ LDAP: error code 8 - 00002028: LdapErr: DSI D 0C09018A,
coment: The server requires binds to turn on integrity checking if SSL\TLS are not

al ready active on the connection, data 0, vece ]
Remote Control needs to be configured for either SASL or SSL connections.

SASL (Simple Authentication and Security Layer)

The following parameters relate to using SASL to secure the connection to the LDAP server. If you are not using
SASL, the parameters must not be edited. Comment out the parameters. The following values are used to configure
Remote Control to connect to Active Directory that uses SASL in a test environment. Consult your organizations

active directory support team to acquire the correct values for your company.

Idap.security_authentication
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Specifies the security level to use. If this property is unspecified, the behavior is determined by the
service provider. If you are using SSL, the value is set to simple. If you are using SASL, the value is set to
the SASL mechanism DIGEST-MDS5.

| dap. security_aut henticati on= DI GEST- MD5

Idap.connectionRealm
The Realm name where the user ID and password resides.

| dap. connect i onReal m= nmydomai n. myconpany. com

Idap.connectionQop

This value can be one of:

« auth = Authentication only

- auth-int = Authentication and integrity checking by using signatures

« auth-conf = (SASL only) Authentication, integrity and confidentiality checking by using signatures
and encryption.

| dap. connect i onQop= aut h- conf

Idap.connectionMaxbuf

Number that indicates the size of the largest buffer the server is able to receive when you use auth-int or
auth-conf. The default is 65536.

| dap. connect i onMaxbuf = 16384

Idap.connectionStrength

Connection strength can be one of: low, medium, high.

| dap. connecti onStrengt h= hi gh

SSL (Secure Socket Layer)

The following parameters define the use of SSL to connect to the Active Directory server. To use SSL, you must install
a Root CA public key certificate keystore on the Remote Control Server. If SSL is not used, the parameters can be
commented out inthe | dap. properti es file.

Idap.security_protocol

Specifies the security protocol to use. The value is a string that is determined by the service provider.

For example, ssl. If this property is unspecified, the behavior is determined by the service provider.

| dap. security_protocol =ssl

Idap.ssl_keyStore

Enter the location of the keystore file.
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| dap. ssl _keySt or e=Pat hOf KeyStoreFi | e

Idap.ssl_keyStorePassword
Enter the location of the keystore password.

| dap. ssl _keySt or ePasswor d=Keyst or ePasswor d

Setting user authentication properties

Authenticating the user

Use the following properties to define how the user is authenticated when they attempt to log on to the Remote
Control server. To configure the following sections use the LDAP browser as described for each parameter, to derive

the correct settings.
Idap.digest
Digest algorithm that is used by LDAP. Values are SHA, MD2, or MD5 only. The default is cleartext. If

the LDAP servers returns a password, Remote Control uses the Digest algorithm to encrypt the user
input password and compare it with the password it receives from the LDAP server. If no password is
returned from the LDAP server, Remote Control uses the user name and password that is provided by

the end user to authenticate with LDAP.

| dap. di gest =SHA

Idap.userid

Idap.userid is the LDAP attribute that contains the user ID that is mapped to the userid field in the
Remote Control database. The userPrincipalPattern property then needs to know whether the

@domainname, UPN suffix, is added for Active Directory authentication.
sAMAccountName

sAMAaccount must be used so that the user ID only portion of the logon, without the UPN

Suffix, is used.
userPrincipalName

userPrincipalName must be used to force all logons to use the full User Principal Name.

Note: It is recommended to set Idap.userid to this value to ensures that it does not
contain any invalid characters. For example, an apostrophe.

The Idap.userid relates to other configuration values in the | dap. properti es file.

For example, if the Idap.userid is set to userPrincipalName, the user must log on to Remote Control with

their full ID. For example, awi | son@xanpl e. com
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« The Idap.userSearch variable would be (userPrincipalName={0}).

« The Idap.principalPattern would be {0}.

If the Idap.userid is set to use sSAMAccountName, the user must log on to Remote Control with just the

user ID part of their ID. For example, awilson. The following parameters must be set so that the fully

qualified name is appended.
For example
* The Idap.userSearch variable would be (userPrincipalName={0}@mydomain.mycompany.com)

For a user awilson@example.com, the Idap.userSearch variable would be

(userPrincipalName={0})

« The Idap.principalPattern would be {0}@mydomain.mycompany.com.

For a user awilson@example.com, the Idap.principalPattern would be { 0} @xanpl e. com

Idap.userPassword

The name of the LDAP attribute in the user's directory entry that contains the user's password. In Active

Directory, password is the default name of the attribute.

| dap. user Passwor d=passwor d

Idap.userEmail

The name of the LDAP attribute in the user's directory entry that contains the user's email address.

Note: The Idap.userEmail property cannot have a null value. If your Active Directory Tree does
not contain email information, a different attribute must be used. For example, Idap.userEmail

might be set to userPrincipalName.

Idap.userRealm

Realm name that is used for user authentication. This setting is optional and can be commented out, in

the | dap. properti es file, for most configurations.
| dap. user Real nrusers. conpany. donai n. com

Idap.principalPattern

Pattern for construction of user principal for using LDAP authentication. Some LDAP servers require
email address, for example, user i d@onai n. comand others require the user ID only. The string “{0} is

substituted by the users user ID entered at the login screen.

Searching for the users directory entry

The method available for finding the end-users information involves defining a starting point in the Active Directory
tree and allowing Remote Control to recursively search through the tree for the userid. For most Active Directory
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implementations this is the preferred method as users are usually spread out in several locations in an Active
Directory tree. This method is especially helpful if user information is contained under a single branch of the tree but
broken up by department or underneath the branch

Note: It should be noted that when LDAP has been enabled, new users and new user groups should be
created in Active Directory and not in Remote Control. This is because each time the synchronization with
Active Directory takes place the users and user groups are deleted from the Remote Control database and

then imported again from Active Directory.

To use the recursive search configure the following parameters:
Idap.userBase

The base LDAP directory entry for looking up users that match the search criteria. If not specified, the
search base is the top-level element in the directory context.

for exanpl e OU=nyl ocati on, DC=nyconpany, DC=com

You can refine your search by going deeper into the OU structure and selecting to search only within a
specific organizational unit for example an OU called Users and therefore you would set the property
value as

| dap. user Base=OU=User s, ou=nyl ocat i on, dc=nydonai n, dc=myconpany, dc=com

This would instruct Remote Control to look for users matching the criteria, only within the Users OU (and
any OUs that belong to the Users OU if Idap.groupSubtree is set to true)

Idap.userSearch

Defines the LDAP query that is used to import Active Directory users to Remote Control. The defined
query needs to filter the results such that only those users which match the search criteria are imported
to Remote Control. The default value is

(objectClass=user)

which means, look for users in any object that is a user object within the userbase. That is import all

Active Directory users to Remote Control.

Note: When using the above it should be noted that some environments can have thousands of
users therefore it is important to create a filter which will only import the required users. To limit
the users that are imported to only those users who match the search criteria and are members
of the groups that were imported into Remote Control through the Idap.groupSearch filter, you
should set the property Idap.userinGroup to true. It should also be noted that as well as being
imported into the relevant groups that are returned in the group search, users are also imported
into the DefaultGroup. Setting Idap.userinGroup to false will import all users who match the

search criteria, regardless of their group membership.
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The search can therefore be further refined by using more complex queries. For example if you have the

following values set

| dap. gr oupBase=( OU=nyl ocat i on. DC=nyconpany. DC=con)
Ldap. user Search: (&(obj ect d ass=user) (| (menber Of =CN=Depar t nent 1, OU=GROUPS,
OU=nyl ocat i on, DC=nyconpany, DC=conm) (nenber Of =CN=Depar t nent 3, OU=GROUPS,

OU=nyl ocat i on, DC=nyconpany, DC=com) ) ( name={ 0} ) )

If there were three groups defined, Department1, Department2 and Department3 the above query
would authenticate and import any users that are defined as objectclass user and are members of the
Department1 OR Department3 groups. Users from Department2 would not be able to logon to Remote

Control.
The (&(name={0}) is added to the end to specify that the name attribute is used for logging in. This value
has to match whatever attribute was specified as Idap.userid.

Idap.userSubtree

Set this value to true if you want to recursively search the sub tree of the element specified by the
userBase attribute for the user's directory entry. The default value of false causes only the top level to be

searched (a nonrecursive search). This is ignored if you are using the userPattern expression.

| dap. user Subt ree=true

Importing Active Directory Groups

One of the greatest benefits of integrating with Active Directory is being able to use existing Active Directory groups.
After Active Directory groups are imported, an administrator must define the permissions for each group and group
membership is handled inherently by Active Directory. To import Active Directory groups, configure the following

properties in the | dap. properti es file.
Idap.groupName
The LDAP attribute name that is used for the group search.

| dap. gr oupNane=cn OR | dap. gr oupNane=nane

Idap.groupDescription

The LDAP attribute name to be used to get the description for the group. It is set to description by
default.

| dap. gr oupDescri pti on=descri ption

Idap.groupNameTrim

Set to true or false. Limits the group name that is imported to the Remote Control database to 64

characters. The recommended value is false.

Idap.groupMembers
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LDAP attribute name to be used to find the members of the groups that are returned as a result of the

specified search. The default value is member.

| dapgr oupMenber s=nenber

Idap.groupSubtree

If set to true, Remote Control searches recursively through the subtree of the element that is specified in
the Idap.groupBase parameter for groups that are associated with a user. If left unspecified, the default
value of false causes only the top level to be searched, and no recursive search is run. True or False

(default).

Idap.groupBase
The base LDAP directory entry for starting the search for groups to synchronize. If left unspecified, the
default is to use the top-level element in the directory context.

for exanpl e OU=nyl ocati on, DC=nmyconpany, DC=com

To refine your search and go deeper into the OU structure, select to start the search only within a

specific organizational unit. For example, an OU called Test. Set the property to the following value.
OU=Test , OU=nyl ocat i on, DC=nyconpany, DC=com

Therefore, Remote Control looks for groups that match the criteria, only within the Test OU (and any OUs

that belong to the Test OU if Idap.groupSubtree is set to true).

Idap.groupSearch

Defines the LDAP query that is used to import AD groups to Remote Control. The defined query needs to

filter the results such that only those groups that are needed are imported to Remote Control.

| dap. gr oupSear ch=( obj ect G ass=gr oup)

Imports all AD groups found in the OU specified in the Idap.groupBase property to Remote

Control. Some environment can have thousands of groups.

| dap. gr oupSear ch=( & obj ect O ass=gr oup) (cn=*SM5*))
Imports all groups that contain SMS in the cn attribute. For example, visio-sms-users.

| dap. gr oupSear ch=( & obj ect O ass=gr oup) (cn=adni ns))
Imports all groups that are named admins.

| dap. gr oupSear ch=( & obj ect O ass=gr oup) (cn=adm ns*))
Imports all groups that have the text admins in the name. For example, administrators,
server-administrators.

Idap.groupMembers

LDAP attribute name to be used to find the members of the groups that are returned as a result of the

specified search. The default value is member.
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These queries can be tested by using the LDAP browsers directory search option or the LDAP configuration utility in

the Remote Control server Ul.

Testing the Connection

When the cormon. properties &l dap. properti es files are updated, reset the Remote Control application by
selecting Admin > Reset Application.

When the service restarts, log on to the Remote Control server by using an Active Directory user ID and password. If
the entries in the LDAP properties file are correct, you are authenticated and logged on successfully.

BigFix® Remote Control Server connects directly to LDAP. Therefore, any password changes within LDAP are
immediately effective only if the LDAP password change synchronizes to the LDAP server that is set within the
| dap. properti es file.

Note: The default ADMIN user ID within the BigFix® Remote Control Server application always authenticates
against the BigFix® Remote Control Server regardless of whether LDAP authentication is enabled. If there is a

connectivity problem between BigFix® Remote Control Server and LDAP, the ADMIN user can always log on.

If there are any errors in the | dap. properti es file, you see a failed logon message. The Logon screen is displayed
with an Invalid user name or wrong password message.

To determine the cause of the failure look inthe t r c. | og file. View the application log by using the server Ul.

« In the BigFix® Remote Control Server Ul, click Admin > View application log
« Click CTRL+END to reach the end of the file.

The following common errors can be displayed. The errors indicate a problem with creating the initial connection
between BigFix® Remote Control Server and Active Directory.

AcceptSecurityContext error, data 525
Returns when user name is invalid.
AcceptSecurityContext error, data 52e

Returns when user name is valid but password or credentials are invalid. Prevents most other errors
from being displayed as noted.

AcceptSecurityContext error, data 530

Logon failure: account logon time restriction violation. Displays only when presented with valid user
name and password credentials.

AcceptSecurityContext error, data 531

Log on failure: user is not allowed to log on to this computer. Displays only when presented with valid

user name and password credentials.

AcceptSecurityContext error, data 532



Remote Control Installation Guide | 10 - Configure LDAP | 124

Logon failure: the specified account password is expired. Displays only when presented with valid user

name and password credentials.
AcceptSecurityContext error, data 533

Logon failure: account currently disabled. Displays only when presented with valid user name and
password credential.

AcceptSecurityContext error, data 701

The user's account is expired. Displays only when presented with valid user name and password
credential.

AcceptSecurityContext error, data 773

The user's password must be changed before they log on for the first time. Displays only when

presented with valid user name and password credential.
AcceptSecurityContext error, data 775

The referenced account is locked out and cannot be logged on to. Displays even if invalid password is

presented.
LDAP Authentication.exceptionmyserver.mydomain.com:389

Displays when the server name specified by Idap.connectionURL is unreachable.

Verifying that the groups are imported

When authentication is successful and you are logged on to the Remote Control server, click User groups > All User
Groups to verify that the correct groups were imported from Active Directory.

After the groups are imported into Remote Control, define permissions for the newly imported groups.

Sample LDAP Configuration File

The file is a sample configuration file. It uses a simple connection to Active Directory with importing of Active

Directory groups

# LDAP Properties

# Server Authentication definition

# The directory URL used to establish an LDAP connection

Idap.connectionURL=ldap://myldapserver

# define the secondary LDAP server name, if the primary is down we can use an alternative LDAP server

#-ldap.alternateURL=

# The username used to authenticate a read-only LDAP connection. If left not set, an anonymous connection is made.
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Idap.connectionName=administrator@mydomain.MyCompany.com

# The password used to establish a read-only LDAP connection.
Idap.connectionPassword=myPassword

# Instructs Remote Control to read the value of the password parameter as encrypted ( true) or plain text ( false). See

Admin guide for instructions on generating encrypted password

Idap.connectionPasswordEncrypted=false

# The fully qualified Java™ class name of the JNDI context factory to be used for

# this connection. If left unset, the default JNDI LDAP provider class is used.

# - -ldap.contextFactory=com.sun.jndi.ldap.LdapCtxFactory

# i SASL Definition ########H#HH#H###HHHH A A AR AR AR
# specifying the security level to use. Its value is one of the following strings: "simple" or "DIGEST-MD5".

# . If using SSL, you have to use simple.

Idap.security_authentication=simple

#ldentifies the realm or domain from which the connection name should be chosen

# -—- Idap.connectionRealm=

#Quality of protection

# QOP can be one of: auth, auth-int, auth-conf

# auth -- Authentication only

# auth-int -Authentication and integrity checking by using signatures

# auth-conf - (SASL only) Authentication, integrity and confidentiality checking
# by using signatures and encryption.

# —Idap.connectionQop=auth

# Number indicating the size of the largest buffer the server is able to receive when
# using "auth-int" or "auth-conf". The default is 65536.

# Idap.connectionMaxbuf=16384
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# Strength can be one of: low,medium,high

# -—ldap.connectionStrength=high

# HURHHH AR SSL Definition ######H## U A #HH AR HHH AR B HH
# specifying the security protocol to use. Its value is a string determined by

# the service provider (for example: "ssl"). If this property is unspecified, the behaviour

# is determined by the service provider.

# -—ldap.security_protocol=ssl

# Access the keystore, this is where the Root CA public key cert was installed
# No need to specify the keystore password for read operations
# -—Idap.ssl_keyStore=PathOfKeyStoreFile

# -—-ldap.ssl_keyStorePassword=KeystorePassword

# specifying how referrals encountered by the service provider are to be processed.
# The value of the property is one of the following strings:

# "follow" - follow referrals automatically

# "ignore" - ignore referrals

# "throw" - throw ReferralException when a referral is encountered.

# If this property is not specified, the default is determined by the provider.

# -—-ldap.referrals=follow

# i define Group search for LDAP #######H#H Y
# The base LDAP directory entry for looking up group information. If left unspecified,
# the default is to use the top-level element in the directory context.
Idap.groupBase=0U=Groups,0U=mylocation,DC=mydomain,DC=mycompany,

DC=com

#The LDAP filter expression used for performing group searches.

Idap.groupSearch=(&(objectClass=group) (name=TRC*))
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# Set to true if you want to recursively search the subtree of the element specified in
# the groupBase attribute for groups associated with a user. If left unspecified, the default
# value of false causes only the top level to be searched (a nonrecursive search).

Idap.groupSubtree=true

#The LDAP attribute that we should use for group names.

Idap.groupName=name

#The LDAP attribute that we should use for group descriptions

Idap.groupDescription=description

# This is the attribute specifying user members within a group

Idap.groupMembers=member

# # A User search definition #############HHHH#######
#The base of the subtree containing users

#If not specified, the search base is the top-level context.

Idap.userBase=0U=Users,0U=mylocation,DC=mydomain,DC=mycompany, DC=com

# The LDAP filter expression to use when searching for a user's directory entry, with {0} marking

# where the actual username is inserted.

Idap.userSearch=(&(objectClass=User)(sAMAccountName={0}))

# Set this value to true if you want to recursively search the subtree of the element specified by
# the userBase attribute for the user's directory entry. The default value of false causes only the
# top level to be searched (a nonrecursive search).

Idap.userSubtree=true

#Set this value to true if a user has to be a member of the groups found in the group search

Idap.userinGroup=true

# Digest algorithm (SHA, MD2, or MD5 only)
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# Remote control will use it to encrypt the user input password and
# compare it with password it receives from the LDAP server. If left unspecified, the default value is "cleartext".

# -—- Idap.digest=SHA

#LDAP attribute used for userids

Idap.userid=sAMAccountname

# LDAP User password attribute

Idap.userPassword=password

# LDAP Attribute containing the Users Email address

Idap.userEmail=userPrincipalName

# If the following parameters are defined they are mapped into the local remote control database
Idap.forename=givenName

Idap.surname=sn

Idap.title=title

Idap.initials=initialsg

Idap.company=company

Idap.department=department

Idap.telephone=telephoneNumber

Idap.mobile=mobile

Idap.state=st

Idap.country=Co

###4# Other property definitions

#Set this value to the page size of LDAP search retrievals (default=500).

# Do not set this to anything greater than the max page size for the LDAP server ( for example, AD has a limit of 1000)

Idap.page.size=500



Chapter 11. Federal information processing standard
(FIPS 140-2) compliance in Remote Control

The US Federal information processing standard 140-2 (FIPS 140-2) is a cryptographic function validation program
that defines security standards for cryptographic modules that are used in IT software.

When configured in FIPS 140-2 mode, Remote Control uses the following FIPS 140-2 approved cryptographic
modules:

The IBM Java JCE FIPS 140-2 Cryptographic Module (IBMJCEFIPS) is a scalable, multipurpose cryptographic module
that supports many FIPS approved cryptographic operations. This module is used in the Remote Control Server

( (until versions 10.0.0.0736 included) and in the Remote Control Controller up to version 10.0.0.0518 included
(Windows and Linux Only). The certificate number for this cryptographic module is #2715 is held on the NIST website
at https://csrc.nist.gov/projects/cryptographic-module-validation-program/Certificate/2715.

The IBM Java JCE FIPS 140-2 Cryptographic Module (IBMJCEPIusFIPS) that supersede the IBMJCEFIPS. The new
provider has similar functionality to the older equivalent but offers support for newer algorithms, additional hardware-
accelerated cryptographic capabilities (where supported) and performance enhancements. This module is used in
the Remote Control Server starting from version 10.0.0.0818. The certificate number for this cryptographic module

is #3064 is held on the NIST website at https://csrc.nist.gov/Projects/Cryptographic-Module-Validation-Program/
Certificate/3064.

The BC-FJA (Bouncy Castle FIPS Java API) (BCFIPS) is a comprehensive suite of FIPS Approved algorithms
implemented in pure Java. This module is used in the Remote Control Controller starting from Version 10.0.0.0600
(Windows, Linux and MacOS). The certificate number for this cryptographic module is #3514 is held on the NIST

website at https://csrc.nist.gov/projects/cryptographic-module-validation-program/Certificate/3514.

The OpenSSL FIPS Object Module is a general purpose cryptographic module. This module is used in the Remote
Control Target, Broker, and other native components. The certificate number for the cryptographic module used in
Remote Control version up to 10.0.0.0818 included is #1747 is held on the NIST website at https://csrc.nist.gov/
projects/cryptographic-module-validation-program/Certificate/1747. The certificate number for the cryptographic
module used in Remote Control starting from version 10.1.0 is #4282 is held on the NIST website at https://

csrc.nist.gov/projects/cryptographic-module-validation-program/certificate/4282.
Enable FIPS compliance on the server

Enabling FIPS compliance on a server installation with a stand-alone WebSphere
Application Server

The BigFix® Remote Control Server uses the middleware infrastructure that is provided by WebSphere® secure HTTP
communications. Therefore, to enable FIPS for a manual BigFix® Remote Control Server installation requires that
you configure WebSphere® for FIPS-compliant mode. You must also configure the BigFix® Remote Control Server

through a setting in the conmon. pr operti es configuration file.
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To enable FIPS compliance for a manual installation, complete the following steps:

1. Configure WebSphere

Note: Running in FIPS mode in IBM® WebSphere® with the IBM® JRE and the IBM® JSSE provider
currently does not work when you use an MS SQL database. These options work with MS SQL when
FIPS is not enabled in IBM® WebSphere.

2. Log on to the BigFix® Remote Control Server with a valid admin ID and password.
3. Click Admin > Edit properties files

4. In the common. properti es file set FIPS.compliance to true.

5. Click Submit.

6. Click Admin > Reset Application.

Note: The FIPS enablement changes in WebSphere affect all other applications that are running on the server.
Therefore, browser settings for the users who access the other applications must be changed to support

Transport Layer Security (TLS), if required by their browser version.

For example, to enable TLS in Internet Explorer complete the following steps:

« Click Tools > Internet Options.

» On the Advanced tab, select Use TLS 1.0.
« Click Apply

« Click OK.

Enabling FIPS compliance on an automated server installation

Enable During Server Installation

To enable FIPS compliance on the BigFix® Remote Control Server, run the Remote Control Server
Installer and select Enable FIPS and Enable NIST SP800-131A in the Web server parameters panel.

Enable Manually

To enable FIPS compliance can be configured manually on the BigFix® Remote Control Server instead

of running the Remote Control Server Installer by following this procedure:

1. Editthe j ava. securi ty file that is found at the following directory.
Windows® systems
%TRC_SERVER_PATH%\ ] ava\jre\lib\security\]java. security

Where %TRC_SERVER_PATHY% is the path for the installation directory for the BigFix® Remote
Control Server.
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Linux® / UNIX® systems

STRC_SERVER_PATH/ j avaljrel/lib/security/java.security

Where STRC_SERVER_PATH is the path for the installation directory for the BigFix® Remote

Control Server.

2. Modify the security.provider.x= list so the following entry is the first one in the list:

security.provider.1=com.ibm.crypto.FIPS.provider.BMJCEFIPS

Fix the number sequence of the other items in this list so that all items are numbered in sequence.

For example:

> The full list after the changes when performed on a Remote Control server build 10.0.0.0808 or later is

as follows:

security. provider.
security. provider.
security. provider.
security. provider.
security. provider.
security. provider.
security. provider.
security. provider.
security. provider.
security. provider.

security. provider.

1=com i bm crypto. pl us. provi der. | BMICEPI usFI PS
2=com i bm j sse2. | BMISSEPr ovi der 2

3=com i bm crypto. pl us. provi der. | BMICEPI us
4=com i bm crypt o. provi der. | BMICE

5=com i bm security.]jgss.| BMIGSSProvi der

6=com i bm security.cert.|BMCertPath

7=com i bm security. sasl .| BVMSASL

8=com i bm xni . crypt o. | BUXMLCr ypt oPr ovi der
9=com i bm xni . enc. | BUXMLEncPr ovi der

10=com i bm security.jgss. nech. spnego. | BVSPNEGO

1l=sun. security. provider. Sun

o The full list after the changes when performed on a Remote Control server build 10.0.0.0807 or earlier

is as follows:

security. provider.
security. provider.
security. provider.
security. provider.
security. provider.
security. provider.
security. provider.
security. provider.
security. provider.
security. provider.

security. provider.

3. Add the following lines:

1=comibmfips.jsse. | BMISSEFI PS

2=com i bm crypto.fips. provider.| BMICEFI PS
3=com i bm j sse2. | BMISSEPr ovi der 2

4=com i bm crypt o. provi der. | BMICE

5=com i bm security.jgss.| BMIGSSProvi der

6=com i bm security.cert.|BMCertPath

7=com i bm security. sasl .| BMSASL

8=com i bm xni . crypt o. | BUXMLCr ypt oPr ovi der
9=com i bm xni . enc. | BUXMLEncPr ovi der

10=com i bm security.jgss. mech. spnego. | BVSPNEGO

11=sun. security. provider. Sun
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ssl . Socket Fact ory. provi der=com i bm j sse2. SSLSocket Fact oryl npl

ssl . Server Socket Fact ory. provi der=com i bm j sse2. SSLSer ver Socket Fact or yl npl

4. Save the file.
5. Edit thej vm opt i ons that are found in the following directory.

Windows® systems

%TRC_SERVER_PATH% \w p\usr\servers\trcserver\jvm options

Where %TRC_SERVER_PATHY% is the path for the installation directory for the BigFix® Remote
Control Server.

Linux® / UNIX® systems

STRC_SERVER_PATH/ Wl p/ usr/ servers/trcserver/jvm options

Where STRC_SERVER_PATH is the path for the installation directory for the BigFix® Remote
Control Server.

6. Add the following lines:
o Remote Control server build 10.0.0.0808 or later

-Dcom i bm j sse2. usefi psprovi der=true
-Dcom i bm j sse2. sp800-131=stri ct
-Dcom i bm j sse2. overri deDef aul t TLS=t r ue

-Dcom i bm j sse2. usefi psProvi der Nane=| BMICEPI usFl PS

o Remote Control server build 10.0.0.0807 or earlier

-Dcom i bm j sse2. usefi psprovi der=true
-Dcom i bm j sse2. sp800- 131=stri ct

-Dcom i bm j sse2. overri deDef aul t TLS=t r ue

7. Save the file.
8. Log on to the BigFix® Remote Control Server with a valid admin ID and password.
9. Click Admin > Edit properties files

10. Inthe conmon. pr operti es file set FIPS.compliance to true.

11. Click Submit.

12. Click Admin > Reset Application. Restart the server service.

13. Restart the server service.
Check to see whether the BigFix® Remote Control Server is configured for FIPS by completing the following step.
« Click Admin > View Current Server Status.

The following fields show that FIPS compliance is enabled.
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- Enabled FIPS mode: The value of this field is determined by the FIPS.compliance property in the
conmon. properti es file.

« JVM configured for FIPS: The value of this field is determined by the configuration of the JVM and the security
providers that are listed in the j ava. securi ty file.

Troubleshooting:

- Browser or Controller connection with the Remote Control server may fail

If the server is configured to operate in FIPS mode with the following
exception in the messages. | og filej ava. | ang. Nul | Poi nt er Except i on
com i bm ws. channel . ssl . i nt er nal . SSLConnect i onLi nk 238, Browser or Controller connection with

the Remote Control server might fail.

This is a side effect of the adoption of IBM Java 8.0.6.26. If the issue persists, do the following:
1. Stop the Remote Control Server.
2.0penthe..\TRC\java\jre\lib\security\java.security fileand add the

RSAPSS value as the last entry of the j dk. t1's. di sabl edAl gori t hns.

The updated property list must look as follows:

jdk.tls.disabl edAl gorithns=SSLv3, RC4, DES, Mbwi thRSA, DH keySi ze < 1024, DESede,

\ EC keySize < 224, 3DES_EDE CBC, anon, NULL, DES_CBC, RSAPSS

3. Start the Remote Control Server.

« The Join Broker Session operation may fail

When the secondary controller connects to the primary controller and the environment is
configured to operate in FIPS mode, the Join Broker Session operation may fail. The primary
controller may show an exception like the foll following exception in the nessages. | og file:

SEVERE - The connection was refused with pkt type [260]

This is a side effect of the adoption of IBM Java 8.0.6.26. If the issue persists, do the following:

Openthe..\controller\jrellib\security\java.security file and add the rsaPss value as the last

entry of the j dk. t1s. di sabl edAl gori t hns. The updated property list should look as follows:

jdk.tls.disabl edAl gorithnms=SSLv3, RC4, DES, MD5withRSA, DH keySize < 1024, DESede, \ EC

keySi ze < 224, 3DES EDE CBC, anon, NULL, DES CBC, RSAPSS

- The playback of a session recording via the Server Web Interface may fail to start with no error

message shown if the Server is Configured to operate in FIPS mode

This is a side effect of the adoption of IBM Java 8.0.6.26. If the issue persists, do the following:
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1. Save the TRCPI ayer . t r cj ws file as provided by the server.
2. Edit the File and remove the line <ar gunent >- - f or cef i ps</ ar gunent >

3. Save the file and execute the TRCPI ayer . t r cj ws file by clicking on it.

Enabling FIPS compliance on the controller

The Remote Control controller is a Java™ application that requires a FIPS certified cryptographic provider when FIPS
compliance is enabled. In FIPS-compliant mode the Remote Control controller supports the BC-FJA (Bouncy Castle
FIPS Java API) with the IBM Semeru Runtime Open Edition JRE on Windows, Linux and MacOS.

Starting from Remote Control Version 10.0 0 Update 6 (Build number 0612 or higher), the controller installation
packages include the BC-FJA (Bouncy Castle FIPS Java API) FIPS certified cryptographic provider with the IBM®
Semeru Runtime Open Edition JRE. When the controller is started from the Server Managed on OnDemand mode the

FIPS compliance is controlled by a setting in the . t r ¢j ws start file.
Note: Only required if you are running the controller locally for establishing peer-to-peer sessions.

To set FIPS compliance on the Controller when operating in peer to peer mode update the local configuration as
follows:

Editthetrc_control | er. cf g file on the system that the controller is installed on.

Windows® systems

[controller install dir]J\trc_controller.cfg

Where [controller install dir] is the installation directory that is chosen when you install the
controller.

Linux® / UNIX® systems

/opt/bigfix/trc/controller/trc_controller.cfg
Set the fips.compliance property to True and save the file.

Check to see whether the controller is configured for FIPS by completing the following step during a remote control
session.

« Click Controller tools > Show session information in the controller window.

Enable FIPS compliance on the target

The Remote Control target includes FIPS-capable OpenSSL libraries. You can enable FIPS compliance at installation

time or by editing the target registry on a Windows® system or by changing the configuration file on a Linux® system.
For more information about installing the target, see the BigFix® Remote Control Installation Guide.

Using the target user interface, choose the appropriate option to verify that the target is in FIPS mode.
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- On the Remote Control- Target user interface, click Actions Menu > Connection info

» Hover the mouse over the Remote Control icon in the system notification area.

Enabling FIPS compliance on a Windows™ target

On a Windows™ system, you can enable FIPS compliance on the target in two ways; during installation or by editing

the target registry after installation.

Enabling FIPS compliance by using the target installer

Enable the FIPS compliance target property during installation by completing the following steps:

1. On the Server Address panel of the target installer, click Advanced settings.
2. Select Use a FIPS certified cryptographic provider and Use secure connections (https). Continue with the rest

of the target installation.

Performing a silent installation

When performing a silent target installation, run the installation command and use the FIPSCOMPLIANCE property
to enable FIPS on the target . For more details of performing a silent installation, see Running a target custom

installation on a Windows system (on page 78).

Use the following properties when enabling FIPS mode

» TRC_SERVER_PROTOCOL=https
* TRC_SERVER_PORT=443
» FIPSCOMPLIANCE=yes

For example : trc_target_setup.exe /s /v"/qn TRC_SERVER_HOSTNAME=yourserver TRC_SERVER_PROTOCOL=https
TRC_SERVER_PORT=443 FIPSCOMPLIANCE=yes"

where yourserver is the hostname or IP address of your BigFix® Remote Control Server.

Enabling FIPS compliance after target installation

After you install the Remote Control target, you can enable FIPS compliance by editing the target registry. To enable

FIPS compliance, complete the following steps.

. Run the regedit command at a command prompt window.

. In the Windows™ registry, go to HKEY_LOCAL_NMACHI NE\ SOFTWARE\ Bi gFi x\ Renpt e Control \ Tar get
. Right-click FIPSCompliance and select Modify.

. Type yes in the Value data field and click OK.

a A WO N =

. Restart the target service.
For more information about restarting the target service, see Manage the component services (on page 7109).

Follow the steps in the section that is relevant to your operating system.
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Enabling FIPS compliance in Linux® or UNIX® based operating systems

After you install the Remote Control target, you can enable FIPS compliance by editing the

trc_target. properties file. To enable FIPS compliance, complete the following steps:

1. Editthe /etc/trc_target. properti es file.
2. Set the value of FIPSCompliance to yes and save the file.
3. Restart the target service.
For more information about restarting the target service, see Manage the component services (on page 709).

Follow the steps in the section that is relevant to your operating system.

Enabling FIPS compliance on the gateway

You can enable FIPS compliance on the gateway component by editing the gateway configuration file that is created
when you install gateway support.
Thetrc_gat eway. properti es file is in the following directory.
Windows™ systems
\ Docunents and Settings\All Users\Application Data\Bi gFi x\ Renote Contr ol
\ Gat eway
or\ ProgranDat a\ Bi gFi x\ Renot e Contr ol \ Gat eway.
Linux™ systems
letc

To enable FIPS compliance, complete the following steps.

1. Editthetrc_gat eway. properti es file.
2. Set FIPSCompliance = Yes.
3. Save the file.
4. Restart the gateway service.
For more information about restarting the gateway service, see Manage the component services (on page

109). Follow the steps in the section that is relevant to your operating system.

Enabling FIPS compliance on the broker
You can enable FIPS compliance on the broker component by editing the broker configuration file that is created
when you install broker support.
Thetrc_broker. properti es fileis in the following directory.
Windows® systems

\ Docunents and Settings\All Users\Application Data\Bi gFi x\ Renote Contr ol
\ br oker.
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or\ Progr anDat a\ Bi gFi x\ Renot e Control \ br oker.
Linux® systems
letc

To enable FIPS compliance, complete the following steps.

1. Editthetrc_broker. properti es file.
2. Set FIPSCompliance = Yes.
3. Save the file.
4. Restart the broker service.
For more information about restarting the broker service, see Manage the component services (on page 109).

Follow the steps in the section that is relevant to your operating system.



Chapter 12. NIST SP800-131A compliance in Remote
Control

Remote Control version 10.0.0 components can be configured for NIST SP800-131A compliance.

The National Institute of Standards and Technology (NIST) Special Publications (SP) 800-131A standard strengthens

algorithms and increases the cryptographic key lengths to improve security.

The following prerequisites are required:

« Ensure that all keys have at least a key security strength greater than or equal to 112 bits. RSA keys must be at
least 2048 bits.

- Ensure that all certificates are created with the new key strengths. Any RSA certificates that use keys shorter
than 2048 bits must be replaced with a certificate that uses 2048-bit keys or higher.

« Ensure that all certificates are signed by an allowed signature algorithm of minimum SHA-2.

When you enable NIST SP800-131A compliance, the TLSv1.2 protocol is used for providing secure connections.

Therefore, you must ensure that your browser is compatible.

Table 18. Browser compatibility for TLSv1.2
The following table provides information about the supported browser versions that are compatible with TLSv1.2.

TLSv1.2 supported but TLSv1.2 supported
TLSv1.2 not supported disabled but default and enabled by default
Internet All versions of IE on Windows™ XP and Win- IES, IE9, IE10 on Windows™ 7 IET1 on Windows™ 7
Explor- dows™ Vista operating systems (IE6, IE7,IE8,  and Windows™ 8 operating sys- operating system and
er IE9) tem. later
Firefox <24 24 >24

Compliance with NIST SP800-131A also requires that the cryptographic provider is FIPS 140-2 certified. When
SP800-131A compliance is enabled, FIPS 140-2 compliance is enabled automatically, even when it is disabled in the

settings.
For NIST SP800-131A compliance, you must configure all your components. There is no compatibility with earlier

versions of the components.

Note: There is no support for NIST SP800-131A with Oracle JVMs. Therefore, to take advantage of the NIST
support, you must install the stand-alone controller component.

Enable NIST SP800-131A compliance on the server

You can enable NIST SP800-131A compliance on the Remote Control server during installation, when you are using
the server installer program. You can also enable NIST compliance after installation. To enable NIST SP800-131A
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compliance for a manual BigFix® Remote Control Server installation, you must configure theBigFix® Remote Control
Server and WebSphere®.

Enabling NIST SP800-131A compliance during the server installation

To enable NIST SP800-131A compliance during installation, follow the instructions in Installing by using the server
installer (on page 36). Select Enable NIST SP800-131A compliance (Enables FIPS) on the Web server parameters
pane during the installation.

Enabling NIST SP800-131A compliance on a server with a stand-alone WebSphere
Application Server

The BigFix® Remote Control Server uses the middleware infrastructure that is provided by WebSphere® secure HTTP
communications. Therefore, to enable NIST SP800-131A compliance for a manual BigFix® Remote Control Server
installation you must configure BigFix® Remote Control Server and WebSphere®.

To enable NIST SP800-131A compliance for a manual server installation, complete the following steps after you
install the server.

1. Configure WebSphere

Refer to the IBM WebSphere® documentation on how to enable NIST SP800-131A in WebSphere®. Follow the

instructions relevant to your version of WebSphere®.

. Log on to the BigFix® Remote Control Server with a valid admin ID and password.
. Click Admin > Edit properties files

. Inthe conmon. properti es file set sp800131a.compliance to true.

. Click Submit.

. Click Admin > Reset Application.

N o o0 b WODN

. Restart the server service.
For more information about restarting the server service, see Manage the component services (on page 109).

Follow the steps in the section that is relevant to your operating system.

Note: NIST SP800-131A enablement changes in WebSphere® affect all other applications that are running on
that server. Therefore, browser settings for the users who access those other applications must be changed

to support Transport Layer Security (TLS).

To enable TLS in Internet Explorer, complete the following steps.

« Click Tools > Internet Options.

» On the Advanced tab, select Use TLS 1.2.
« Click Apply.

« Click OK.

To enable TLS in Firefox, complete the following steps.
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- In the browser, go to the about:config page.
4 « Click I'll be careful, | promise.
« In the search field search for security.tls.version.max.
« Set the value to 3.

Enabling NIST SP800-131A compliance after you install the server

After you install the server by using the installer program, you can enable NIST SP800-131A compliance in a number

of ways.

However, if you did not already enable FIPS you must enable if first. For more information about enabling FIPS after

you install the server, see Enabling FIPS compliance on an automated server installation (on page 130).

You must also make sure that the server certificate is compliant by ensuring that you follow the prerequisites for NIST
support. For more information about certificate prerequisites, see NIST SP800-131A compliance in Remote Control
(on page 138).

To enable NIST SP800-131A compliance after an automated BigFix® Remote Control Server installation, complete

the following steps.

1. Choose the appropriate method for enabling the NIST configuration.
Option 1

a. Go to the tools directory that is in the server installation directory.
b. Editthetrcset up. cnd ort rcset up. sh file, depending on your operating system.
c. In the line that calls the ss| . cnd or ssl . sh file, change the 0 that is before trcto a 1.

Change the 0 that is at the end of the command to a 1 also. For example,

The command before the change is,

...\tools\ssl.cmd" "C:\Program Fil es (x86)\Bi gFi x\ TRC\ server"
10 "C\" "9%CERTSTOREPWA "servernane.|localnet” 0 trc

" CERSTOREPWSELF% "TrC' " 0"

The command after the change is,

...\tools\ssl.cmd" "C \Program Fil es (x86)\Bi gFi x\ TRC\ server"
10 "C\" "9%CERTSTOREPWA "servernane.localnet” 1 trc

" UCERSTOREPWSELF% "TrC' " 1"

. Save the file.

. In the same directory, edit t nem sh ort nem cnu, depending on your operating system.
. Set the value of NIST800=1. Set the value of FIPSON=1 if it is not already set.

. Run the following command.

Q@ —+« 0o o
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trcsetup userid password certpassword

Where userid and password are the database connection credentials and certpassword is

your certificate file password.

Note: Derby does not have database credentials, therefore use useri d and
passwor d for the credentials. Type the following command when you are using

Derby.

trcsetup userid password certpassword

Option 2 - Temporary NIST configuration

Note: The configuration changes set in this option are overwritten if you run the

trcset up or t nremfiles again.

a. Editthe ssl . xml filethatisinthe[instal I dir]\w p\usr\servers\trcserver

directory.

Where
[installdir]
Is the server installation directory.

b. Add ssIProtocol="TLSv1.2" to the line ssl id="defaultSSLConfig". For example,

<server>
<ssl id="defaul t SSLConfig" ssl Protocol ="TLSv1. 2"
/>

<keystore id="defaul t KeyStore" password="Tr C\ebAS"
/>

</ server>

c. Save the ssl . xni file.

d. In the same directory, edit the j vm opt i ons file.

e. Add the lines, -Dcom.ibm.jsse2.sp800-131=strict and -
Dcom.ibm.jsse2.overrideDefaultTLS=true.

f. Save the file.

2. Log on to the BigFix® Remote Control Server with a valid admin ID and password.
3. Click Admin > Edit properties files

4. In the common. properti es file, set sp800131a.compliance to true.

5. Click Submit.
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6. Click Admin > Reset Application. Restart the server service.
For more information about restarting the server service, see Manage the component services (on page 109).
Follow the steps in the section that is relevant to your operating system.

Check to see whether the BigFix® Remote Control Server is configured for NIST SP800-131A by completing the

following step.
« Click Admin > View Current Server Status.
The following fields show that NIST SP800-131A compliance is enabled.

» Enabled NIST SP800-131A mode
« JVM configured for NIST SP800-131A mode

Creating a certificate for an MS SQL database when NIST
SP800-131Ais enabled

When you enable NIST SP800-131A compliance and you are using an MS SQL database, you must create a

certificate.

To generate the certificate, you can use the IBM® Key Management tool. You can access the IBM® Key Management
tool if the Remote Control server is installed with embedded components and also if the controller component is

installed. It is also provided by IBM® WebSphere® Application Server.

Note: To create a certificate with 4096 key size or greater, you must overwrite the restriction policy files
| ocal _policy.jar and US_export_policy.jar.
Go to the following directory and copy the | ocal _policy.jar and US_export_policy.j ar files.
Windows™ systems
TRC\ server\java\deno\jce\policy-files\unrestricted
Linux™ systems

TRC/ server/javal deno/jcel/ policy-files/unrestricted

Replace the following files with the JAR files that you copied.
Windows™ systems

TRC\ server\java\jre\lib\security\local policy.jar

TRC\ server\java\jre\lib\security\US export_policy.jar
Linux™ systems

TRC/ server/javaljre/lib/security/local _policy.jar

TRC/ server/javaljre/lib/security/US export_policy.jar
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To create and install the certificate, complete the following steps:

1. Install one of the supported versions of MS SQL server and the latest patches. Minimum requirement is MS
SQL Server 2012 Service Pack 3.

2. Create a keystore with a self-signed certificate.
a. Open a command line window.

b. Go to one of the following directories to run the keytool.
Remote control server that is installed with embedded components
Go to the Remote Control server installation directory.
WebSphere® Application Server is installed
Go to the WebSphere® Application Server installation directory.
The controller component is installed
Gotothe...\Controller\jre directory. For example,
Windows™ systems.
C:\ Program Fi | es\ Bi gFi x\ Renote Control\Controller\jre
Linux™ systems.

/opt/bigfix/trc/controller/jre
c. Change to the bi n directory.

d. Run the i keynan file relevant to your operating system.
Windows™ systems
i keyman. bat
Linux™ systems

i keyman. sh
e. Select Key Database File > New
f. Select PKCS12 for Key database type.
g. Click Browse and go to the location in which you want to store the keystore.
h. Type a file name for your file and click Save.

i. Click OK.

j. Enter and confirm a password to protect the keystore and click OK.

k. Select Create > New Self-Signed Certificate

. Enter a name for the Key Label.
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For example, the host name of the server.
m. Select X509 V3 for the Version.

n. Select a Key Size value.
Recommended value for NIST SP800-131A compliance is 2048 or greater.

0. Select SHA256WithRSA for the Signature Algorithm

p. Type a Common Name.
Set to the DNS host name of your server.

For example, trcserver. exanpl e. com

g. Enter any additional optional information as required.

=

. Enter a Validity Period.
Set the number of days that the certificate is valid for. Default is 365 days.

s. Set the Subject Alternative Names, DNS Name option to the DNS host name of your server.
t. Click OK.

3. Add the certificate store to the database server.
a. At a command line, run rmt. exe.

b. Add a certificate snap-in.
i. Select File > Add/Remove Snap-in.
ii. Select the Certificates snap-in and click Add.
iii. Select Computer account and click Next.
iv. Ensure that the Local computer option is selected and click Finish.
v. Click OK.

c. Import the certificate
i. In the Console1 window, go to Console Root > Certificates.
ii. Right click Certificates and select All Tasks > Import.
iii. Click Next on the Welcome window.
iv. Click Browse and select the certificate store that you created.
v. Click Next.
vi. Enter the password for the certificate store and click Next.
vii. Ensure that Place all certificated in the follolwing store is selected and that Certificate Store
is set to Personal. Click Next.
viii. Click Finish.

4. Manage private keys.
a. Right-click the certificate file and select All Tasks > Manage Private Keys.
b. Click Add.
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c. Click Check Names, select MSSQLSERVER and click OK.
d. Click OK on the Select Users and Groups window.
e. Set permissions for MSSQLSERVER on the Permissions window and click OK. For example, select
Allow for Read for a Read-only option.
5. To complete the configuration, run the SQL Server Configuration Manager.
a. Expand SQL Server Network Configuration.
b. Right click Protocols for MSSQLSERVER and select Properties.
c. On the Certificates tab, select your imported certificate.
d. On the Flags tab set Force Encryption to Yes and click OK.
e. Click OK on the Warning window.
f. Select SQL Server Services.
g. Right-click SQL Server (MSSQLSERVER) > Restart in the right pane.

Enabling NIST SP800-131A compliance on the controller

The IBM® JRE for Windows® operating system and Linux® (Intel®) operating systems is included with Remote
Control and is installed when you install the controller software.

If you are using a Windows® system, the JRE is included in the controller packaget rc_control | er _set up. exe
andtrc_control | er. nsi.ForLinux® systems, the JRE is included in the packagetrc-control | er-
jre-10.x. x.i386.rpm Where 10.x.x is the version that you want to install. The packages install the IBM® Java™
Run-time Environment preconfigured with the IBM® FIPS certified cryptographic provider and NIST SP800-131A
enabled. The packages also register the MIME type appl i cati on/ x-trc-j ws and a file association for *. t r cj ws

files.

To check whether the controller is connected in FIPS or NIST SP800-131A mode during a remote control session,
click Controller tools > Show session information. Encryption is set to AES FIPS when FIPS mode is enabled and is
set to TLSv1.2 when NIST mode is enabled.

Enabling NIST SP800-131A compliance in the stand-alone controller
After you install the stand-alone controller, you can edit the properties file to enable NIST SP800-131A compliance.
If you install the controller component locally to start peer to peer remote control sessions, you must edit the

trc_controll er. cf g fileto enable NIST SP800-131A compliance. To enable NIST SP800-131A compliance,
complete the following steps.

1. Editthetrc_control | er. cf g file on the system that the controller is installed on.
Windows® systems
[controller install dir]\trc_controller.cfg
Where [controller install dir] is the installation directory you chose when you installed the
controller.

Linux® systems
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opt/Bigfix/trc/controller/trc_controller.cfg

2. Set sp800131a.compliance to true.
3. Save the file.

Enable NIST SP800-131A compliance on the target

You can enable NIST SP800-131A compliance on the Remote Control target in various ways. NIST SP800-131A
compliance can be enabled during installation when you are using the target installation program. You can enable
NIST SP800-131A compliance after the installation by editing the target registry on Windows® systems, or by editing
the configuration file on Linux® systems.

Using the target user interface, choose the appropriate option to verify that NIST SP800-131A compliance is enabled

on the target.

- On the Remote Control- Target user interface, click Actions Menu > Connection info.
« Hover the mouse over the Remote Control icon in the system notification area.

Enabling NIST SP800-131A compliance in a Windows® target

When you are using a Windows operating system, you can enable NIST SP800-131A compliance on the target in two

ways. You can enable compliance during installation or by editing the target registry after installation.

Enabling NIST SP800-131A compliance during the target installation

To enable the NIST SP800-131A compliance target property during installation, follow the instructions in Install the
target (on page 55). On the Server Address screen of the target installer, click Advanced settings. Select Enable NIST
SP800-131A compliance (Enables FIPS).

Enabling NIST SP800-131A compliance during silent installation of the target

To enable NIST SP800-131A compliance during a silent installation of the target, you can use the SP800131A
parameter in the installation command. For more information about a target silent installation, see Running a target

custom installation on a Windows system (on page 78).

Use the following parameters to enable NIST SP800-131A compliance.

» TRC_SERVER_PROTOCOL=https
* TRC_SERVER_PORT=443
» SP800131A=yes

For example, trc_target_setup.exe /s /v"/gn TRC _SERVER HOSTNAME=your server TRC_SERVER PROTOCOL=htt ps

TRC_SERVER PORT=443 SP800131A=yes"”

Where yourserver is the host name or IP address of your BigFix® Remote Control Server.
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Enabling NIST SP800-131A compliance after target installation

After you install the Remote Control target, you can enable NIST SP800-131A compliance by editing the target
registry. To enable NIST SP800-131A compliance, complete the following steps.

1. Run the regedit command at a command prompt window.
2. In the Windows™ registry, go to HKEY_LOCAL_MACHI NE\ SOFTWARE\ Bi gFi x\ Renpt e Control \ Tar get
On a 64-bit system, the 32-bit registry keys are under the WOW6432Node key.
For example, HKEY LOCAL_MACHI NE\ SOFTWARE\ WOW6432Node\ Bi gFi x\ Renpt e Control \ Tar get.
3. Right-click SP800131ACompliance and select Modify.
4. Type yes in the Value data field and click OK.
5. Restart the target service.
For more information about restarting the target service, see Manage the component services (on page 7109).

Follow the steps in the section that is relevant to your operating system.

Enabling NIST SP800-131A compliance on Linux® or UNIX® based targets

After you install the Remote Control target, you can enable NIST SP800-131A compliance by editing the
trc_target. properti es file. To enable NIST SP800-131A compliance, complete the following steps.

1. Editthe/etc/trc_target. properties file.

2. Set the value of SP800737ACompliance to yes and save the file.

3. Restart the target service.
For more information about restarting the target service, see Manage the component services (on page 709).
Follow the steps in the section that is relevant to your operating system.

Enabling NIST SP800-131A compliance on the gateway
You can enable NIST SP800-131A compliance on the gateway component by editing the gateway configuration file
that is created when you install gateway support.
Thetrc_gat eway. properti es file is in the following directory.
Windows™ systems
\ Docunents and Settings\All Users\Application Data\Bi gFi x\ Renote Contr ol
\ Gat eway
or\ ProgranDat a\ Bi gFi x\ Renot e Contr ol \ Gat eway.
Linux™ systems
letc

To enable NIST SP800-131A compliance, complete the following steps.

1. Editthetrc_gat eway. properti es file.
2. Set SP800131ACompliance = Yes.
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3. Save thefile.

4. Restart the gateway service.
For more information about restarting the gateway service, see Manage the component services (on page
109). Follow the steps in the section that is relevant to your operating system.

Enabling NIST SP800-131A compliance on the broker

You can enable NIST SP800-131A compliance on the broker component by editing the broker configuration file that is
created when you install broker support.
Thetrc_broker. properti es fileis in the following directory.
Windows® systems
\ Docunents and Settings\Al|l Users\Application Data\Bi gFi x\ Renote Control
\ br oker
or\ Progr anDat a\ Bi gFi x\ Renote Control \ br oker.
Linux® systems
letc

To enable NIST SP800-131A compliance, complete the following steps.

1. Editthetrc_broker. properti es file.

2. Set SP800131ACompliance = Yes.

3. Save thefile.

4. Restart the broker service.
For more information about restarting the broker service, see Manage the component services (on page 109).
Follow the steps in the section that is relevant to your operating system.

Enabling NIST SP800-131A compliance on the CLI tools

NIST SP800-131A compliance can be enabled during installation when you are installing the CLI tools on a Windows
operating system. You can enable NIST SP800-131A after you install the CLI tools in Linux by editing the configuration
file.

Enabling NIST SP800-131A compliance when you install the Windows cli tools

To enable NIST SP800-131A compliance during the installation of the command line interface tools, follow the
instruction in Installing the cli tools on a Windows system (on page 90). Click Advanced settings on the Server
Address screen, and select Enable NIST SP800-131A compliance (Enables FIPS) during the installation.
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Enabling NIST SP800-131A compliance on the cli on Linux® or UNIX® based
targets

After you install the cli tools, you can enable NIST SP800-131A compliance by editing the
trc_target. properties file. To enable NIST SP800-131A compliance, complete the following steps.

1. Editthe/etc/trc_target. properti es file.
2. Set the value of SP800737ACompliance to yes.
3. Save the file.



Chapter 13. Verifying the server installation

When you complete the server installation, you can verify it by completing the following steps:

1. In a browser window, type the address of the Remote Control server. For example,htt p: // your ser ver name/ trc
where yourservername is the host name or IP address of your Remote Control server.

2. Verify that the Remote Control logon screen is displayed.

3. Log on with the following admin ID and password - id=admin, password=password.

4. At the change details screen, change the password by following the instructions that are given.



Chapter 14. Recover from installation errors

If you experience installation errors, use the following chapters to identify the problem and address it.

Recovery steps

Use the following information as a starting point to find log files and other information to help you recover from
installation errors.

If you must contact HCL Software Support, gather the following information.

« If you are using a Windows™ operating system, any event log that is relevant to the installation error.
« The installation log files.

 Operating system version, including any service packs.

 The version of the WebSphere® Application Server, database server, and Java™.

- Hardware description.

« Installation media type.

- Windows™ services that were active during the unsuccessful installation. For example, antivirus software.

The following files can also be used to gather information about any errors that might occur.

\'tsetup.ini

Contains some basic information, logged during an automated installation.

—

installdir]\install.log

Contains internal debug messages.

—

installdir]\inst.ini

Contains all parameters about the installation.

—

installdir]\w p\usr\server\trcserver

Contains configuration xml files.

—

installdir]\w p\usr\server\trcserver\|l ogs\ nessages. | og

—

installdir]\w p\usr\server\trcserver\l ogs\ nessages_xxxxxxx. | og

—

installdir]\w p\usr\server\trcserver\logs\ffdc directory

Errors during installation

The following topics describe recovery actions for errors that might occur during the Remote Control server
installation when you use the server installer program.

Not enough memory

Symptom
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Memory error reported during the installation and the installation does not continue.

Cause
The memory check at the beginning of the installation determines that the computer that you are
installing on does not have the required minimum memory for installation.

Solution

For more information about the requirements for memory, see Server requirements (on page 16) .

DB2® connection error when database options are verified

Symptom
DB2® database connection error reported during installation.

Causes

During the installation if you select DB2® as the database, the installer verifies the information that
is given in the database options screen. The user ID, password, and port values are used to establish
a connection to the database. If a connection is not successful, an error is reported. This error also

contains the error reported by DB2®.

Solution

This error can be reported for any of the following reasons.

* Incorrect values are entered in the database options screen. Go back to the previous screen and

verify the information.

- There is no database instance present. If you are planning to use DB2®, it must be installed
before the Remote Control server. A database instance must also be created.

« Cannot connect to the remote database. If you are using a remote database, verify that you can

ping the IP address of the remote system.

Oracle pre-checks
Symptom
Oracle database connection error reported during installation.

Cause

During the installation if you select Oracle as the database, the installer verifies the information that is
given in the database options screen by connecting to the database. If the connection fails, an error is

reported. The error message contains the error that is returned from Oracle.

Solution
Go back to the previous screen and use the information that is given to correct the problem.

For example: If the Oracle database is not created before the installation, the following error is reported.
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Failed to verify userid, password, server, database and driver
file conbination supplied.Please verify details and try again.

( Listener refused the connection with the followi ng error:
ORA- 12505. TNS: | i stener does not currently know of SID given in
connect descri ptor
The Connection descriptor used by the client was:

127.0. 0. 1: 1521: TRCDB

In this case, you must cancel the installation and create the Oracle database before you install Remote

Control again.

libstdc++.s0.5 error when installing the server using the installation program
Symptoms
The server installation aborts with the following exception error in Linux®.

This application has unexpectedly quit:Invocation of this Java application has caused an

I nvocati onTar get Exception. This application will now exit".

The installation log may show the following error

java.l ang. unsati sfiedlinkerror :fontmnager (libstdc++. so.5: can not open shared object file:No

such file or directory)
Causes

Missing package required.
Solution

Install the libstdc++.s0.5 package. This can be installed by installing the compat-libstdc++-33 package
which includes libstdc++.s0.5.

Errors after installation

When the installation of Remote Control is complete and the application service starts, you can log on. If you cannot

log on successfully, use the following information to resolve the problem.

» Check that the server service is running.
Windows™ systems

In Windows™ services, check that the following service is started

Remote Control-Server.

Linux™ systems
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The following service is created / et c/init.d/ trcserver or/etc/rc.d/init.d/
trcserver and started.

Note: To manually stop or start the server type the following command.

letc/init.d/trcserver [paranmeter] Where parameter is stop, start, or restart.

e Check the log filesinthe[instal I dir]\w p\usr\server\trcserver\| ogs directory for any reported
errors. You can also check the t r c. | og file in the server installation directory.

- If you are using an Oracle database, check that the user ASSET exists.

Out of memory error
Symptom

Out of memory errors are reported in the log files when the BigFix® Remote Control Server is started.

Failed to instantiate heap is reported in them.

Causes

There is not enough memory available to run the application. The reason for the error is that the
maximum memory that is allocated to the heap is too high, and can be affected by other applications
that are running or installed.

During installation, the installer attempts to set up the Remote Control application to use up to 70% of
available RAM. The percentage is lowered if a Java virtual machine™ (JVM) cannot be started. However,

if other software is installed, an out of memory error might also be reported in the Remote Control log
files.

Solution

The solution to this problem is to use a supplied script to manually set the memory parameters to a
lower value. This script, can be found in the Remote Control installation directory. Use the script to set
the memory parameters and the number of threads and web connections.

 tmem cmd - for Windows® systems.
« tmem sh - for UNIX based systems.

Run the following command from the Remote Control installation directory:

tmem cmd i nnmem naxmem

Note: Use tmem.sh for UNIX based systems.

minmem; maxmem

Sets the minimum and maximum memory to be allocated.
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Note: The 32-bit Java that is supplied in 32-bit eWAS can use a maximum of 2.7

GB only, no matter how much RAM is available.

You can also use the tmem.cmd and tmem.sh command to adjust the following parameters.
maxwebconn
Sets the number of web connections allowed. The default is 85 and can increase to 175.
maxthreads; minthreads
Sets the minimum and maximum threads allowed. Maximum threads are 50, increasing to

150.

To edit these parameters in version 10.x.x, complete the following steps:

1. Edittrcsetup. cnd ortrcset up. sh.
2. Edit the line that contains the call to the nenory. cnd file. For example, C: \ TRC\ ser ver
\tool s\nmenory. cnd 163 49 135 1

Where
- maxwebconn = parameter 1 (163)
o minthreads = parameter 2 (49)
- maxthreads = parameter 3 (135)

Do not edit parameter 4. Keep the value 1.

3. Change the required values.
4. Save thet rcset up file.

5. Type the following command.
trcsetup userid password certpassword
Where userid and password are the database connection credentials and certpassword is your
certificate file password.
Note: Derby does not have database credentials, therefore use user ID and password for

the credentials. Type the following command when you are using Derby:

trcsetup userid password certpassword

Database connection authorization failure

Symptom
A database connection authorization failure error is reported in the log files.

Causes
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The database password might be invalid.

Solution

Change the password by running the following command from the Remote Control installation directory:

Windows® systems.
[installdir]\tool s\tdbpasswd. cnd userid password. Where installdir is the Remote Control
installation directory and userid and password are the database logon credentials.

UNIX based systems.
[installdir]/tools/tdbpasswd. sh userid password. Where installdir is the Remote Control

installation directory and userid and password are the database logon credentials.

Run the command to change the database password for the application. Restart the Remote Control

service after you run the command.

Application welcome page does not display

Symptom
The Remote Control server welcome page does not appear when you type in the Remote Control server
URL in your browser.

Cause

The issue can occur for a number of reasons, which are reported in the log files.

Solution

Look through the i nst al | . | og file in the server installation directory, for any reported errors.

DB2® connection error when database options are verified

Symptom
DB2® database connection error reported during installation.

Causes

During the installation if you select DB2® as the database, the installer verifies the information that
is given in the database options screen. The user ID, password, and port values are used to establish
a connection to the database. If a connection is not successful, an error is reported. This error also

contains the error reported by DB2®.

Solution

This error can be reported for any of the following reasons.
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* Incorrect values are entered in the database options screen. Go back to the previous screen and
verify the information.

- There is no database instance present. If you are planning to use DB2®, it must be installed
before the Remote Control server. A database instance must also be created.

- Cannot connect to the remote database. If you are using a remote database, verify that you can

ping the IP address of the remote system.

Targets cannot contact the server

Symptom

Targets are not registering or updating their details on the BigFix® Remote Control Server.

Causes
- The target does not have the correct URL for the server.
 The host name part of the URL, that is used to contact the server, does not match the common
name in the server's SSL certificate.
Solution

When you install the target software the target contacts the server by using http or https, and the server
URL that is defined during the installation of the target. However, there are two important things to note

to ensure that the connection between the server and target is successful.

« The target must have the correct URL for the server.

 The host name part of the URL must match the common name in the server's SSL certificate.

When the BigFix® Remote Control Server is installed with the installation program, you must ensure
that you supply the correct values in the Web server parameters window. By default, the upload data to
server field is populated with the computer name from the Windows® operating system settings. The
server installer program uses the field value to generate the server URL. The URL is then saved in the
trc. properti es file in the url property and is also saved in the SSL certificate. Therefore, make sure
that you specify the correct computer name during the installation. If you specify an incorrect value, the
following problem might occur.

When a target contacts the server for the first time, it uses the ServerURL property from the target
registry or configuration file to contact the server. When the server responds to the target, it includes
the server address that is assigned to the url property inthe t r c. properti es file. The target uses
this URL to contact the server. If the address that is sent to the target is incorrect, the target can register
once and then is not able to contact the server again. After a while, the target is marked as being offline.
You are also unable to start sessions with this target, because the target does not have a correct

working URL with which to authenticate an incoming session.

The common name that is in the server's SSL certificate must be a host name that resolves to the

IP address of the server. If the SSL certificate has, for example, mytrcserver, but on the target there
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is no way to translate mytrcserver to the IP address of the server, your environment is not correctly
configured. The only names that are correctly supported are fully qualified domain names that are
registered in the DNS. For example, mytrcserver.example.ibm.com. To use only mytrcserver, the server
and target must be on the same local network and have WINS configured.

You can check that the DNS server is properly configured by using the nslookup command to query the
full computer name and IP address.

For example: At a command prompt type, the following commands.

C:\ >nsl ookup

Default Server: dns.exanple.ibmcom

Address: 192.0.2.0

Type in the hostnane of your server

> mytrcserver. exanpl e.i bm com
Server: dns. exanpl e.i bm com

Address: 192.0.2.0

Nane: nytrcserver. exanpl e.i bm com

Address: 192.0.2.1

Type in the ip address of your server

> 192.0.2.1
Server: dns. exanpl e.ibmcom

Address: 192.0.2.0

Nane: nytrcserver. exanpl e.i bm com

Address: 192.0.2.1

you can see that the server host name resolves to the correct IP address.

Errors when you use Oracle as the database

Symptom

java.l ang. Arrayl ndexQut Of BoundsExcept i on error reported when you use an Oracle database.
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Cause
There is a problem with the Oracle jdbc drivers.
Solution

Choose the appropriate option to resolve the problem.

* Use the Oracle 10.2g JDBC 4 drivers. The drivers work with oracle 9, 10 and 11.
- If you are using the Oracle 11g drivers, manually edit the t r c. pr operti es file and set the

following property oracle.increment.keys.off=1.

Note: Restart the server service.

Errors when trying to connect to the Microsoft® SQL database in FIPS compliancy
mode

Symptom
Errors when trying to connect to the Microsoft® SQL database in FIPS compliancy mode
Cause

Using the IBM® JRE and the IBM® JSSE provider and Websphere Application Server, which has been
enabled for FIPS compliancy currently, does not work when using an MS SQL database.

Solution

These options only work with MS SQL when FIPS is not enabled in IBM® Websphere.



Chapter 15. Uninstall the components

After you install the various Remote Control components, you can uninstall them in various ways.

Uninstall the server

To remove the Remote Control server, the method you choose depends on the type of installation that was run. If
you installed the server by using the Remote Control installation program, you can uninstall the software by using the
installer or by using Add or Remove programs. If you ran a manual installation of BigFix® Remote Control Server, you

must uninstall the software by using the IBM® WebSphere Application Server administration console.

Uninstalling the server by using the installer

Use the following procedure to uninstall the Remote Control server software if you are using a Windows® operating

system or a Linux® operating system.

To uninstall the Remote Control server by using the installer, complete the following steps :

1. Navigate to the Remote Control server installation directory.

The default directory or the specific directory that you chose when you installed the server. For example,

Windows® systems

\ Program Fi | es\ Bi gFi x\ TRC\ server

Linux® systems

/ opt / Bi gFi x/ Ti vol i / TRC/ server

2. Double click Uninstall Remote Control - Server.exe
3. Click Uninstall.
4. Click Done when finished.

The Remote Control features, files, and folders that were created by the installer are removed.

Uninstalling the server application in IBM® Websphere Application Server

If you have performed a manual installation of the BigFix® Remote Control Server software, you can uninstall the

software using the IBM® Websphere Application Server administration console by completing the following steps:

To access the Administrative Console complete the following steps:

1. In your browser type

https://[server : port]/ibm console
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where server is the ipaddress or name for the application server machine for example localhost or 192.0.2.0

and port is the port that the server is listening on.

. Logon with the ID and password that were defined when installing Websphere.
. Expand Applications and click Enterprise applications.

. Select the check box for the Remote Control server application.

. Click Uninstall.

. Select Save to save to the Master Configuration.

Uninstalling the server using Add or Remove programs

If you are using a Windows® operating system you can uninstall the server software, using Add or Remove Programs

by completing the following steps :

o oA WN =

. Open the Control Panel.

. Double click Add or Remove Programs.
. Select Remote Control - Server.

. Click Change Remove.

. Click Uninstall.

. Click Done when finished.

Uninstalling the target on Windows™ systems

Using Add or Remove Programs to remove the target software from a Windows™ system.

To remove the target software by using Add or Remove Programs complete the following steps:

1,
2.
3.
4,
5,

Open the Control Panel.

Double-click Add or Remove Programs.
Select IBM Remote Control - Target.
Click Remove.

Click Yes at the prompt.

The Remote Control target software is removed from your system.

Uninstalling the target on Linux® systems

To remove the target software on Linux® systems, complete the following steps:

1.

2.

To find the Remote Control package name that is installed, run the following command.
rpm -qa |grep trc
Run the following command:

rpm -e <trcpackage>



Remote Control Installation Guide | 15 - Uninstall the components | 162

where trcpackage is your package name.

For exanple: rpm-e trc-target

You can verify that the target is removed by completing the following steps:

1. Run the command in step 1 (on page 767) to make sure that there is no Remote Control package installed.

2. Run the following command to make sure that no Remote Control process is running.

ps -ef |grep trc



Chapter 16. Upgrade from previous versions

If you are upgrading to version 10.1 and your environment is configured in FIPS mode, you must upgrade the
controllers first. This is because controllers of a version lower than 10.1 are not able to connect with 10.1 targets. If
the environment is not configured in FIPS mode, there are no requirements on the components' upgrade order.

When upgrading Remote Control from version 9.x to version 10 for the first time, there is no specific component

upgrade order to follow.

When upgrading the Server, the installer will detect that an earlier version of the server is present, and that server

instance is upgraded to version 10.

When upgrading the Target, Broker, Gateway and Controller the upgrade process consists of:

« Installing the version 10 component
« Migrating the component configuration

- Uninstalling the earlier version of the component

If you are upgrading from a version of Remote Control older than 9.0.0 may lead to compatibility issues if the different

components are not upgraded in the correct order.

This limitation applies only to environments where the gateway and broker components are deployed. In these
environments, the broker and gateway must be updated before the server or the target components. After they are
upgraded, the targets and server can be upgraded in the order that best suits your environment, since there are no

dependencies between them.

Upgrade to Version 10 from earlier versions

When upgrading the Server, the installer will detect that an earlier version of the server is present, and that server
instance is upgraded to version 10. The existing database does not need to be migrated and the configuration

settings can be preserved.

Upgrade process

When upgrading the Target, Broker, Gateway and Controller the upgrade process consist of:

« Install the version 10 component.
« Migrate the component configuration.
« Uninstall the earlier version of the component.

Note: During the upgrade process the broker certificate is not relocated. After the broker upgrade verify that

the CertificateFile parameters in the broker configuration are accurate.
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Upgrade the gateway component

You can upgrade the gateway component by using any of the following methods:

Using the installation files

For more information about obtaining the component installation files, see Obtain the installation files
(on page 29). For more information about installing the gateway support on a Windows system, by
using the installation files, see Installing Windows gateway support (on page 93). For more information
about installing the gateway support in Linux, by using the installation files, see Installing Linux gateway

support (on page 94).

Using the BigFix® console

If you have the BigFix® console infrastructure installed, you can use the update fixlet to upgrade the
gateway support. For more information about the upgrade fixlet, see the BigFix® Remote Control

Console User's Guide.

Upgrade the broker component

You can upgrade the broker support by using any of the following methods:

Using the installation files

For more information about obtaining the component installation files, see Obtain the installation files
(on page 29). For more information about installing the broker support on a Windows™ system, by using
the installation files, see Installing Windows broker support (on page 95). For more information about
installing the broker support in Linux™, by using the installation files, see Installing Linux broker support

(on page 95).

Using the BigFix® console

If you have the BigFix® console infrastructure installed, you can use the update fixlet to upgrade the
broker support. For more information about the upgrade fixlet, see the BigFix® Remote Control Console

User's Guide.

Note: The upgrade process from version 9.x, it's important to note that the broker certificate is not relocated.
After the broker upgrade, it is crucial to verify the accuracy of the Certi fi cat eFi | e paraneters inthe

broker configuration.

Note: The upgrade process to version 10.1.0 may overwrite the existingt r c_br oker . properti es
file. Make a backup copy of the trc_broker.properties file before proceeding with the upgrade. After

the upgrade review your current broker configuration and remove any existing Def aul t TLSGi pher Li st,

Def aul t HTTPSGI pher Li st, and Server TLS* properties to ensure that the Broker operates with version 10.1.0

hardened configuration.
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Upgrade the server component

If you already installed the BigFix® Remote Control Server software, you can upgrade the component by carrying out

a similar installation type to your original installation.

Before you start the upgrade, you must back up your property files and any recording files if applicable. Back up any
certificates, if applicable. For more information about backing up and restoring certificates, see the BigFix® Remote

Control Administrator's Guide

Property files

e comon. properties
« | dap. properties
etrc.properties
*log4j 2. properties

econtroller.properties

The files are in the following directories.
Windows® systems

[Instal IDir]w p\usr\servers\trcserver\apps\ TRCAPP. ear\trc. war\ VEB- | NF
\ cl asses\ Where InstallDir is the Remote Control server installation directory. For example, C:
\Program Fil es ( x86)\Bi gFi x\ TRC\ server\w p\usr\servers\trcserver\apps
\ TRCAPP. ear\trc. war\ VEEB- | NF\ cl asses\

Linux® systems
[Instal I Dir]w p/usr/servers/trcserver/apps/ TRCAPP. ear/trc. war/WEB- | NF/
cl asses/ Where InstallDir is the Remote Control server installation directory.

Recordings Files

The video recordings folder is defined by the rc.recording.directory property in the trc.properties file.

You can upgrade the server component by using any of the following methods:

Using the installation files

For more information about obtaining the component installation files, see Obtain the installation files
(on page 29). For information about installing the server, by using the installer, see Installing by using the

server installer (on page 36).

Note: During the installation, select to keep existing property files and do not select to drop the

database.

For information about installing the server, on WebSphere 8.5, see Installing on WebSphere Application

Server version 8.5.5: deploying the war file (on page 45).

Using the BigFix® console
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If you have the BigFix® console infrastructure installed, you can create and run a server installation task
to upgrade the server. For more information about using the wizard to create a server configuration task,

see the BigFix® Remote Control Console User's Guide .

Note: When you create the server task, do not select the drop database option if you want to
keep your existing database.

When you complete the upgrade verify that the new version is installed, manually edit the new properties files. Update
the values with the values that are in your backed up properties files. Restore your recording files and certificates if

applicable

Upgrade the target component

You can upgrade the target component by using any of the following methods:
Using the installation files

For more information about obtaining the component installation files, see Obtain the installation files
(on page 29). For more information about installing the target component on a Windows™ system, by
using the installation files, see Installing the Windows target (on page 55). For more information about
installing the target component on a Linux™ system, by using the installation files, see Installing the
Linux target (on page 76).

Using the BigFix® console
If you have the BigFix® console infrastructure installed. you can use the update fixlet to upgrade the

target component. For more information about the upgrade fixlet, see the BigFix® Remote Control

Console User's Guide.

Upgrade the controller component

The controller component upgrade is a major upgrade. Any existing properties are backed up and added to the new

properties file.

If you are using a Linux™ operating system and are upgrading from IBM® Endpoint Manager for Remote Control
version 9.0.1 or earlier, edit thet rc_control | er. cf g. r ppmewfile. Compare the property values in the file with the
valuesinthetrc_control | er. cf g file. Merge the differences intothetrc_control | er. cf g file and save the

file.
Any of the following methods can be used to upgrade the controller component:
Using the installation files

For more information about obtaining the component installation files, see Obtain the installation files
(on page 29). For more information about installing the controller component on a Windows™ system,
by using the installation files, see Installing the controller on a Windows system (on page 84). For more
information about installing the controller component in a Linux™ system, by using the installation files,

see Installing the Linux controller (on page 85).
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Using the BigFix® console

If you have the BigFix® console infrastructure installed, you can use the update fixlet to upgrade the
controller component. For more information about using the update fixlet, see the BigFix® Remote

Control Console User's Guide.



Chapter 17. Maintaining the target installation
The BigFix® Remote Control Target installation can be modified by using a maintenance program.

You can access the maintenance program on a system with Microsoft® Windows® by running the

trc_target_setup. exe program. To access the maintenance program, complete the following steps:

1. Go to the target installation directory. For example,

\ Program Fi | es\ Bi gFi x\ Renot e Control \ RCTar get
2. Double-clicktrc_target_setup. exe.
3. At the welcome screen click Next.

4. Select an option and click Next
Modify
Select this option to go through the target installation screens to modify the previously installed
values.
To modify the installation properties, follow from step 5 (on page 56).
Repair
Select this option to fix missing or corrupted files, shortcuts, and registry entries.

a. Click Repair.
b. Click Finish.

Remove

Select this option to remove the target software and all of its features.

a. Click Remove.
b. Click Finish.



Appendix A. Properties that can be set in the target
configuration

You can configure target properties either during or after installation. The operating system on the target system
determines which properties can be configured. The target properties determine the actions that can be carried
out during a peer-to-peer session. If you set a server URL and set the Managed property to Yes, the actions are

determined by the policies that are set on the Remote Control server.

For more information about which properties are configurable in each operating system, see Table 23: Operating
systems that the property is configurable in (on page 797).

Windows™ systems

The target properties are saved in the target registry. Edit the target registry to modify the properties:

1. On a 64-bit system, all the 32-bit registry keys are under the Wow6432Node key. For example:
HKEY_LOCAL_MACHI NE\ SOFTWARE\ WOW6432Node\ Bi gFi x\ Renot e Control \ Tar get

Note: On a 32-bit system, go to HKEY LOCAL_MACHI NE\ SOFTWARE\ Bi gFi x\ Renot e
Cont r ol \ Tar get

2. Right-click the required property and select Modify
3. Set the required value and click OK.

4. Restart the target service.

Linux™ systems

The target properties are saved tothe /et c/trc_t arget. properti es file. Edit the file after
installation to configure the target.

1. Editthetrc_target. properti es file.
2. Modify the required properties.
3. Save the file.

4. Restart the target service.

macOS devices

You can configure the propertiesinthet rc_t ar get . cf g file when you install the target.

For more information, see Installing the BigFix Remote Control Target for macOS by using

the .pkg file (on page 77). The target properties are saved to / Li br ary/ Pref er ences/

com bi gfi x. remptecontrol .target. plist.Tomodify atarget property, complete the following
steps:

1. Open the Ter i nal . app.
2. To modify a property, enter the following command.
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sudo defaults write /Library/Preferences/com.bigfix.remotecontrol.target.plist Keyword Value

Where Keyword is the property name and Value is the value for the property. For example,

sudo defaults write /Library/Preferences/com.bigfix.remotecontrol.target.plist LogLevel 4

3. Restart the target.
o For BigFix Remote Control version 10 update 6 or earlier
a. Click Remote Control Target > Quit Remote Control Target
b. Openthe Renot e Control Target app
o For BigFix Remote Control version 10 update 7
a. Enter sudo I aunchct! unl oad /Library/ LaunchDaenons/ RCTar get Daenon. pl i st

b. Enter sudo | aunchct! |oad /Libr ary/ LaunchDaenons/ RCTar get Daenon. pl i st

Target property definitions

Table 19. Installation option descriptions

Default

Target property Value Description

ServerURL

Blank

For the target to register with the server and take part in remote control
sessions that are started from the server, provide the Remote Control
server URL in the format: ht t p: / / ser ver nane/ t r c, where server-

name is the fully qualified name of yourRemote Control server.
For example, htt p: //trcserver. exanpl e. conftrc
Note: If you provide a server URL and you want the target to

take part only in remote control sessions that are started from

the server, set AllowP2P to No.

ProxyURL

Blank

Host name or IP address for a proxy server, if you are using one.

BrokerList

Blank

The list of host names or IP addresses of the brokers and their
ports, that you want the target to connect to. In the format, host-

name1:port,hostname2:port,hostname3:port.

GroupLabel

Blank

A target group name that the target is made a member of when the
configuration is applied. This target group must exist in the Remote

Control database.

Note: The GroupLabel property can be used only if the target
is not already registered with the server. If the target is already
registered, it is not assigned to the target group. The allow.tar-

get.group.override property inthet r c. properti es file on
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Table 19. Installation option descriptions (continued)

Default

Value

Target property Description

P9 the server must be set to Yes for the GroupLabel property value

to be applied.

Note:

« The allow.target.group.override property in the t r -

c. properti es file on the server must be set to Yes
for the GroupLabel property value to be applied when
the target is not already registered with the server.

» The allow.override.at.triggered.callhomes property in
thetrc. properti es file on the server must be set
to Yes for the GroupLabel property value to be applied
when the target performs periodic callhomes after the
target has registered with the server.

« You can specify a single target group name or a list of
target groups with a semicolon separator in the for-

mat Group1;Group2.

PortToListen 888 Specify the TCP port that the target listens on. The default value for the

BigFix® Remote Control Target for macOS is 8787.

AllowP2P Yes Used to enable peer-to-peer mode. Use this parameter to enable peer to

peer connections regardless of the server status. Default value is No
No

A peer-to-peer session cannot be established between a
controller and this target. If a ServerURL is provided, the
targets can take part only in remote control sessions that

are initiated from the server.
Yes

A peer-to-peer session can be established between a con-

troller user and this target.

Note: If this option is Yes and a server URL is pro-
vided, the target can take part in both peer-to-peer
sessions and sessions that are initiated from the

server.
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Table 19. Installation option descriptions (continued)

Target property

Default

Value

Description

AllowP2PFailover

No

Use this parameter to enable failover to peer-to-peer mode when the
server is down or unreachable. AllowP2P must also be set to Yes. De-

fault value is No.
No

The session does not failover to peer-to-peer mode when

the server is down or unreachable.
Yes

The session does failover to peer-to-peer mode when the

server is down or unreachable.

FIPSCompliance

No

Use this property to enable the use of a FIPS-certified cryptographic
provider for all cryptographic functions. For more information about en-
abling FIPS compliance, seeFederal information processing standard

(FIPS 140-2) compliance in Remote Control (on page 729).

Note: If you enable FIPS compliance on the target, you must al-
so enable FIPS compliance on the controller components that
are installed. Only the IBM® Java™ Run-time Environment (JRE)
is supported in FIPS-compliant mode and the JRE is installed
when you install the controller software. To enable FIPS compli-

ance on the controller, complete the following steps.

1. Editthetrc_control | er. cf g file on the system

that the controller is installed on.
Windows™ systems
[controller installation

dir]\trc_controller.cfg

where [controller installation dir] is the
directory that the controller is installed
in.

Linux™ systems
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Table 19. Installation option descriptions (continued)

Default

Target property Value Description

opt/Bi gFi x/trc/controller/tr-

c_controller.cfg

2. Set the fips.compliance property to Yes and save the

file.

SP800131ACompliance No Select this option to enforce NIST SP800-131A-compliant algorithms
and key strengths for all cryptographic functions. For more information
about enabling NIST SP800-131A compliance, see NIST SP800-131A

compliance in Remote Control (on page 138).

Note: If you enable NIST SP800-131A compliance on the tar-
get, you must also enable NIST SP800-131A compliance on the
controller components that are installed. Only the IBM® Java™
Run-time Environment (JRE) is supported in NIST SP800-131A
compliant mode and the JRE is installed when you install the
controller software. To enable NIST SP800-131A compliance on

the controller, complete the following steps.

1. Editthetrc_control | er. cf g file on the system

that the controller is installed on.
Windows™ systems
[controller installation

dir]\trc_controller.cfg

where [controller installation dir] is the
directory that the controller is installed
in.

Linux™ systems
opt/BigFix/trc/controller/tr-

c_controller.cfg

2. Set the sp800131A.compliance property to Yes and

save the file.

Accessibility No Select this option to enable the accessibility Ul. Available only on Win-

dows operating system.
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Table 19. Installation option descriptions (continued)

Default
Value .
Target property Description
LogLevel 2
The log level determines the types of entries and how much informa-
tion is added to the log file. Default value is 2.
0 - Logging is set to a minimal level.
1-Logging is set to ERROR level.
2 - Logging is set to INFO level.
4 - Logging is set to DEBUG level.
Note: Use Log Level = 4 only by request from HCL support.
LogRollover Daily
Controls the period after which a new log file is started. This period
must be shorter than the LogRotation period, therefore not all combina-
tions are valid. LogRollover cannot be disabled. Default value is Daily.
Hourly
Start a new log file on the hour. Recommended if the log
is written to frequently or when you use a log level higher
than 2.
Daily
Start a new log file every day.
LogRotation Weekly

Controls the period after which an older log file is overwritten. Log rota-

tion can be disabled. Default value is Weekly.
Daily

Overwrite log files after 1 day. When LogRollover is set to
Hourly, the suffix that is added to the log file name is 00H
to 23H.

Weekly

Overwrite log files after 1 week. When LogRollover is set
to Hourly, the suffix that is added to the log file name
specifies the day and hour. Value can be Mon-00H to
Sun-23H. When LogRollover is set to Daily, the suffix that
is added to the log file name specifies the day. The value

can be Mon to Sun.

Monthly
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Table 19. Installation option descriptions (continued)

Default

Value

Target property Description

Overwrite log files after 1 month. 01-00H to 31-23H. When
LogRollover is set to Hourly, the suffix that is added to
the log file name specifies the numeric day of the month
and the hour. Value can be 01-00H to 31-23H. When
LogRollover is set to Daily, the suffix that is added to the
log file name specifies the numeric day of the month. The

value can be 01 - 31.
Disabled

LogRotation is disabled. When LogRollover is set to
hourly, the suffix that is added to the log file name spec-
ifies the current date and time. Value can be YYYY-MM-
DD-hh. When LogRollover is set to Daily, the suffix that is
added to the log file name specifies the current date. The

value can be YYYY-MM-DD.

Table 20. Session option properties.

Target property Default Value Description

AllowMonitor Yes Determines whether the target can take part in monitor peer-to-peer
sessions. For information about the different types of remote control
session that can be established, see the BigFix® Remote Control Con-

troller User's Guide.
Yes
The target can take part in monitor peer-to-peer sessions.
The Monitor option is available for selection in the ses-
sion type list in the controller window. The Open connec-
tion window also lists a Monitor option.

No

The target cannot take part in monitor peer-to-peer ses-
sions. The Monitor option is not available in the session

type list in the controller window.

AllowGuidance Yes Determines whether the target can take part in guidance peer-to-peer

sessions.
Yes

The target can take part in guidance peer-to-peer ses-

sions. The Guidance option is available in the session
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Table 20. Session option properties. (continued)

Target property

Default Value

Description

type list in the controller window. The Open connection

window also lists a Guidance option.
No

The target cannot take part in guidance peer-to-peer ses-
sions. The Guidance option is not available in the session

type list in the controller window.

AllowActive

Yes

Determines whether the target can take part in active peer-to-peer ses-

sions.
Yes

The target can take part in active peer-to-peer sessions.
The Active option is available in the session type list in
the controller window. The Open connection window also

contains an Active option.
No

The target cannot take part in active peer-to-peer ses-
sions. The Active option is not available in the session

type list in the controller window.

DisableChat

No

Determines the ability to start a chat session with the target and also

chat to the controller user during a peer-to-peer session.
Yes

If Chat Only is chosen as the connection type on the open
connection screen, the session is refused. During the ses-
sion, the chat icon is not available in the controller win-

dow.
No

A Chat Only session can be initiated from the open con-
nection window. During the session, the chat icon is avail-

able in the controller window.

DisableFilePull

No

Determines the ability to transfer files from the target to the controller

during the session.
Yes

Files cannot be transferred from the target to the con-

troller.

No
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Table 20. Session option properties. (continued)

Target property Default Value Description

Files can be transferred from the target to the controller.

DisableFilePush No Determines the ability to transfer files from the controller to the target

during the session.
Yes

Files cannot be transferred from the controller to the tar-

get.
No

Files can be transferred from the controller to the target.

DisableClipboard No Determines the availability of the clipboard transfer menu in the con-
troller Ul in a peer-to-peer session. Use the menu to transfer the clip-
board content between the controller and target during a remote con-

trol session.

Yes
The clipboard transfer menu is not available during the
session to transfer the clipboard content to and from the
target.

No

The clipboard transfer menu is available during the ses-

sion.

AllowRecording Yes The controller user can make and save a local recording of the session

in the controlling system.
Yes
The record option is available in the controller window.
No

The record option is not available in the controller win-

dow.

AllowCollaboration Yes Use this property to allow more than one controller to join a session.

Determines the availability of the collaboration icon on the controller
window.
Yes

The collaboration icon is available in the controller win-

dow.

No
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Table 20. Session option properties. (continued)

Target property

Default Value

Description

The collaboration icon is not available in the controller

window.

AllowHandover

Yes

The master controller in a collaboration session, can hand over con-
trol of the session to a new controller. Determines the availability of the

Handover button on the collaboration control panel.
Yes

The Handover button is displayed in the collaboration

control panel.
No

The Handover button is not displayed in the collaboration

control panel.

AllowForceDisconnect

No

Determines whether a Disconnect session button is available in the
message window that is displayed when you attempt to connect to the
target. You can use the Disconnect session option to disconnect the

current session.
Yes

The disconnect button is displayed in the message win-

dow.
No

The disconnect button is not displayed in the message

window.

ForceDisconnectTimeout

45

Number of seconds you must wait for the controller user to respond to
the prompt to disconnect the current session. If they do not respond

in the time that is given, they are automatically disconnected from the
session. The timer takes effect only when AllowForceDisconnect and

CheckUserLogin are set to Yes. The default value is 45.

AutoWinLogon

Yes

Determines whether a session can be started when no users are logged

on at the target.

Yes

Session is started with the target.
No

Session is not started and the following message is dis-
played. Sessi on rejected because there is no user

| ogged to confirmthe session
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Table 20. Session option properties. (continued)

Target property Default Value Description

RunPreScript No Determines whether a user-defined script is run before the remote con-
trol session starts. The script is run just after the session is allowed but
before the controller user has access to the target. The outcome of run-
ning the script and the continuation of the session is determined by the

value that is set for Proceed on pre/post-script failure.
Yes

When a remote control session is requested, the defined
script is run before the controller user has access to the

target.
No
No script is run before the session.

For more information about setting up pre and post session scripts, see

the BigFix® Remote Control Administrator's Guide.

RunPostScript No Determines whether a user-defined script is run after the remote control

session finishes.
Yes

When a remote control session ends, the user-defined

scriptis run.
No
No script is run after the session.

For more information about setting up pre and post session scripts, see

the BigFix® Remote Control Administrator's Guide.

ProceedOnScriptFail No The cction to take if the pre-script or post-script execution fails. A posi-
tive value or 0 is considered a successful run of the pre-script or post-
session script. A negative value, a script that is not found, or not fin-

ished running within 3 minutes is considered a failure.
Yes

If the pre-script or post-script run fails, the session contin-

ues.
No

If the pre-script or post-script run fails, the session does

not continue and ends.

WorkaroundW2K3RDP No Automatically reset the console after a Remote Desktop console ses-
sion. When a Remote Desktop user uses the /admin or /console option

to start a Remote Desktop session with a Windows™ Server 2003 sys-
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Table 20. Session option properties. (continued)

Target property

Default Value

Description

tem and a user starts a remote control session with this target before,
during or after the Remote Desktop session, remote control is unable
to capture the display. The result is that a gray screen is shown in the
controller. This issue is a limitation in Windows™ Server 2003 operating
systems. Therefore, this property introduces a workaround that will re-
set the Windows™ session either after each Remote Desktop session
ends, or before a remote control session starts, depending on the value

Yes.

The workaround is disabled. This value is the default val-

ue.

Reset the session automatically when a remote control

session is started.

/’ Note: The Windows™ session takes a couple of
minutes to initialize and a blank desktop is dis-
played on the controller until the initialization is
complete. A message informs the controller user
that the session is being reset and it might take a

few minutes.

Reset the session automatically when the Remote Desk-

top user logs out.

EnableTrueColor

No

Determines whether the target desktop is displayed in high-quality col-
ors in the controller window at the start of a session. Used together

with Lock color quality.

Yes.
The target desktop is displayed in true color 24-bit mode
at the start of the session. Partial screen updates are also
enabled.

No.

The target desktop is displayed in 8-bit color mode at the
start of the session. Partial screen updates are also en-

abled. This value is the default value.
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Table 20. Session option properties. (continued)

Target property Default Value Description

LockColorDepth No
Determines whether the color quality that a remote control session is

started with can be changed during the session. Used together with En-

able high quality colors.
Yes.

The initial color quality, for the remote control session, is
locked and cannot be changed during the session. The
Performance settings icon is disabled in the controller
window. The controller user cannot change settings to im-

prove the session performance if their network is slow.
No.

The color quality can be changed during the session. The
Performance settings icon is enabled in the controller

window.

RemoveBackground No If a desktop background image is set on the target, this property can be
used to remove the background from view during a remote control ses-

sion.
Yes.

The desktop background image on the target is not visible

during a remote control session.
No.

The desktop background image on the target is visible

during a remote control session.

NoScreenSaver No Stops the target from sending screen updates when it detects that the

screen saver is active.
Yes.

While the screen saver is active on the target system, the
target stops transmitting screen updates. The controller
displays a simulated screen saver so that the controller
user is aware that a screen saver is active on the remote
display. The controller user can remove the screen saver

by pressing a key or moving the mouse.
No.

A simulated screen saver is not displayed in the session
window. The target screen is displayed as normal and the

target continues to transmit screen updates.
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Table 20. Session option properties. (continued)

Target property

Default Value

Description

Managed

Yes

Determines whether the target registers with the Remote Control serv-

er.
Yes.

The target registers with the Remote Control server and
periodically contacts the server.
No.

The target does not register with the Remote Control serv-

er. The target can take part only in peer-to-peer sessions.

Table 21. User acceptance property descriptions

Target property

Default

Value

Description

ConfirmTakeOver

Yes

Determines whether the acceptance window is displayed on the target, when a re-

mote control session is requested.
Yes

The user acceptance window is displayed and the target user can

accept or refuse the session.
No

The user acceptance window is not displayed and the session is es-

tablished.

ConfirmModeChange

Yes

Determines whether the user acceptance window is displayed when the controller
user selects a different session mode from the session mode list on the controller
window.

Yes

The user acceptance window is displayed each time a session mode
change is requested and the target user must accept or refuse the
request.

No

The user acceptance window is not displayed and the session mode

is changed automatically.

ConfirmFileTransfer

Yes

Determines whether the user acceptance window is displayed when the controller

user selects to transfer files between the target and the controller.
Yes

The acceptance window is displayed in the following two cases. The

target user must accept or refuse the file transfer.
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Table 21. User acceptance property descriptions (continued)

Default

Value

Target property Description

« The controller user selects pull file from the file transfer
menu on the controller window. The target user must se-
lect the file that is to be transferred after they accept the
request.

« The controller user selects send file to controller from

the Actions menu in the target window.

The acceptance window is not displayed and files are transferred
automatically from the target to the controller system when request-

ed.

ConfirmSysInfo Yes Determines whether the user acceptance window is displayed when the controller

user requests to view the target system information.
Yes

When the controller user clicks System information in the controller
window, the user acceptance window is displayed. The target user
must accept or refuse the request. If the target user clicks accept,
the target system information is displayed in a separate window on
the controller system. If they click refuse, a message is displayed on

the controller and the system information is not displayed.
No

The target system information is displayed automatically when the

controller user clicks the system information icon.

ConfirmRecording Yes Determines whether the user acceptance window is displayed when the controller

user clicks the record icon on the controller window.
Yes

When the controller user clicks the record icon on the controller win-
dow, a message window is displayed. If the target user clicks Ac-
cept, the controller user can select a directory to save the recording
to. If the target user clicks Refuse, a recording refused message is

displayed to the controller.

note: After the target user accepts the request for recording,
if the controller user stops and restarts local recording, the

acceptance window is not displayed.

No
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Table 21. User acceptance property descriptions (continued)

Target property

Default

Value

Description

When the controller user clicks the record icon on the controller win-
dow, the message window is not displayed. The controller user can

select a directory to save the recording to.

ConfirmCollaboration

Yes

Determines whether the user acceptance window is displayed when another con-

troller user requests to join a collaboration session with a target.
Yes

When the controller user tries to join the collaboration session, the
user acceptance window is displayed. The target user must accept
or refuse the request to allow the additional controller to join the
session. If the target user clicks accept, the additional controller
joins the collaboration session. If they click refuse, a message is dis-
played on the controller system and the additional controller cannot

join the collaboration session.
No

The additional controller automatically joins the collaboration ses-
sion when they try to connect to the master controller of the ses-

sion.

AcceptanceGraceTime

45

Sets the number of seconds to wait for the target user to respond before a ses-

sion starts or times out, used with Confirm incoming connections.

« Acceptable values 0 - 60. If set to 0, the target user is not asked to re-

spond to the session request.

alote: If Confirm incoming connections is Yes, Acceptance grace time
must be set to a value >0 to provide the target user with enough time to

respond.

AcceptanceProceed

No

The action to take if the user acceptance window timeout lapses. The target user
did not click accept or refuse within the number of seconds defined for Accep-

tance grace time.
Yes
Session is established.
No

Session is not established.
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Table 21. User acceptance property descriptions (continued)

Default

Value

Target property Description

HideWindows (Deprecated) No
nlote: The "Allow to show/hide selected windows during the session" fea-

ture has been deprecated for all versions above Windows 7.

Determines whether the Hide windows check box is displayed on the user accep-

tance window when Confirm incoming connections is also set to Yes.
Yes

The Hide windows check box is displayed on the user acceptance

window.

The Hide windows check box is not visible on the user acceptance

window.

DisableGUI_CLI No Lets the user to send actions to the target through command line.
Yes

The GUI command line interface is disabled.

The GUIcommand line interface is enabled.

note: The command line interface is only available in man-

aged mode and when the BrokerList property is not empty.

Table 22. Security property descriptions

Target property Default Value Description

CheckUserLogin Yes Determines whether a logon window is displayed when the controller

user clicks a session type button on the Open Connection window.
Yes

The logon window is displayed and the controller user
must log on with a valid Windows™ operating system ID
and password. If the logon credentials are invalid, the tar-

get refuses the session.
No

The logon window is not displayed and the session is es-

tablished.

CheckUserGroup see description Default value.
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Table 22. Security property descriptions (continued)

Target property

Default Value

Description

Windows™ systems

BUI LTI N Adni ni strators

Linux™ systems

wheel

When CheckUserGroup has a value set, the user name that is used for
authentication must be a member of one of the groups that are listed. If
the user is not a member, the session is refused. Multiple groups must

be separated with a semicolon. For example, wheel ; t rcusers

/’ Note: By default, on Windows™ systems, only the Administrator
user is granted access. On Linux™ systems, by default no users
are granted access. To resolve this issue, complete one of the

following steps.

1. To also grant administrator rights to the users, make
them members of the Administrators group on Win-
dows™ systems or the wheel group on Linux™ sys-
tems.

2. For users with no administrator rights, complete the
following steps.

a. Create a group or use an existing group. For
example, the following command can be run

as root:

groupadd trcusers

b. Add the users to this group. For example, the
following command can be run as root to

add bsmith to trcusers:

usernmod -a -G trcusers <bsmith>

c. Add the group to the list in the Authorized

user group field.

AuditToSystem

Yes

Determines whether the actions that are carried out during remote con-
trol sessions are logged to the application event log on the target. This

file can be used for audit purposes.
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Table 22. Security property descriptions (continued)

Target property Default Value Description
Yes
Entries that correspond to each action that is carried out
during the session, are logged in the application event log
of the target.
No
No entries are logged to the application event log.
AutoSaveChat No Determines whether the chat text, entered during a chat session, can be
saved.
Yes
The chat text is saved as an html file. The file is
chat - user nane- dat e. ht ml , where username is the
display name of the logged on user on the controller ma-
chine in a peer-to-peer session. In managed mode user-
name is the display name for the controller user that is on
the server. The date is in the format YYYYMMDD. The file
is saved in the working directory of the target. The loca-
tion of the working directory is defined by the target prop-
erty WorkingDir. For example, on Windows™ systems, the
file is saved to
c:\ ProgranDat a\ Bi gFi x\ Renote Control.
On Linux systems, the file is saved to / var / opt / bi g-
fix/trc/target/.
On Mac systems, the file is saved to / User s/ <user >/ Li -
brary/ Application Support/com bi gfix.renotecontrol -
.target.
No
The chat text is not saved to a file.
EnableFileTransferSystemAccess No Determines whether the file transfer session allows for target file sys-
tem access using System privileges (Windows) or root privileges (Lin-
ux). This option is valid for peer to peer sessions only.
Yes
The file transfer session uses System privileges (Win-
dows) or root privileges (Linux) on the target file system.
No
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Table 22. Security property descriptions (continued)

Target property

Default Value

Description

The file transfer session uses the privileges of the logged

on user on the target file system.

Note: If the option is set to No, and there is no logged on user
on the target during the file transfer session, an error message

is displayed.

SessionDisconnect

No

Determines whether the target computer is automatically locked when

the remote control session ends. Allowed value: lock.

When you set the value to lock, the target computer is automatically
locked at the end of the session. If the property is blank or set to anoth-
er value, the target computer is not automatically locked at the end of

the session.

AllowPrivacy

Yes

Determines whether a controller user can lock the local input and
screen of the target in a remote control session. Determines the visibili-

ty of the Enable Privacy option on the controller window.
Yes

The Enable Privacy option is available in the Perform Ac-

tion in target menu in the controller window.
No

The Enable Privacy option is not available in the Perform

Action in target menu in the controller window.

AllowInputLock

Yes

This property works with Allow privacy and on its own. You can use Al-
low input lock to lock the target users mouse and keyboard during a re-

mote control session.
Yes

The lock target input menu item is enabled, in the Per-
form action in target menu in the controller window.
Select lock target input to lock the target users mouse
and keyboard during a remote control session. The target

screen is still visible to the target user.
No

The lock target input menu item is not enabled in the Per-

form action in target menu in the controller window.
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Table 22. Security property descriptions (continued)

Target property Default Value Description

Note: If the option to Enable Privacy is Yes during a session,
the remote user input is automatically locked. It is not possible

to enable privacy without also locking the input.

EnablePrivacy No Determines whether the local input and screen are locked for all ses-
sions. Therefore, the target user cannot input or do anything on the tar-

get while in a remote control session.
Yes

The target screen is blanked out by the privacy bitmap
when the session starts, preventing the target user from
interacting with the screen while in the session. The tar-
get desktop is still visible to the controller user in the con-

troller window.
No

The target screen is not blanked out when the session is

started and the target user can interact with the screen.

EnablelnputLock No This property works with Enable privacy. When privacy mode is en-
abled, use Enable input lock to determine whether the target user can

view their screen, during a remote control session.
Yes

The target screen is visible to the target user during the
session, while in privacy mode but the mouse and key-

board control is locked.
No

The target screen is not visible to the target user. The pri-
vacy bitmap is displayed on the target during the session.
The target users mouse and keyboard input is also dis-

abled.

Note: Enable privacy must be Yes for Enable input lock to take

effect.

DisablePanicKey No Determines whether the Pause Break key can be used by the target user

to automatically end the remote control session.

Yes
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Table 22. Security property descriptions (continued)

Target property

Default Value

Description

The target user cannot use the Pause Break key to auto-

matically end the remote control session.
No

The target user can use the Pause Break key to automati-

cally end the remote control session.

EnableOSSN

No

Determines whether a semi-transparent overlay is displayed on the tar-
get computer to indicate that a remote control session is in progress.
Use this property when privacy is a concern so that the user is clearly

notified when somebody can remotely view or control their computer.
Yes

The semi-transparent overlay is displayed on the target
screen with the text Remote Control and what type of re-
mote control session is in progress. For exanpl e, Renote
Control - Active Mde. The overlay does not intercept
keyboard or mouse actions. The user is still able to inter-

act with their screen.
No

No overlay is displayed on the target computer.

Note: This policy is only supported on targets where a Win-

dows™ operating system installed.

DisableGUI

No

Determines whether the target Ul is visible when the remote control

session is starting and also during the session.

Note: This option works only when the target is installed in
peer-to-peer mode and the Managed target property is set to
No. This option is ignored when applied to any targets that were
installed by using the Remote Control server mode when a serv-

er URL was supplied.

Yes
The target Ul is not visible on the target and the target
user is not aware that the session is started. The Remote
Control target icon is not visible in the Windows™ system

tray.

No
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Table 22. Security property descriptions (continued)

Target property Default Value Description

The target Ul is displayed on the target as the session is
starting and is available to the target user during the re-

mote control session.

Operating systems that the property is configurable in

Table 23. Operating systems that the property is configurable in

Property name Windows™ Linux™ macO0S
ServerURL * * ok
ProxyURL * * *k
BrokerList * * *
GroupLabel * * ok
PortToListen * * *
AllowP2P * * *
AllowP2PFailover * * *k
FIPSCompliance * *
SP800131ACompliance * *
Accessibility *
LogLevel * * *
LogRollover * * *
LogRotation * * *
AllowMonitor * * *
AllowGuidance * * *
AllowActive * * *
DisableChat * * *
DisableFilePull * * *
DisableFilePush * * *
DisableClipboard * *
AllowRecording * * *
AllowCollaboration * * *
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Table 23. Operating systems that the property is configurable in (continued)

Property name

Windows™

Linux™

macOS

AllowHandover

AllowForceDisconnect

ForceDisconnectTimeout

AutoWinLogon

*%

RunPreScript

RunPostScript

ProceedOnScriptFail

WorkaroundW2K3RDP

EnableTrueColor

LockColorDepth

RemoveBackground

NoScreenSaver

Managed

*%

ConfirmTakeOver

ConfirmModeChange

ConfirmFileTransfer

ConfirmSysinfo

ConfirmRecording

ConfirmCollaboration

AcceptanceGraceTime

AcceptanceProceed

HideWindows

CheckUserLogin

CheckUserGroup

AuditToSystem

AutoSaveChat

EnableFileTransferSystemAccess

*%*

SessionDisconnect
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Table 23. Operating systems that the property is configurable in (continued)

Property name Windows™ Linux™ macO0S
AllowPrivacy *
AllowInputLock *
EnablePrivacy *
EnablelnputLock *
DisablePanicKey *
EnableOSSN *
DisableGUI * ok
DisableGUI_CLI * * *x

Note: ** Property supported starting from macOS Remote Control target V10 Update 7.



Appendix B. Support

For more information about this product, see the following resources:

« BigFix Support Portal

« BigFix Developer

« BigFix Playlist on YouTube

* BigFix Tech Advisors channel on YouTube

* BigFix Forum


https://support.hcltechsw.com/csm?id=bigfix_support
https://developer.bigfix.com/
https://www.youtube.com/playlist?list=PL2tETTrnR4wtneQ2IxSIiDFljzQDuZNBQ
https://www.youtube.com/channel/UCtoLTyln5per0JYzw1phGiQ
https://forum.bigfix.com
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Notices
This information was developed for products and services offered in the US.

HCL may not offer the products, services, or features discussed in this document in other countries. Consult your
local HCL representative for information on the products and services currently available in your area. Any reference
to an HCL product, program, or service is not intended to state or imply that only that HCL product, program, or
service may be used. Any functionally equivalent product, program, or service that does not infringe any HCL
intellectual property right may be used instead. However, it is the user's responsibility to evaluate and verify the

operation of any non-HCL product, program, or service.

HCL may have patents or pending patent applications covering subject matter described in this document. The
furnishing of this document does not grant you any license to these patents. You can send license inquiries, in writing,
to:

HCL

330 Potrero Ave.

Sunnyvale, CA 94085

USA

Attention: Office of the General Counsel

For license inquiries regarding double-byte character set (DBCS) information, contact the HCL Intellectual Property

Department in your country or send inquiries, in writing, to:

HCL

330 Potrero Ave.

Sunnyvale, CA 94085

USA

Attention: Office of the General Counsel

HCL TECHNOLOGIES LTD. PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT,
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some jurisdictions do not allow disclaimer of
express or implied warranties in certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made
to the information herein; these changes will be incorporated in new editions of the publication. HCL may make
improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time

without notice.

Any references in this information to non-HCL websites are provided for convenience only and do not in any manner
serve as an endorsement of those websites. The materials at those websites are not part of the materials for this
HCL product and use of those websites is at your own risk.

HCL may use or distribute any of the information you provide in any way it believes appropriate without incurring any
obligation to you.
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Licensees of this program who wish to have information about it for the purpose of enabling: (i) the exchange of
information between independently created programs and other programs (including this one) and (ii) the mutual use
of the information which has been exchanged, should contact:

HCL

330 Potrero Ave.
Sunnyvale, CA 94085
USA

Attention: Office of the General Counsel

Such information may be available, subject to appropriate terms and conditions, including in some cases, payment of

a fee.

The licensed program described in this document and all licensed material available for it are provided by HCL under
terms of the HCL Customer Agreement, HCL International Program License Agreement or any equivalent agreement

between us.

The performance data discussed herein is presented as derived under specific operating conditions. Actual results

may vary.

Information concerning non-HCL products was obtained from the suppliers of those products, their published
announcements or other publicly available sources. HCL has not tested those products and cannot confirm
the accuracy of performance, compatibility or any other claims related to non-HCL products. Questions on the
capabilities of non-HCL products should be addressed to the suppliers of those products.

Statements regarding HCLs future direction or intent are subject to change or withdrawal without notice, and
represent goals and objectives only.

This information contains examples of data and reports used in daily business operations. To illustrate them as
completely as possible, the examples include the names of individuals, companies, brands, and products. All of these

names are fictitious and any similarity to actual people or business enterprises is entirely coincidental.
COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate programming techniques
on various operating platforms. You may copy, modify, and distribute these sample programs in any form without
payment to HCL, for the purposes of developing, using, marketing or distributing application programs conforming to
the application programming interface for the operating platform for which the sample programs are written. These
examples have not been thoroughly tested under all conditions. HCL, therefore, cannot guarantee or imply reliability,
serviceability, or function of these programs. The sample programs are provided "AS IS," without warranty of any kind.

HCL shall not be liable for any damages arising out of your use of the sample programs.

Each copy or any portion of these sample programs or any derivative work must include a copyright notice as
follows:
© (your company name) (year).

Portions of this code are derived from HCL Ltd. Sample Programs.
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Trademarks

HCL Technologies Ltd. and HCL Technologies Ltd. logo, and hcl.com are trademarks or registered trademarks of HCL
Technologies Ltd., registered in many jurisdictions worldwide.

Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered trademarks or trademarks of Adobe
Systems Incorporated in the United States, and/or other countries.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Oracle and/or its affiliates.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the United
States, other countries, or both.

Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both.
UNIX is a registered trademark of The Open Group in the United States and other countries.

Other product and service names might be trademarks of HCL or other companies.

Terms and conditions for product documentation

Permissions for the use of these publications are granted subject to the following terms and conditions.
Applicability

These terms and conditions are in addition to any terms of use for the HCL website.

Personal use

You may reproduce these publications for your personal, noncommercial use provided that all proprietary notices
are preserved. You may not distribute, display or make derivative work of these publications, or any portion thereof,
without the express consent of HCL.

Commercial use

You may reproduce, distribute and display these publications solely within your enterprise provided that all proprietary
notices are preserved. You may not make derivative works of these publications, or reproduce, distribute or display
these publications or any portion thereof outside your enterprise, without the express consent of HCL.

Rights

Except as expressly granted in this permission, no other permissions, licenses or rights are granted, either express or

implied, to the publications or any information, data, software or other intellectual property contained therein.

HCL reserves the right to withdraw the permissions granted herein whenever, in its discretion, the use of the
publications is detrimental to its interest or, as determined by HCL, the above instructions are not being properly
followed.
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You may not download, export or re-export this information except in full compliance with all applicable laws and
regulations, including all United States export laws and regulations.

HCL MAKES NO GUARANTEE ABOUT THE CONTENT OF THESE PUBLICATIONS. THE PUBLICATIONS ARE PROVIDED
"AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED
TO IMPLIED WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT, AND FITNESS FOR A PARTICULAR
PURPOSE.
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